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Before You Begin 

Thank you for purchasing ACD/ChemSketch—an integrated software package from Advanced 
Chemistry Development, Inc., (ACD/Labs) for drawing chemical structures, reactions, and 
schematic diagrams, and designing other chemistry-related reports and presentations. 

About This Reference Manual 

This manual provides a comprehensive description of all of the options available in 
ACD/ChemSketch, it is designed for either online use or to be printed and used as a “hard copy” 
version. 

The screen shots shown throughout this reference manual have been taken with a relatively 
small window size. 

The colors and other properties of the window elements described throughout this manual 
correspond with the default Windows Display Properties. 

This reference manual is provided in electronic form, readable with Adobe Acrobat software.  If 
you cannot locate an index topic you need please do a text string search for the relevant word or 
phrase, or related words. 

Mouse Conventions 

You may perform several actions during your work with this software; the following specific words 
are used to describe them: 

• Point to means move the mouse pointer  to an item. 

• Click or left-click means point to an item, and press the left mouse button.   
• Right-click means point to an item, and press the right mouse button.   
• Double-click means point to an item, and quickly press the left mouse button twice.   
• Drag means point to an item, and press and hold down the left mouse button while you 

move the item. 
• Select means highlight or make an interface element active by either clicking it or dragging 

over it (other actions are possible if specified in documentation).  If used in “select the 
check box”, it means that the check box should be marked with a tick (as opposed to “clear 
the check box” when the check box should be cleared, without a mark). 
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For More Information… 

To see the latest in ACD/Labs software and services, please visit our Web site at  

http://www.acdlabs.com/ 

Our Web site is being accessed at the rate of tens of thousands of “hits” per day.  There’s a 
reason for this: much is offered through our Web site.  As of Autumn 2007, we offer free 
ChemSketch 11.0, an ACD/LogP Freeware Add-on for ChemSketch, a free ISIS 3D Add-in, free 
ChemDraw extensions, and a free 2-week demo key for “Interactive Laboratory” sessions where 
you can run test calculations using Java applets without purchasing software.  There are 
TechSmith Camtasia-based movies which show the operation of many of our software packages 
(especially ChemSketch) available for download. 

We are constantly updating the information on our Web site.  The Web site will tell you at which 
scientific conferences you can visit the ACD/Labs booth.  You can browse the Frequently Asked 
Questions page or drop in and “chat” on our newsgroup, which can also be reached via our web 
page. 

If you would like to stay informed of the latest developments in chemical software at ACD/Labs, 
please be sure to sign up for e-mail broadcasts at our Web site page: 

http://www.acdlabs.com/feedback/mailing.html 

If you would like to participate in the ACD/Labs forums, please access: 

http://forum.acdlabs.com 

How to Contact Us 

We are accessible through our Web site, phone, fax, and regular mail, but by far the most popular 
way to contact us is via electronic mail.  Questions on pricing, sales, availability, and general 
issues should be directed to: 

info@acdlabs.com 

Technical and scientific support issues should be addressed by visiting:  

http://support.acdlabs.com 

Please tell us the name of the software purchaser; the product name, version number, build 
number, and license ID of the product you are contacting us about (from the Help menu, choose 
About to find this information); as well as a description of the problem you are having.  If 
applicable, please tell us the name of the distributor from whom you purchased the software. 

Online Updates 
All PC-based ACD/Labs software contains the capability to have software updates delivered 
online.  You will need the registration numbers of the software and an Internet connection from 
the same computer on which the software is installed.  The updates are small fixes, for example, 
bringing the actual version number of a program from 11.00 to 11.01.  For more information on 
this, please refer to the document located in the ACD/Labs documentation folder, 
\\DOCS\UP_CLNT.PDF, or contact our technical support department. 

. 

http://www.acdlabs.com/�
http://www.acdlabs.com/feedback/mailing.html�
http://forum.acdlabs.com/�
http://support.acdlabs.com/�
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1. Introduction 

1.1 About ACD/ChemSketch 

ACD/ChemSketch is the powerful all-purpose chemical drawing and graphics package from 
ACD/Labs developed to help chemists quickly and easily draw molecular structures, reactions, 
and schematic diagrams, calculate chemical properties, and design professional reports and 
presentations. 

ACD/ChemSketch includes: 
• Structure mode for drawing chemical structures and calculating their properties (for more 

information, refer to Section 3). 
• Draw mode or text and graphics processing (for more information, refer to Section 4). 
• Additional modules that extend the ChemSketch possibilities (most of them should be 

purchased separately). 

1.2 Additional Modules 

There are additional ACD/Labs applications accessible through the ACD/ChemSketch interface, 
as single-click buttons or add-on applications.  These applications, which are increasing in 
number with each upgrade, are available as additional options and should be considered as 
separate items.  Please contact us or consult our Web site for more details on pricing and 
availability. 

• ACD/ChemBasic—the special programming language that enables you to customize 
ACD/Labs software (can be downloaded from http://www.acdlabs.com/).  
ACD/ChemBasic is available as part of the ACD/ChemSketch freeware download on our 
Web site.  For examples on how ChemBasic can be used with ChemSketch, refer to 
Appendix C, “Goodies”. 

• ACD/I-Lab—the Internet-based service that allows you to get instant access to chemical 
databases and property predictions programs.  An account on the Interactive Lab can be 
set up from http://www.acdlabs.com/ilab.  As of Spring 2005, a 2-week demo period can 
be arranged for ACD/I-Lab.  ACD/ChemSketch 8.0 can connect to ACD/I-Lab automatically 
if run on a PC with Internet connection (for more information, refer to Section 3.17). 

• ACD/Tautomers—checks and generates the most reasonable tautomeric forms of organic 
structures (included in both freeware and commercial versions of ACD/ChemSketch).  For 
more information, refer to Section 3.12.3. 

http://www.acdlabs.com/�
http://www.acdlabs.com/ilab�
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• ACD/Dictionary—looks up the molecular structure for common drug names—
Commercial version only!   The new version of ACD/Dictionary contains more than 
125,000 systematic and non-systematic names, registry numbers, and abbreviations along 
with the corresponding molecular structures of the most frequently used chemicals.  The 
entries cover more than 220 therapeutic categories, and the inhibitors for more than 500 
different enzymes are also available (ACD/Dictionary included in the commercial version 
only).  For more information, refer to Section 3.13.6. 

• ACD/Name Freeware—generates a name for structure according to IUPAC 
Recommendations on Organic, Biochemical, and Inorganic Nomenclature.  This tool is 
distributed as a free add-on to ACD/ChemSketch.  For more information, refer to Section 
3.12.16. 

The following applications can be purchased in addition to ACD/ChemSketch: 
• ACD/Boiling Point and Vaporization—calculates accurate boiling points at any pressure 

from 0.001 torr to 7600 torr, in most cases to ±10 degrees or better, for a structure as 
drawn in the ChemSketch window.  This additional application is described in the separate 
ACD/Boiling Point User’s Guide (\\DOCS\BP.PDF). 

• ACD/Sigma—estimates the Hammett-type or related parameters for different substituent 
groups as drawn in the ChemSketch window.  This additional application is described in 
the separate ACD/Sigma User’s Guide (\\DOCS\SIGMA.PDF). 

• ACD/Name to Structure—generates a molecular structure for almost any chemical name.  
ACD/Name to Structure processes the majority of the names of general organic 
compounds and many natural product derivatives according to IUPAC Recommendations 
on Organic, Biochemical, and Inorganic Nomenclature.  This additional application is 
described in the separate ACD/Name to Structure User’s Guide (\\DOCS\NAMESTR.PDF). 

1.3 What’s New? 

ACD/ChemSketch includes some new enhanced features and options as compared to the 
previous version. 

In version 11.0 

General Capabilities 

• Generation of InChI key and auxiliary information on InChI 
• Applying antialiasing 
• Improved zoom 
• Possibility to view all of the supported formats at once when opening documents 
• New Document button is added to the existing command 
• Some shortcuts are changed in accordance with MS Windows standard 
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Structure Mode 

• ACD/Labs now supports a usage of special coordination bonds that represent a specific 
bonding between a ligand and metal center in coordination structures.  Such bonds indicate a 
connection but do not affect the valence of the corresponding atoms.  
Version 10.0 vs. version 11.0: 
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• Simplified usage of structure drawing styles 
• Possibility to use both superscript and subscript characters in the same label. 

Draw Mode 

• Ability to insert and export images with .PNG extension 
• Editing of the previously inserted text using the same tool 

1.4 Freeware Version 

From April 1999 onward, ACD/Labs has been making ChemSketch available as freeware, 
through the “Free Stuff” link at our Web site. 

Now version 11.0 of ACD/ChemSketch can be downloaded for free! 

Important ACD/ChemSketch freeware should be installed in its own separate folder.  
This folder can contain other ACD/Labs freeware concurrently available but 
should not contain any purchased ACD/Labs software. 

All of the limitations on Freeware and also the Frequently Asked Questions (FAQs) can be found 
on our Web site at http://www.acdlabs.com/products/chem_dsn_lab/chemsketch/tech.html. 

Note Although ACD/ChemSketch freeware does not entitle you to technical support, we 
encourage you to visit the ChemSketch newsgroup where you can post your 
questions or share tips. 
http://forum.acdlabs.com 

 

http://www.acdlabs.com/products/chem_dsn_lab/chemsketch/tech.html�
http://forum.acdlabs.com/�
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2. Interface Overview 

2.1 Objectives 

This chapter will familiarize you with the ChemSketch window and its basic elements. 

Instructions for system requirements, and for installing and uninstalling the software are provided 
on a separate sheet of paper, shipped with the software itself. 

2.2 Common Window Elements 

When describing the program throughout this reference manual, some terms defining various 
parts of its interface are used.  Below, you will find some general information on the interface 
arrangement. 

At the very top of each window, there is a title bar that shows the name of the program, name of 
the current window and buttons controlling the size and position of the window (for more details, 
refer to the Section 2.3). 

Right below the title bar, you will find the menu bar that contains the program menus.  By clicking 
the menus, you can access the program commands. 

Below the menu bar, you can see one or two toolbars containing buttons that you use for 
working in that window (note that each toolbar of the ACD/Labs programs can be customized; for 
more information, refer to the Section 2.2.1).  These toolbars are specific for each window and 
are referred to with different names (e.g., you can find General and Editing toolbars in the 
ChemSketch window). 

Workspace is a changeable part of a window where you work (draw structures, view results of 
your manipulations, see the opened files and databases, etc.).  The workspace may be divided 
into several subwindows each of which display a specific type of data. 

Beneath the workspace, there is usually a status bar that displays information that may be useful 
for your work at the current moment, e.g., the name of the currently opened file, the position of 
the cursor in the workspace, etc. 

If ACD/ChemSketch is run from another ACD/Labs program, at the very bottom of each window, 
the Window Switching bar incorporates buttons for switching between the program windows 
and for performing specific actions that result in switching to another window.  For example, 

clicking Substructure Search  will start the substructure search and as a result will 
automatically switch to the Database window displaying the search result. 
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2.2.1 Toolbar Customization 

The toolbars of each ACD/Labs program can be customized by right-clicking the toolbar.  The 
following options are available on the context menu that appears. 

• Toolbar buttons—you can cancel the selection of a button to hide it. 
• Reset Toolbar—selects all of the toolbar buttons on the list. 

If some of the buttons do not fit, More Buttons  appears on the toolbar.  Some of the toolbars 
display the shortcut menu containing the following additional commands: 

• Chevron Style—adds More Buttons  at the end of the toolbar if the buttons do not fit on 
the toolbar. 

• Wrap Style—splits the toolbar into two parts (one under another) if the buttons do not fit on 
the toolbar. 

• Gray Scale Style—switches on/off the toolbar buttons' coloration. 
• Colored Highlight—switches on/off the coloration of the selected buttons (when a button 

is pressed or the mouse pointer is placed on a button). 

2.3 Title Bar 

At the very top of the window, there is a title bar that shows the name of the program, the name 
of the current window, the name and location of the currently open file (the default file name is 
NONAMEXX.SK2, where ‘XX’ is the ordinal number of a file starting from 00), and three small 
buttons controlling the size and position of the window.  If the window does not fill the entire 
screen, dragging the title bar will move the window but will not change its size. 

Click the program icon on the left side of the bar to view the commands controlling the window.  
Some of them are present on the title bar as the buttons: 

Buttons Description 

 Minimize button—reduces the window.  Note that this option is available only if the window 
is not already minimized. 

 Restore button—returns the window to its previous size.  Note that this option is available 
only if the window is maximized. 

 Maximize button—makes the window fill the entire screen.  Note that this option is 
available only if the desktop or window is not already maximized. 

 Close button—closes all of the opened documents.  If you have made any changes to the 
opened document and haven't saved your work yet, the program prompts you to do so. 

 Control Menu box—displays the shortcut menu with the listed above commands. 
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2.4 Color Palette 

The Color palette is displayed horizontally below the workspace and allows you to change the 
color of the selected objects. 

You can display/hide the Color palette by selecting/clearing the Palette check box in the 
Preferences dialog box (General tab) or by selecting Show Palette on the Options menu. 

To display more colors, click More  to the right of the palette. 

To change the color of the selected objects, click the required color on the Color palette 
according to the following scheme: 

• In the Structure mode, clicking the color box changes the color of selected atoms and right-
clicking the color box changes the color of selected bonds. 

• In the Draw mode, clicking the color box changes the fill color of selected objects, right-
clicking the color box changes the pen color of the selected objects. 

2.5 RSS News bar 

RSS News bar is a line displayed above the status bar that lists the latest news from ACD/Labs 
and Reactive Reports and any other RSS channels specified by you. 

Note You can display/hide the RSS News bar by selecting/clearing the RSS check box 
in the Preferences dialog box (General tab), or by selecting Show RSS on the 
Options menu. 
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2.5.1 RSS Channels Dialog Box 

This dialog box allows you to add, remove RSS channels and set options of displaying news 
creeping line. 

To display this dialog box, on the RSS News bar, click . 

 

 

Option Description 
RSS Channels  Displays a list of RSS channels.  Select the check boxes of the 

channels you want to be displayed. 
Note that ACD/Labs RSS Feed and Reactive People news cannot be 
switched off. 

 
Click this button to add the new URL to the RSS Channels list. 

 
Click this button to delete the currently highlighted row of the required 
channel in the RSS Channels list. 
Note that you cannot delete Reactive People and ACD/Labs News 
channels.   

Update Every…min. Specify the interval of information renewal (in the range from 1 to 120 
minutes). 

Scroll Items Select this check box to set continuous scrolling of RSS News bar.  If 
this check box is not selected, the bar is scrolled with pauses of several 
seconds. 

Scroll Speed Move the slider left or right to set the speed of scrolling. 

 
Displays the HTTP Proxy Parameters dialog box.  For more 
information refer to Section 2.5.2. 

 
Click this button to apply the specified settings without closing the dialog 
box. 
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2.5.2 HTTP Proxy Parameters Dialog Box 

This dialog box allows you to specify parameters of the Proxy Server if the latter is required. 

To display this dialog box, in the RSS Channels dialog box, click Proxy . 

 

Option Description 
Use Default Proxy Settings Select this check box to use the default settings of the Proxy Server 

specified in Internet Explorer. 

Use Proxy Server Select this check box to specify the required IP address and port 
number of the Proxy Server in your local network. 

Need authentication Select this check box to specify Proxy Server access credentials in the 
Login and Password boxes. 

 
Click this button to apply the default settings of the Proxy Server 
specified in Internet Explorer. 

 

2.6 Status Bar 

The status bar is displayed horizontally at the bottom of the ChemSketch window, below the 
Color palette.  It contains a great deal of useful information: 

Element Function 

 ACD/I-Lab indicators.  For more information, refer to the technical 
documentation on ACD/I-Lab. 

 Allows you to login to ACD/I-Lab. 

 Shows your current I-Lab balance. 

 Displays the name of the current document (also shown on the title bar). 
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Element Function 

 Shows the status of the document: either modified or not. 

 
Displays the previous page in the current document (if any). 

 
Shows the number of the current page/number of pages in the 
document.  Clicking this button displays the list of all the pages. 

 
Displays the next page in the current document (if any). 

 /  In the Structure mode, shows the number of fragments in the workspace 
or the number of selected fragments. 

 In the Structure mode, shows the molecular formula of the selected 
fragment / structure (if any) or the overall number of elements currently 
present on the page (if no fragment or structure is selected). 
Note that if the Composition property is selected (see below), this box 
displays the percent ratio between drawn atoms of elements: 

 

 In the Structure mode, shows the currently selected property calculated 
for the drawn structure. 

 
In the Structure mode, displays a menu of different properties of the 
structure currently displayed.  Select one of the properties and the 
information is provided in the special box on the status bar (see above).  
Note that this button is labeled with the name of the property currently 
displayed in the Properties box.  When a different property is selected, 
the button label changes accordingly. 

 
In the Structure mode, during the 3D optimization, shows the progress 
of the optimization and allows you to cancel it (for more information, 
refer to Section 3.12.4). 

2.7 Structure and Draw Modes 

When ACD/ChemSketch starts up, you will find many menu commands and toolbar buttons 
appear dimmed (inactive).  They will be made available as soon as you draw a structure. 

In the ChemSketch window, there are two modes, Structure and Draw.  You can switch between 
them using the buttons on the General toolbar: 

 
In the Structure mode, you can draw structures and reaction schemes while the Draw mode 
provides you with the tools for typing text and drawing various graphical objects.  The interface 
elements in these modes differ. 

For more information on ACD/ChemSketch working modes, refer to the chapters that follow.
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3. Structure Mode 

3.1 Objectives 

This chapter acquaints you with: 
• The general capabilities of the Structure mode 
• The Structure mode interface at a glance 
• A detailed description of each command, tool, and interface part available in the Structure 

mode 

To switch to the Structure mode, on the General toolbar, click Structure . 

3.2 General Information 

In the Structure mode, you can perform the following actions: 
• Draw chemical structures using the buttons located on the different toolbars of the 

ChemSketch window. 
• Instantly see either the elemental composition or the formula and formula weight of the drawn 

structure(s) or chemical property of the selected structure on the status bar. 
• Calculate the molar refractivity, molar volume, parachor, index of refraction, surface tension, 

density, and some other physicochemical properties for the selected structure.  You can copy 
the results of calculation to the ChemSketch window. 

• Find chemical structures according to their systematic or non-systematic names, therapeutic 
category or inhibited enzyme by using the integrated ACD/Dictionary (included in the 
commercial version only).  You can also draw a structure and see all of its names, type of 
therapeutic category, and inhibited enzymes, which are listed in ACD/Dictionary. 

• Retrieve NMR and Mass reference data from the expanded Periodic Table of Elements. 
• Check the most favorable tautomeric forms of the drawn structure and automatically correct 

the structure by using the integrated Tautomeric Forms function on the Structure toolbar. 
• Convert 2D structures into their 3D counterparts and view, measure, and handle them in 

virtual 3D. 
• Produce a cleaned-up version of a structure. 
• Draw chemical reactions and label reaction arrows to simplify editing of specific experimental 

conditions.  Associate atoms in reactant to product schemes with atom-atom mapping. 
• Save or load structures to or from a file on the disk, export or import structures to or from MDL 

molfiles, cut and paste structures to other Windows applications, by using the File menu 
commands. 
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3.3 Screen 

Below, you can see the screen with the Structure mode enabled.  The names and positions of the 
toolbars and the other elements to be used throughout this manual are introduced. 

ChemBasic toolbar

Menu bar
Title bar

General toolbar

Structure toolbar

Atoms 
toolbar

Reference 
toolbar

Workspace

Color Palette

Status bar
RSS News bar

 
This table gives the short description of each interface element designated in the above picture: 

Interface Element Function 
Title bar This bar shows the name of the program, the name and location of the currently 

open file, and buttons controlling the size and position of the window (for more 
information on the title bar, refer to Section 2.3). 

Menu bar This bar contains a series of words.  Each word links to a list (‘menu’) of related 
commands for working in the ChemSketch window in the Structure mode (for a 
detailed description of each menu and the commands it contains, refer to Sections 
3.9–3.19). 

General toolbar This toolbar includes tools that are present in both Structure and Draw modes and 
will help you with tasks relevant to both modes such as: saving, opening files, 
undoing/redoing operations, copying and pasting, zooming in and out, as well as 
inserting various templates (for more information, refer to Section 3.5). 
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Interface Element Function 
ChemBasic toolbar This toolbar includes additional tools that extend the functionality of 

ACD/ChemSketch.  Note that the ChemBasic toolbar is present in both Structure 
and Draw modes if you have the Goodies tools previously installed (for more 
information, refer to Appendix C). 

Structure toolbar This toolbar is only present in the Structure mode.  It contains tools for drawing and 
manipulating chemical structures (for more information, refer to Section 3.6). 

Atoms toolbar This toolbar contains buttons representing atoms, as well as tools for changing atom 
properties (for more information, refer to Section 3.7). 

References toolbar This toolbar contains the Table of Radicals and various buttons representing ready-
made radicals you take from the table.  You can also access ACD/Dictionary (—
Commercial version only!) from this toolbar.  For more information, refer to 
Section 3.8. 

Workspace The workspace is the current ChemSketch page where you can draw and edit the 
required objects (structures, reactions, pictures). 

Color Palette Allows you to quickly color atoms and bonds in the selected chemical structures (for 
more information, refer to Section 2.4). 

Status bar This bar contains information that may be useful for the current moment: name of 
the opened .SK2 file, page number, molecular formula of the selected structure, etc.  
It also contains a button for automatic I-Lab access.  For more information, refer to 
Section 2.6. 

3.4 Menu Bar 

Right below the title bar, you will find the menu bar that contains the program menus.  By clicking 
the menus you can access the program commands. 

 
For detailed information on the commands that are available from the menus of the ChemSketch 
window in the Structure mode, refer to Sections 3.9–3.19. 

3.5 General Toolbar 

In both Structure and Draw modes, below the menu bar, the General toolbar is displayed.  The 
General toolbar contains buttons for opening and closing files, undoing/redoing actions, 
cutting/copying/pasting, and zooming.  Most of the buttons on this toolbar are shortcuts of the 
menu commands; the other buttons are tools that have no corresponding menu command. 

The table below gives the short description of all of the buttons available on the General toolbar: 

Button Function Menu Command 

 
Switches to the Structure mode. No corresponding menu 

command. 

 
Switches to the Draw mode (for more information on this mode, 
refer to Section 4). 

No corresponding menu 
command. 

You can also press SPACEBAR to switch between the Structure and Draw modes. 
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Button Function Menu Command 

 
Adds a new empty document (see Section 3.9.1). New command (File 

menu). 

 
Adds a new empty page at the end of the current document 
(see Section 3.11.1). 

New command (Pages 
menu). 

 
Displays the Open dialog box where you can specify the name 
and location of an .SK2 file to be open (see Section 3.9.2). 

Open command (File 
menu) 

 
Saves the currently open document.  When you are saving 
your work for the first time, the Save Document As dialog box 
prompts you to specify the file name and location (see Sections 
3.9.4–3.9.5). 

Save or Save As 
command (File menu) 

 
Displays the Print dialog box where you can specify the 
required settings for printing the current document (see Section 
3.9.12). 

Print command (File 
menu) 

 
Displays the Export dialog box where you can specify the 
name and location of an Adobe PDF file to which the current 
document is to be exported (see Section 3.9.7) 

Export command (File 
menu) 

 
Cancels the last action (see Section 3.10.1). Undo command (Edit 

menu) 

 
Reverts the last canceled action (see Section 3.10.2). Redo command (Edit 

menu) 

 
Enables the Delete tool that allows you to delete specific 
objects in the workspace (see Section 3.5.1). 

No corresponding menu 
command. 

 
Removes the selected object from the workspace and places it 
to the Clipboard (see Section 3.10.3). 

Cut command (Edit 
menu) 

 
Copies the selected object to the Clipboard (see Section 
3.10.4). 

Copy command (Edit 
menu) 

 
Allows you to insert the contents of the Clipboard into the 
workspace (see Section 3.10.5). 

Paste > Default 
command (Edit menu) 

 
Enables the Zoom In tool that allows you to get a close-up 
view of objects (see Section 3.5.2). 

No corresponding menu 
command. 

 
Reduces the display of the objects according to the pre-defined 
factor (see Section 3.5.3). 

No corresponding menu 
command. 

 
Allows you to control the image scale (see Section 3.5.4). No corresponding menu 

command. 

 
Sets the workspace display to 100% (see Section 3.5.4). No corresponding menu 

command. 

 
Displays the current page to the full width and height in the 
workspace (see Section 3.5.4). 

No corresponding menu 
command. 

 
Fits all of the objects on the current ChemSketch page into the 
workspace (see Section 3.5.4). 

No corresponding menu 
command. 

 
Fits the selected objects into the workspace (see Section 
3.5.4). 

No corresponding menu 
command. 

The zoom-in and zoom-out functions re-scale the display of the objects on the screen, but do not affect the 

actual size of the objects.  To re-size objects, use the Select/Move/Resize  tool (Draw mode) or the 

Select/Rotate/Resize  tool (Structure mode). 
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Button Function Menu Command 

 
Displays the Template Window dialog box that contains both 
the built-in and user-defined templates to simplify drawing 
structures (see Section 3.13.1). 

Template command 
(Templates menu) 

 
Displays the Search for Structure dialog box that allows you 
to find the required structures in the specified files without 
opening them (see Section 3.12.25) —Commercial version 
only!. 

Search for Structure 
command (Tools menu) 

 
Generates the name for the selected structure or structures 
(see Section 3.12.16). 

Generate > Name for 
Structure command 
(Tools menu) 

 
Displays the ACD/Name to Structure dialog box that allows 
you to generate structures from names (see Section 3.12.17). 

Generate > Structure 
from Name command 
(Tools menu) 

 
Runs ACD/3D Viewer (see Section 3.5.5). No corresponding menu 

command. 

 
Closes the active document (see Section 3.9.3). Close command (File 

menu). 

Note Toolbars of most ACD/Labs programs can be customized using the toolbar 
shortcut menu (for more information, refer to Section 2.2.1). 

3.5.1 Delete Button 

This button enables the Delete tool allowing you to remove objects in the workspace.  Note that 
this tool works differently in the Structure and Draw modes. 

Structure mode 

In this mode, you can delete both whole chemical structures or graphical objects and the 
structural fragments or single atoms or bonds. 

Note To be able to select and delete the objects created in the Draw mode, as well as 
reaction pluses and arrows, in the Preferences dialog box (Structure tab), select 
the Select Graphics check box. 

To delete an atom or bond: 

• Click Delete  to enable the corresponding tool, and then click an atom or bond you want to 
delete. 
The Delete tool removes the pointed atom and the adjacent bonds.  It never leaves single 
atoms in the workspace.  However, you can retain parts of a structure; hold down CTRL and 
click a bound atom (for example, the central atom in isobutene).  Only the atom you click 
disappears—all other atoms are retained. 
The Delete tool erases the pointed bond. If a single atom is left after the deletion process, it is 
also automatically removed.  However, you can retain all single atoms if you hold down CTRL 
when using the Delete tool.  
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To delete a structural fragment: 
1. With the Delete tool active drag over the structural fragment you want to delete so that the 

selection squares appear. 
2. Point to any of selection nodes so that they become black, and then click. 

Tip To delete several fragments at once, hold down CTRL while selecting them, then 
release CTRL, point to any of the selection nodes so that they become black, and 
click. 

To delete whole structure(s): 
1. With the Delete tool active drag over the structure(s) you want to delete so that the selection 

squares appear. 
2. Point to any of selection nodes so that they become black and click. 

Tip To delete the selected objects, you can also use the Delete command (Edit menu).  
Note that this command is available only if there is a selection. 

Draw mode 

In this mode, you can delete whole chemical structures and graphical objects. 

To delete an object: 

1. Click Delete  to enable the corresponding tool.  Note that the cursor, in this case, 

becomes an arrow labeled Del . 
2. Point to the object you want delete so that the contour appears around it, and then click. 

To delete several objects at once: 
1. With the Delete tool active drag over the objects you want to delete so that the selection 

squares appear. 
2. Point to any selected object so that the contours appear around all of the selected objects and 

click. 

Note To delete a part of a structure, switch to the Structure mode and follow the 
aforementioned regulations. 

3.5.2 Zoom Buttons 

You can zoom the required part of the workspace using the Zoom In  and Zoom Selection 

 buttons on the General toolbar. 

The Zoom In  button allows you to magnify the workspace.  Click this button to enlarge the 
display of objects from their current magnification up to the next preset scale (see the zoom 
control box list) and center them on the screen.  

The Zoom Selection  tool allows you magnify the selected part of the workspace.  When you 
click the button, the cursor turns into a magnifying glass.  Select the area you want to see 
magnified by dragging over it.  The selected area will be fit into the workspace display. 
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To restore the fragment to the previous view, use the Zoom Out  tool. 

Important This function re-scales the display of the objects on the screen, but does not 
affect the actual size of the objects.  To re-size objects, use the 

Select/Rotate/Resize  tool (Structure mode) or the Select/Move/Resize 

 tool (Draw mode). 

3.5.3 Zoom Out Button 

This button  enables the Zoom Out tool allowing you to reduce the display of the objects from 
their current magnification to a pre-defined factor every time you click this button. 

To magnify an object, on the General toolbar, click Zoom In  or Zoom Selection . 

To magnify the screen to specific dimensions, use the Full Page , Page Width , or Fit 

All  tools (for more information, refer to the next section). 

Important This function re-scales the display of the objects on the screen, but does not 
affect the actual size of the objects.  To re-size objects, use the 

Select/Rotate/Resize  tool (Structure mode) or the Select/Move/Resize 

 tool (Draw mode). 

3.5.4 Zoom Box and Image Scaling Buttons 

This box  controls the image scale.  Choose the percentage of decrease or increase 
from the drop-down list. 

Important This function re-scales the display of the objects on the screen, but does not 
affect the actual size of the objects.  To re-size objects, use the 

Select/Rotate/Resize  tool (Structure mode) or the Select/Move/Resize 

 tool (Draw mode). 

In this box, you can select one of the following: 

Option Description Button 
Full Page Displays the current page to the full width and height in the 

workspace.  

Page Width Displays the current page to the full width in the workspace. 
 

Fit Selected Fits the selected objects into the workspace.  

Fit All Fits all of the objects on the current ChemSketch page into the 
workspace.  

Magnification scale Select one of the magnification values: 25%, 50%, 75%, 100%, 
150%, 200% and 400% to enlarge or reduce the display. 

 

Tip You can also manually type the percentage value in the box.  The minimum available 
value is 10; the maximum magnification is 500.  To input your own value, just click in 
the box, type the value, and then press ENTER. 
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3.5.5 3D Viewer Button 

This button starts ACD/3D Viewer that is a fast yet accurate 3D modeling and visualization 
program.  It is fully integrated with ACD/ChemSketch, allowing you to draw 2D structures and 
quickly obtain their 3D representations in a striking 16 color display.  For more information, refer 
to the ACD/3D Viewer User’s Guide located in the ACD/Labs documentation folder 
(\\DOCS\3D.PDF). 

3.6 Structure Toolbar 

In the Structure mode, below the General toolbar, the Structure toolbar containing buttons for 
drawing chemical structures is displayed.  

The table below lists all of the buttons available on the Structure toolbar and gives the short 
description for each of them. 

Button Description 

 
Allows you to select and move objects over the workspace (see Section 3.6.1). 

 
Allows you to select, move, and rotate objects on the workspace (see Section 3.6.2). 

 
Allows you to rotate the selected structure or structural fragment in 3D (see Section 3.6.3). 

 
Switches between two modes of selection: lasso and rectangular box (see Section 3.6.4). 

 
Allows you to draw bonds (see Section 3.6.5). 

 
Allows you to draw bonds in a continuous mode (see Section 3.6.6). 

 
Allows you to draw chains (see Section 3.6.7). 

 
Allows you to draw stereo bonds facing towards the viewer (see Section 3.6.8). 

 
Allows you to draw stereo bonds facing away from the viewer (see Section 3.6.9). 

 Allows you to draw various coordinating bonds (see Section 3.6.10).  

 
Allows you to draw bonds of some special types (see Section 3.6.11). 

 

 Allows you to draw delocalized bonds (see Section 3.6.12).  

 Allows you to draw Markush bonds (see Section 3.6.13).  

 
Allows you to draw reaction pluses (see Section 3.6.14). 

 
Allows you to draw reaction arrows.  Clicking the white triangle on the button displays more 
arrow tools (see Section 3.6.15). 

 



2BStructure Mode 

ACD/ChemSketch  Reference Manual 18 

Button Description 

 
Allows you to label reaction arrows (see Section 3.6.16). 

 
Allows you to automatically calculate synthesis data for each reaction components (see 
Section 3.6.17). 

 
Allows you to map a drawn reaction either manually or automatically (see Section 3.6.18). 

 
Allows you to draw polymers (see Section 3.6.19). 

 
Allows you to change the double bond arrangement, hydrogen position, bond intersection 
point, and connection point of an atom label (see Section 3.6.20). 

 
Allows you to rotate a chemical structure so that a chosen bond becomes horizontal (see 
Section 3.6.21). 

 
Allows you to rotate a chemical structure so that a chosen bond becomes vertical (see 
Section 3.6.22). 

 
Allows you to flip a chemical structure or selected fragment on the axis of a chosen bond (see 
Section 3.6.23). 

 
Rotates the selected chemical structure on its horizontal axis, giving its mirror reflection (see 
Section 3.6.24). 

 
Rotates the selected chemical structure on its vertical axis, giving its mirror reflection (see 
Section 3.6.25). 

 
Allows you to create an instant template based on any structure or selected fragment, so that 
you can insert it anywhere in the workspace or attach it to another structure (see Section 
3.6.26). 

 
Redraws and resizes the selected chemical structures to standardize all of the bond lengths 
and angles (see Section 3.12.2). 

 
Checks and generates the most reasonable tautomeric forms of drawn organic structures 
(see Section 3.12.3). 

 
Creates a 3D model of a 2D chemical structure (see Section 3.12.4). 

 
Calculates boiling point (BP), vapor pressure (VP), enthalpy of vaporization, and flash point 
for the selected structure (see Section 3.12.5). 

 
Calculates and displays monoisotopic mass for several fragments of a structure (see Section 
3.12.6). 

 Calculates electronic constants—σ of different types (e.g., inductive, resonance, meta, para 
etc.) for substituents (see Section 3.6.27). 

Note The toolbars of each ACD/Labs program can be customized using the toolbar 
shortcut menu (for more information, refer to Section 2.2.1). 

3.6.1 Select/Move Button 

This button  enables the Select/Move tool allowing you to select and move atoms, bonds, 
fragments, structures, and graphical objects. 

You can quickly switch from the Select/Move mode to the: 

• Draw Normal mode ( ) by pressing ESC 
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• Select/Rotate/Resize mode ( ) by right-clicking in the workspace 

Tip To be able to select and move objects created in the Draw mode, as well as reaction 
pluses and arrows, make sure that the Select Graphics check box is selected in the 
Preferences dialog box (Structure tab).  For more information on this dialog box, 
refer to Section 3.14.1.2. 

Table 1.  The table below summarizes the actions you can perform to select objects (note that 

the Select/Move tool must be active ): 

To Select Do This 

Atom or bond Click any atom or bond on the required structure. 

Fragment or structure Drag over the required fragment or structure (you can previously set 
either Lasso or Rectangular selection mode; refer to Section 3.6.4). 

Multiple structures, 
fragments 

Drag over the required fragments or structures holding down SHIFT (you 
can previously set either Lasso or Rectangular selection mode; refer to 
Section 3.6.4). 

Entire structure Click an empty space in the drawing area adjacent to, but not touching, 
the structure you wish to select. 

All the structures in the 
workspace 

Click an empty space in the drawing area away from any drawn structure 
until all the structures are selected and marked with hollow squares.  
Clicking again will deselect all of the structures. 

Objects drawn in the Draw 
mode 

Click the object once. 

All the objects drawn in the 
Structure and Draw modes 

Press CTRL+A. 

Table 2.  The table below summarizes the actions you can perform to move objects (note that the 

Select/Move tool must be active : 

To Move Do This 

Selected object without 
snap on grid 

If Snap On Grid is not selected on the Options menu (refer to Section 
3.14.3), point to the object so that the contour appears around it (for 
graphics) or so that the hollow selection squares become black (for 
structures) and drag. 
If Snap On Grid is selected, hold down SHIFT+CTRL while moving. 

Selected object leaving its 
copy behind 

Point to the object so that the contour appears around it (for graphics) or 
so that the hollow selection squares become black (for structures), press 
CTRL and hold it down while dragging. 

Selected object fixing the 
object’s coordinates along 
one of the axis 

To move the selected object exactly along the X (Y) axis without 
changing the coordinates along the Y (X) axis, hold down SHIFT while 
moving. 

Selected object snapping on 
grid 

If Snap On Grid is not selected on the Options menu, hold down 
SHIFT+CTRL while moving.  
If Snap On Grid is selected, simply drag the object. 

Note If the Informative Cursor check box in the Preferences dialog box (General tab) 
is selected, the new object’s coordinates (relative to its original location) are 
displayed near the cursor. 

If you double-click the selected structural fragment or the whole structure with this tool active, the 
Properties panel (for more information on options available in this panel, refer to Section 3.12.1) 
appears.  On this panel, you can change the style of the selected object. 
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3.6.2 Select/Rotate/Resize Button 

This button  enables the Select/Rotate/Resize tool allowing you to select, move, and resize 
atoms, bonds, fragments, structures, and graphical objects.  Note that this tool influences the 
actual size of the object; to change the size of the object display, use the zooming tools (refer to 
Sections 3.5.2–3.5.4). 

Note To be able to manipulate objects created in the Draw mode, as well as reaction 
pluses and arrows, make sure that the Select Graphics check box is selected in 
the Preferences dialog box (Structure tab).  For more information on this dialog 
box, refer to Section 3.14.1.2. 

The actions you can perform to select the required objects on the ChemSketch page are 
described in Table 1 of the previous section. 

Table 3.  The table below summarizes the actions you can perform to rotate objects: 

To Rotate Do This 

Unselected object Drag the object by any of its elements (the object will be rotated around its 
center). 

Selected object around its 
center 

Point to the object so that the cursor changes to  and drag (the object will 
be rotated around its center). 
Prior to rotating make sure that the object’s action center is located 
correctly.  To view the action center on an object, in the 
Preferences dialog box (Structure tab), under Show, select 
Action Center. 

Selected object around the 
specified point 

1. In the Preferences dialog box (Structure tab), under Show, select 
Action Center. 
2. Define the center of rotation either by dragging the action center  to 
the required location or by clicking the required location holding down 
CTRL (action center is placed there automatically in this case). 
3. Point to the object so that the cursor changes to  and drag. 

Selected object in 15 
degree increments 

Drag the object holding down SHIFT—the selected object will be rotated at 
the required angle multiple of 15° around its action center. 

Note To view the angle of rotation displayed by the cursor, in the Preferences dialog 
box (General tab), select the Informative Cursor check box. 

Table 4.  The table below summarizes the actions you can perform to resize objects: 

To Resize Do This 

Selected object relative to one 
of its sides or corners 

1. In the Preferences dialog box (Structure tab), under Show, clear 
Action Center. 
2. Point to the required selection handle so that the cursor changes to a 
two-way arrow (  , ,  , or  ), and drag. 
Dragging the top/bottom selection handles resizes the object’s height; 
dragging the left/right handles resizes the width; and dragging the 
corner handles resizes the object proportionally in all directions. 
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To Resize Do This 

Selected object relative to the 
specified point 

1. In the Preferences dialog box (Structure tab), under Show, select 
Action Center. 
2. Define the center of resizing either by dragging the action center  
of the selected object to the required location or by clicking the required 
location holding down CTRL. 
3. Point to the required selection handle so that the cursor changes to a 
two-way arrow ( ,  ,  , or  ), and drag.  Dragging the top/bottom 
selection handles resizes the object’s height; dragging the left/right 
handles resizes the width; and dragging the corner handles resizes the 
object proportionally in all directions. 

Selected object relative to its 
center 

Hold down CTRL when dragging a selection handle as described 
above. 

Selected object at certain 
percent 

Hold down SHIFT when dragging a side selection handle as described 
above—the selected object will be resized by percent value multiple of 
5. 

Selected object so that the 
height and width change 
independently 

Hold down SHIFT when dragging a corner selection handle as 
described above. 

Note To view the percentage of resizing displayed by the cursor, in the Preferences 
dialog box (General tab), select the Informative Cursor check box. 

You can quickly switch between this tool and the Select/Move  tool by right-clicking in the 
workspace. 

3.6.3 3D Rotation Button 

This button  enables the 3D Rotation tool allowing you to rotate structures or selected 

fragments in three dimensions.  Click 3D Rotation  and point to any bond or atom so that it is 
surrounded with a rectangle and drag. 

Note that the direction of rotation of the front atoms in the 3D-optimized structure corresponds to 
the movement of the cursor.  That is dragging to the right makes the front atoms move to the 
right.   

If you are using the up and down stereo bonds for defining the direction of bonds, you should do 
that on the "flat", non-3D-optimized structure and then start 3D optimization anew. 

Tip You can designate any bond as the axis of 3D-rotation by clicking it while holding 
down CTRL.  The bond will be marked with red.  To cancel this, click the bond once 
again while holding down CTRL. 

You can quickly switch from this tool to the Select/Move tool  by right-clicking in the 
workspace. 

3.6.4 Lasso On/Off Button 

These buttons  /  control the mode used for selecting structures.  There are two selection 

modes.  The first mode ( ) selects objects with the rectangular selection box, while the second 

mode selects objects with the lasso selector line ( ).  Note that the latter one, the lasso, allows 
you to select objects in a more specific and precise manner. 
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To choose between selection modes, click the button.  To select the required object on the 
screen, drag over it. 

Note In most cases, clicking the Lasso On/Off button automatically enables the 

Select/Move tool . 

3.6.5 Draw Normal Button 

This button  enables the Draw Normal tool allowing you to draw chemical bonds in the 

normal mode where, unlike the Draw Continuous tool , you can draw new chemical bonds 
to or from any atom on the screen by clicking the desired atom or dragging from it.  Note that the 
Draw Normal tool is automatically on when ChemSketch is loaded. 

Note You can quickly switch between the Draw Normal and Draw Continuous tools by 
right-clicking in the workspace. 

The table below summarizes the actions you can do with this tool: 

This Action Does This 
Clicking in the workspace. Draws an atom currently selected on the Atoms toolbar. 

Clicking a separate atom of the same type 
as the atom selected on the Atom toolbar. 

Draws a single bond with the default length. 

Clicking a bound atom of the same type as 
the atom selected on the Atom toolbar. 

Draws a single bond at an angle of 120° to the existing 
bond. 

Clicking a bound atom of the same type as 
the selected atom holding down CTRL. 

Draws a single bond at an angle of 180° to the existing 
bond. 

Clicking an atom of a type different from 
the atom selected on the Atom toolbar. 

Changes the atom type to that of the selected one.  Note 
that you can draw a bond having an atom of the selected 

type at the end with the Draw Continuous tool  
active (for more information, refer to the section that 
follows). 

Clicking a bond. Switches between possible bond types 
(single / double / triple).  

Dragging. Draws a single bond at any angle and of any length. 
If the Fixed Bond Angle and Bond Length check boxes 
are selected in the Preferences dialog box (Structure 
tab), you can draw bonds of a length multiple to the 
specified value and at an angle multiple to 15°.  If Snap 
on Grid from the Options menu is selected, the drawing 
is constrained by the grid. 

Holding down SHIFT and dragging. Draws a single bond of a length multiple to the value 
specified in the Fixed area of the Preferences dialog box 
(Structure tab) and at an angle multiple to 15°. 
If the Fixed Bond Angle and Bond Length check boxes 
are selected in the Preferences dialog box (Structure 
tab), you will draw bonds at any angle and of any length. 

Holding down SHIFT+CTRL and dragging. Draws a single bond according to the grid. 
If Snap on Grid from the Options menu is selected, the 
drawing is not constrained by the grid. 

Right-clicking an empty space. 
Switches to the Draw Continuous tool . 
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3.6.6 Draw Continuous Button 

This button  enables the Draw Continuous tool allowing you to draw chemical bonds in a 

continuous mode where, unlike the Draw Normal tool , new chemical bonds can only be 
drawn from one specific atom which is selected (placed into the black square).  If none of atoms 
is selected, click any atom to select it or click an empty workspace to insert a new atom.  Note 
that only one atom can be selected at a time on the screen. 

Note You can switch between the Draw Normal and Draw Continuous tools by right-
clicking in the workspace. 

The table below summarizes the actions you can do with this tool: 

This Action Does This 
Clicking in the workspace. Draws an atom currently selected on the Atoms toolbar 

and highlights it. 

Clicking an existing atom of the same type 
as the atom selected on the Atom toolbar. 

Highlights the atom. 

Repetitive clicking the same atom. Draws a single bond with the default length connected to 
the atom of the same type. 

Repetitive clicking any other atom. Connects the two atoms. 
Repetitive clicking in the workspace. Draws atoms of the same type connected with single 

bonds. 

Clicking an atom of a type different from 
the atom selected on the Atom toolbar. 

Highlights the existing atom. 

Clicking this highlighted atom for the second 
time. 

Draws a single bond of a default length from the 
highlighted atom and places the atom of the selected type 
at the end of this bond. 

Clicking any other atom for the second 
time.. 

Connects the two atoms with a single bond. 

Repetitive clicking in the workspace. Draws atoms of the type selected on the Atoms toolbar 
and connects them with single bonds. 

Double-clicking a bound atom. Draws a single bond connecting an atom of the selected 
type at an angle of 120° to the existing bond. 

Holding down CTRL and double-clicking a 
bound atom. 

Draws a single bond connecting an atom of the selected 
type at an angle of 180° to the existing bond. 

Clicking a bond. Switches between possible bond types 
(single / double / triple). 

Dragging.  Draws a single bond at any angle and of any length. 
If the Fixed Bond Angle and Bond Length check boxes 
are selected in the Preferences dialog box (Structure 
tab), you can draw bonds of a length multiple to the 
specified value and at an angle multiple to 15°. 
If Snap on Grid from the Options menu is selected, the 
drawing is constrained by the grid. 

Holding down SHIFT and dragging. Draws a single bond of a length multiple to the value 
specified in the Fixed area of the Preferences dialog box 
(Structure tab) and at an angle multiple to 15°. 
If the Fixed Bond Angle and Bond Length are selected 
in the Preferences dialog box (Structure tab), you will 
draw bonds at any angle and of any length. 
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This Action Does This 
Holding down SHIFT+CTRL and dragging. Draws a single bond according to the grid. 

If Snap on Grid from the Options menu is selected, the 
drawing is not constrained by the grid. 

Right-clicking an empty space. 
Switches to the Draw Normal tool . 

3.6.7 Draw Chains Button 

This button  enables the Draw Chains tool allowing you to draw atom chains.  To draw a 
long atomic chain, drag in the workspace with this tool active. 

Note To view the number of chain members displayed by the cursor as you drag with 
this tool, in the Preferences dialog box (General tab), select the Informative 
Cursor check box. 

The table below summarizes the actions you can perform with this tool: 

This Action Does This 
Clicking in the empty space. Draws an atom currently selected on the Atoms toolbar. 

Clicking a single atom of the same 
type as the atom selected on the 
Atoms toolbar. 

Draws a bond with the default length. 

Clicking a bound atom of the same 
type as the selected atom. 

Draws a bond at an angle of 120° to the existing bond. 

Holding down CTRL and clicking a 
bound atom of the same type as the 
selected atom. 

Draws a bond at an angle of 180° to the existing bond. 

Clicking an atom of a type different 
from that of the selected atom. 

Changes atom type to that of the selected one. 

Clicking a bond. Switches between possible bond types (single / double / triple). 

Dragging Draws a chain.  The atoms in the chain are bound at an angle of 
120° to each other. 
If the Fixed Bond Angle and Bond Length check boxes are 
selected in the Preferences dialog box (Structure tab), you can 
draw bonds of a length multiple to the specified value and at an 
angle multiple to 15°. 
If Snap on Grid from the Options menu is selected, the drawing 
is constrained by the grid. 

Holding down CTRL and dragging Draws a chain.  The atoms in the chain are bound at an angle of 
180° to each other. 
If the Fixed Bond Angle and Bond Length check boxes are 
selected in the Preferences dialog box (Structure tab), you can 
draw bonds of a length multiple to the specified value and at an 
angle multiple to 15°. 
If Snap on Grid from the Options menu is selected, the drawing 
is constrained by the grid. 

Holding down SHIFT and dragging. Draws a chain at a fixed length and fixed angle of 15°. 
If the Fixed Bond Angle and Bond Length check boxes are 
selected in the Preferences dialog box (Structure tab), you will 
draw bonds at any angle and of any length. 
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This Action Does This 
Holding down SHIFT+CTRL and 
dragging 

Draws a chain according to the grid. 
If Snap on Grid from the Options menu is selected, the drawing 
is not constrained by the grid. 

Pressing TAB when dragging Flips the drawn chain. 
Right-clicking an empty space. 

Switches to the Draw Normal tool . 

3.6.8 Up Stereo Bonds Button 

This button  enables the Up Stereo Bonds tool allowing you to draw stereo bonds facing 
towards the viewer in a 3-dimensional representation of the drawn structure.  When this tool is 

active, new chemical bonds can be drawn in the same way as with the Draw Normal  tool 
(for more information, refer to Section 3.6.5).  The differences between these tools are: 

• When a new bond is placed between two atoms or generated from one atom, it is facing 
the viewer. 

• Clicking a bond several times does not change its order (i.e., you cannot draw double and 
triple bonds with this tool).  It changes the direction of the bond. 

To change a normal bond, down stereo bond (a bond that is away from the viewer), or 
coordinating bond to a stereo bond that is facing towards the viewer, activate this tool and click 
the bond. 

You can switch between the Up Stereo Bonds and the Down Stereo Bonds tools by right-
clicking in the workspace. 

3.6.9 Down Stereo Bonds Button 

This button  enables the Down Stereo Bonds tool allowing you to draw stereo bonds that 
are facing away from the viewer in a 3-dimensional representation of the drawn structure.  When 
this tool is active, new chemical bonds can be drawn in the same way as with the Draw Normal 

 tool, but there are some differences between these tools: 
• When a new bond is placed between two atoms or generated from one atom, it is facing 

away from the viewer. 
• Clicking a bond several times does not change its order (i.e., you cannot draw double and 

triple bonds with this tool).  It changes the direction of the bond. 

To change a normal bond, an up stereo bond, or a coordinating bond to a bond that is facing 
away from the viewer, activate this tool, and then click the bond. 

You can switch between the Down Stereo Bonds and the Up Stereo Bonds tools by right-
clicking in the workspace. 
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3.6.10 Coordinating Bonds Buttons 

These buttons enable the set of tools allowing you to draw coordinating (non-covalent) bonds.  
To display all of the possible types, click the right bottom triangle on the button. 

The following types of coordinating bond buttons are available: 

 
With one of the coordinating bonds active, new chemical bonds are drawn in the same way as 

with the Draw Normal  tool, but there are some differences between these tools: 
• When a new bond is placed between two atoms or generated from one atom, it is a 

coordinating bond. 
• Clicking a coordinating bond does not change its order (i.e., you cannot draw double and 

triple bonds with this tool).  It changes the direction of the bond. 

To change a normal bond, an up stereo bond or a down stereo bond to a coordinating bond, 
activate the required Coordinating Bonds tool by clicking the corresponding button, and then 
click the bond. 

Note The number of coordinating bonds drawn on a given atom does not affect its 
valence or charge.  The maximum number of coordinating bonds on an atom is 
defined by its coordinating number, which is set by default to 6 for non-metals and 
to 4, 6, 8, or 10 for metals. 

You can quickly switch to the Draw Normal tool by right-clicking in the workspace. 

3.6.11 Special Bonds Buttons 

These buttons enable the set of tools allowing you to draw various types of bonds.  To display all 
of the possible types, click the right bottom triangle on the button. 

The following types are available: 

 
With one of the special bonds active, new chemical bonds are drawn in the same way as with the 
Draw Normal tool.  The differences between these tools are: 

• When a new bond is placed between two atoms or generated from one atom, it is a special 
bond. 

• Clicking a special bond does not change its order (i.e., you cannot draw double and triple 
bonds with this tool).  
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To change a normal bond, an up stereo bond, or a down stereo bond to a special bond, activate 
the required Special Bonds tool by clicking the corresponding button, and then click the bond. 

You can quickly switch from this tool to the Draw Normal tool by right-clicking in the workspace. 

3.6.12 Solid / Dotted Delocalization Curve Buttons 

This set of buttons  allows you to draw solid or dotted curves indicating the delocalized 
chemical bonds. 

Clicking the right bottom triangle of the button displays the following buttons: 

 Solid Delocalization Curve 

 Dotted Delocalization Curve 

To insert the delocalization curve, draw the structure or select the fragment (or structure) for 
which you want to insert a curve, and then click any of these buttons.  The curve will 
automatically appear. 

Important To apply this option, the selected fragment should contain at least two bonds 
and no branchings.  Otherwise, the corresponding warning message will 
appear. 
Note that query, triple, and quadruple bonds are not allowed in delocalization. 

After you apply this option, the action center is displayed which is not visible while printing.  You 
can place it wherever you need by dragging it. 

It is possible to drag an atom or bond in the selected fragment in the workspace.  Any new bond 
can be drawn from the center by clicking and dragging. 

If necessary, you can change an atom in the selected fragment, the curve is not deleted at that.  
To delete the delocalization curve, select the action center by clicking it and press DELETE.  The 
curve will be also removed if you change the bond type in the structure. 

The charges or radical particles present in the structure will be moved on the action center after 

you click any of these  buttons.  Note that you can also set charge or radical particle on 
the action center manually; on the Atoms toolbar, click the required Charge/Radical Particles 
button (refer to Section 3.7.6), and then click the action center.  

3.6.13 Markush Bond Buttons 

These buttons enable the tools that allow you to attach a Markush bond to a structure or a 
selected structural fragment.  The resulting structure is generic (it represents a group of 
corresponding structures) where the Markush bond denotes the variability in position of a 
substituent within the structure. 

Clicking the right bottom triangle of the button displays the following buttons: 

 Markush Bond 

 Markush Bond with Shadow 

 Added or Removed Fragment 

 Added or Removed Fragment with Shadow 
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To attach a Markush bond, click the required atom on the Atoms toolbar or select the one in the 
Periodic Table (this atom will be at the end of the Markush bond), select the required structure in 
the workspace (if there is more than one structure drawn), and click any of the Markush Bond 
buttons.  If nothing is selected in the structure and you click the button, a warning message will 
appear asking if you wish to attach the Markush bond to the whole structure. 

To visibly display the atoms a Markush bond refers to, use the Markush Bond with Shadow 
tool. 

To draw the structures with the attached mass or formula difference values, instead of the added 

or removed structural fragments themselves, click Added or Removed Fragment  or Added 

or Removed Fragment with Shadow .  The Define Markush Mass Difference dialog box 
appears. 

 
This dialog box contains the following options: 

Option Function 
Additional / 
Subtraction 

In this area, select whether the difference value will be marked as added (Additional) or 
removed (Subtraction). 

Mass Select this option to attach the mass difference value as a Markush label. 
For example, to describe a transformation of N,N-dimethyl-4-nitrosoaniline that resulted in 
a product with the formula weight less by 14 units than initial, select the Subtraction and 
Mass options, and then, in the adjacent box, type 14. The following created structure 
represents the oxygen atom removal from the nitroso group or monodemethylation: 

 
Both structures have formula weight 14 units less than initial N,N-dimethyl-4-
nitrosoaniline. 
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Option Function 
Fragment Allows you to attach the formula difference as a Markush label; select this option, and 

then, in the adjacent box, type a needed formula difference. 
For example, the following Markush structure with the added oxygen fragment describes 
at least three hydroxylation products and amine oxide at the same time: 

 
Note If you wish to perform a substructure search for structures with a Markush bond, 

you should pay more attention to choosing atoms which you want to participate in 
Markush binding. 

3.6.14 Reaction Plus Button 

This button  enables the Reaction Plus tool allowing you to draw a reaction plus in the 
Structure mode. 

Select this tool, move the cursor to the place where you want a plus to be inserted and click once.  
Clicking the plus for the second time will delete it. 

Note You can change the color and style of reaction pluses in the Preferences dialog 
box (Reaction tab).  For more information on this dialog box, refer to Section 
3.14.1.3. 
 
To be able to move and rotate reaction pluses in the Structure mode, make sure 
that the Select Graphics check box is selected in the Preferences dialog box 
(Structure tab). 
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3.6.15 Reaction Arrow Buttons 

These buttons enable the set of tools allowing you to draw various reaction arrows in the 
Structure mode.  Click the bottom right triangle of the button to expand it into more Reaction 
Arrow buttons: 

 
To insert an arrow, choose the required Arrow tool and click in the workspace to place an arrow 
of a standard length or drag to draw an arrow of desired length.  Clicking the arrow for the second 
time will delete it. 

Note You can change the color and style of reaction arrows in the Preferences dialog 
box (Reaction tab).  For more information on this dialog box, refer to Section 
3.14.1.3. 
 
To be able to move and rotate reaction arrows, make sure that the Select 
Graphics check box is selected in the Preferences dialog box (Structure tab). 

You can switch between the available reaction arrow tools by right-clicking in the workspace. 

3.6.16 Reaction Arrow Labeling Button 

This button  enables the tool allowing you to insert labels that specify the appropriate reaction 
conditions. 

To insert reaction conditions, with this tool enabled, click the reaction arrow.  In the Edit 
Reaction Conditions dialog box that appears, type your own comment or click several buttons 
from the conditions set on the right side of the dialog box.  Click OK. 
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This dialog box contains the following options: 

Option Function 

 
Cuts the selected text and places it to the Clipboard. 

 
Copies the selection to the Clipboard. 

 
Inserts the contents of the Clipboard at the insertion point or, if a string is selected, 
replaces it. 

 
In this box, you can specify the appropriate font style. 

 
In this box, you can specify the size of the font. 

 
Formats the selected text with bold.  Click this button again to cancel formatting with 
bold. 

 
Formats the selected text with italic.  Click this button again to cancel formatting with 
italic. 

 
Underlines the selected text.  Click it again to cancel underlining. 

 
Formats the selected text with superscript. 
The superscript button is automatically enabled when you type a formula in any of 
the panes.  For example, atom charge is automatically turned into superscript. 

 
Formats the selected text with subscript. 
The subscript button is automatically enabled when you type a formula in any of the 
panes.  For example, the atom number index is turned into subscript. 

 
Aligns the text left. 

 
Centers the text. 

 
Aligns the text right. 

Upper Pane In this pane, you can specify the conditions for the reaction; the conditions will be 
placed above the reaction arrow. 

Lower Pane Click in the lower pane and then type or select conditions specific for the reaction to 
place them below the reaction arrow. 

 
Inserts the hν symbol (lighting) at the insertion point or, if a string is selected, 
replaces it. 

 
Inserts the Δ symbol (heat applied) at the insertion point or, if a string is selected, 
replaces it. 

 
Inserts the °t symbol at the insertion point or, if a string is selected, replaces it. 

 
Inserts the °C symbol at the insertion point or, if a string is selected, replaces it. 

 
Inserts acid as your reaction condition at the insertion point or, if a string is 
selected, replaces it. 

 
Inserts base as your reaction condition at the insertion point or, if a string is 
selected, replaces it. 

Note If you export the Reaction Conditions set through the Reaction Arrow Labeling 
tool into an .RXN file, the previously specified conditions will be lost. 
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3.6.17 Reaction Calculator Button 

This button  enables the tool allowing you to automatically calculate synthesis data for each 
reaction components. 

To calculate data, with this tool enabled, click the reaction arrow; the Reaction Calculator dialog 
box appears.  It contains the Components table with the following columns: molecular formula 
and formula weight (these columns are filled in automatically), stoichiometric coefficient (K), 
quantity (n), concentration (C), mass (m), volume (V), density (d), as well as yield of products 
(Yield). 

Note To provide the automatic calculation of the reaction data, the data is divided into 
two types—independent and relative.  You can edit the independent data only.  
The relative data is automatically calculated on the basis of the editable data 
and cannot be edited. 

 
To edit the reaction data, double-click the corresponding cell directly within the Components 
table, and then type the data value.  After you press ENTER, all of the relative data is 
automatically calculated.  (To provide the calculation of mass and quantity, you need to type the 
density value.) 

Note that the Yield is always relative and its calculation is based on the component with the 
lowest amount.  To calculate yield, double-click the cell corresponding to the product under m 
(mass) and type the proper value, then press ENTER.  You will see that the yield is calculated 
and the “Based on” notation appears under Yield in the row corresponding to the reactant with 
the lowest amount. 

To display the summarized quantity of the reactants, select the Show Total check box under the 
Components table. 

Clicking OK closes the Reaction Calculator dialog box and pastes the filled in Components 
table in the ChemSketch page. 
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3.6.18 Atom-Atom Map Button 

This button  enables the Mapping tool allowing you to map a drawn reaction either manually 
or automatically.  As you click the button, the Map Tools panel appears and the mapping mode is 
enabled. 

The Map Tools panel contains the following buttons: 

Button Function 
Manual Mapping 

 

Enables the Manual Mapping mode (note that this mode is set by default).  Now, 
you can assign atoms of the reactant to the corresponding atoms of the product 
manually by pointing to a chosen atom and dragging to its counterpart. 

Select Reaction 

 

Works just like the Select/Move tool (for more information on this tool, refer to 
Section 3.6.1) except for not allowing you to move objects. 

Auto Mapping 

 

Maps your reaction automatically.  Note that you can use this tool to map one 
reaction at a time only.  If there is more than one reaction in the workspace, you 
need to select one of them using the Select Reaction tool. 

Delete Mapping 

 

Cancels the mapping of all the reactions on the current page.  To cancel the 
mapping of a certain reaction, first select it using the Select Reaction tool, and 
then click this button. 

It is possible to perform both automatic and manual mapping on the same reaction. 

To distinguish between automatically generated and manually inserted numbers, select different 
colors for automatic and manual mapping.  To define the color for manually inserted map 
numbers, in the Manual Mapping Color box of the Preferences dialog box (Reaction tab), set 
the appropriate color.  For automatic mapping, in the Auto/Manual Numbering Color box of the 
Preferences dialog box (Structure tab), set the appropriate color. 

Whenever you close the Map Tools panel, you quit the mapping mode and atom numbers are no 
longer visible. 

Tip You can export the mapped reactions to ACD/ChemFolder (as a REACCS.RXN file) 
or to ISIS/Draw (as an ISIS/Sketch .SKC files). 

3.6.19 Polymers Button 

This button  enables the Polymers tool allowing you to turn a structure or fragment into a 
polymer.  Clicking this button displays the Polymer panel where you can specify the required 
options. 
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This panel contains the following options: 

Option Description 
Index In this box, specify the index for your polymer (any number or letter).  As you click Apply, it 

will appear at the lower right corner of the right bracket. 

Connectivity In this box, select the way the units are connected in your polymer: head-to-tail, head-to-
head, or either/unknown.  The default setting is head-to-tail so the upper right corner of 
the right bracket is empty, while head-to-head, or either/unknown types produce 'hh' and 
'eu' respectively. 

Style Select the way your polymer will look: in brackets [ ], in parenthesis ( ), or in braces { }. 

Apply Applies the defined parameters to the selected polymer. 

To draw a polymer, follow the steps: 

1. Draw one or more structures you want to turn into a polymer. 

2. On the Structure toolbar, click Polymers  and, on the Polymer panel that appears, specify 
the required settings. 

3. Select the area you want to turn into a polymer either by clicking or by dragging.  Note that 
you can turn the entire structure or part of two structures into one polymer only by dragging. 

As soon as the area is selected, the polymer appears in the workspace. 

Tip When drawing polymers, for your convenience only, hold down CTRL when 

clicking/dragging with the Draw Normal , Draw Continuous , or Draw 

Chains  tools.  Each of these combinations allows you to draw a bond at an angle 
of 180° to the existing bond rather than 120° (created when CTRL is not pressed); 
thus creating more customary-looking structures.  For more information on how to use 
these combinations, refer to Sections 3.6.5, 3.6.6, and 3.6.7. 
 
To create end-open structures, replace the end atoms in a drawn polymer with empty 
atoms using the Pseudo Atom tool (refer to Section 3.7.5). 

3.6.20 Change Position Button 

This button  enables the Change Position tool allowing you to change the arrangement of a 
double bond or the display position of a hydrogen atom, to control the bonds intersection point, 
and to specify the connection point of an atom label. 

You can do the following with this tool: 
• Each additional click on a double bond with this tool active switches between the three 

double bond types shown below: 

   
Symmetric Asymmetric 1 Asymmetric 2 
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• Each additional click on an atom with this tool active switches between various position of 
the hydrogen.  Hydrogen(s) can be displayed around the base symbol in four positions: 

NH2  N
H2  

N
H2

 NH2  

Left Bottom Top Right 
• When the bonds are intersecting, one of them is displayed as a background bond and 

another as a foreground bond.  To bring the background bond to the front, hold down 
SHIFT and click it with the Change Position tool active. 

• Atom labels inserted with the Edit Atom Label tool (for more information, refer to Section 
3.7.4) can be connected to the bond by any symbol on the label.  To change the 
connection symbol on the label, hold down SHIFT and click repeatedly the atom label with 
the Change Position tool active.  The label will shift and, as the needed atom becomes a 
connection point, stop clicking.  If you click the label without holding down SHIFT, the 
program will connect the bond to either the first or last symbol on the label. 

3.6.21 Set Bond Horizontally Button 

This button*  enables the Set Bond Horizontally tool allowing you to rotate a chemical 
structure so that the desired bond becomes horizontal. 

To place the required bond horizontally, make this tool active and then click this bond.  As the 
selected bond becomes horizontal, the whole structure is rotated accordingly.  Each additional 
click on the same bond rotates the structure by 180°. 

3.6.22 Set Bond Vertically Button 

This button*  enables the Set Bond Vertically tool allowing you to rotate a chemical structure 
so that the desired bond is displayed vertically. 

To place the required bond horizontally, make this tool active and then click this bond.  As the 
selected bond becomes vertical, the entire structure is rotated accordingly.  Each additional click 
on the same bond rotates the structure by 180°. 

3.6.23 Flip on Bond Button 

This button*  enables the Flip on Bond tool allowing you to rotate a chemical structure or 
selected fragment on the axis of a chosen bond. 

To flip a structure on one of its bonds, make this tool active and then click the required bond.  
You can also flip a structure on the selected fragment. 

Note Applying this tool to the 3D-optimized structures may cause distortion of structures.  

Thus, it is recommended to use the 3D Rotation  tool instead. 

                                                      
* Before using this command, verify whether the whole chemical structure is selected or only a part of it.  When only parts 
of a structure have been selected, this command may, by changing the angles between bonds, cause unwanted changes 

in the chemical structure.  If this happens, click Undo . 
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3.6.24 Flip Top to Bottom Button 

This button*  enables the Flip Top to Bottom tool allowing you to turn chemical structure(s) 
about the horizontal axis. 

Select the structure you want to rotate and click this button.  If no structure or fragments are 
selected on the current page, clicking this button flips all of the drawn structures as a single 
object.  Flipping structures having optical center produces enantiomers. 

Note If the Select Graphics check box is selected in the Preferences dialog box 
(Structure tab), you can apply this tool to objects created in the Draw mode, as 
well as to reaction pluses and arrows. 

3.6.25 Flip Left to Right Button 

This button*  enables the Flip Left to Right tool allowing you to turn chemical structure(s) 
about the vertical axis. 

Select the structure you want to rotate and click this button.  If no structure or fragments are 
selected on the current page, clicking this button flips all of the drawn structures as a single 
object.  Note that flipping structures having optical center produces enantiomers. 

Note If the Select Graphics check box is selected in the Preferences dialog box 
(Structure tab), you can apply this tool to objects created in the Draw mode, as 
well as to reaction pluses and arrows. 

3.6.26 Instant Template Button 

This button  enables the Instant Template tool allowing you to create a current pattern from 
any structure or selected fragment so that you can insert it anywhere in the workspace or attach it 
to a structure. 

To create an instant template, follow the steps: 

1. Select a structural element which you want to reproduce.  Note that to create a template of an 
entire structure, you don’t need to select it. 

2. Click Instant Template . 
3. Point to the structure or selected structural element and click.  The shadow of the selected 

structure or element becomes attached to the cursor. 

Note If you are going to use the template for attaching it to the already drawn structure, 
make sure that you click the most suitable atom or bond when creating a template.  
For example, if you are going to insert a structure fused with a specific bond, select 
the corresponding template by clicking the bond (not the atom). 
 
You can flip the template shadow by pressing TAB. 

                                                      
* Before using this command, verify whether the whole chemical structure is selected or only a part of it.  When only parts 
of a structure have been selected, this command may, by changing the angles between bonds, cause unwanted changes 

in the chemical structure.  If this happens, click Undo . 
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4. Move it to the desired location in the workspace and click to paste. 

Note When inserting the template taken by an atom, if you click the atom of the drawn 
structure while holding down SHIFT, the atom of the template will replace the atom 
you click (the template will be attached without a bond). 

You can use the template as many times as you want until you choose any other button from the 
toolbar or right-click in the workspace.  If you need this template again, you should create it 
again. 

3.6.27 Calculate Parameters of Substituent Button 

This button  can be used to calculate electronic substituent constants—σ of different types 
(e.g., inductive, resonance, meta-, para-, etc.) for your substituents.  It also calculates some steric 
constants (MV and MR, i.e., the molar volume and molar refractivity) and a hydrophobic constant 
(the π constant of Hansch) for a fragment of your compound.  This option is useful for correlation 
of different properties which depend on characteristics of substituents attached to a constant 
reaction center. 

This module must be purchased in addition to ACD/ChemSketch.  For more details on sigma 
calculation, refer to ACD/Sigma Pro User’s Guide located in the ACD/Labs documentation folder 
(\\DOCS\SIGMA.PDF). 

3.7 Atoms Toolbar 

The Atoms toolbar is displayed vertically to the left of the workspace.  This toolbar includes 
buttons that can be used to quickly insert atoms of the corresponding elements into the drawing 
area and to change the atom properties. 

The table below lists the tools available on the toolbar and the short description of each tool: 

Button Function 

 
Displays the Periodic Table of Elements (see Section 3.13.5). 

 /  
Enables the Query Atom / Query Bond tools that allow you to specify search queries 
for performing a substructure search (see Sections 3.7.1–3.7.2). 

 

Use these buttons to draw the corresponding atoms in the workspace (see Section 
3.7.3). 

 
Enables the Edit Atom Label tool that allows you to insert and change atom labels 
(see Section 3.7.4). 

 /  
This tool allows you to insert pseudo atoms or radical designation labels (see Section 
3.7.5). 

 
Enables the Charge/Radical Particles tool that allows you to change the atom’s 
charge and to draw radical particles (see Section 3.7.6). 

 
This tool allows you to change the chemical properties of an atom (see Section 3.7.7). 

 
Enables the Manual Numbering tool that allows you to number atoms on the drawn 
structure(s) manually (see Section 3.7.8). 

Note To customize the toolbar contents, right-click it to display the context menu (for 
more information, refer to Section 2.2.1). 



2BStructure Mode 

ACD/ChemSketch  Reference Manual 38 

3.7.1 Query Atom Buttons 

These buttons enable the set of tools allowing you to specify the query atoms when performing a 
substructure search.  Click the bottom right triangle of the button to expand it into more buttons: 

Button Description 

 Any Atom 
The marked atom may be any atom but hydrogen. 

 Any Heteroatom 
The marked atom may be any atom except carbon or hydrogen. 

 Any Atom without Hydrogen 
No hydrogens can be attached to this atom. 

 Atom from List 
Creates a list of atoms to be allowed. 

 Atom Not in List 
Creates a list of atoms to be excluded. 

To specify query atoms for a substructure search, click the required button from a set of tools, 
and then click the atom of the structure which you want to be replaced with the query atom. 

Note When you mark query atoms in a structure, you can use the structure only as a 
search query.  You cannot store this structure in a database except for the 
ACD/SpecDB database, version 6.0 or later. 

For more information on how to perform substructure search, refer to online Help of the 
corresponding program. 

3.7.2 Query Bond Buttons 

These buttons enable the set of tools allowing you to specify the query bonds when performing a 
substructure search.  Click the bottom right triangle of the button to expand it into more buttons: 

Button Description 

 Any Bond 
The marked bond can be any type of bond (single, double, triple, or 
aromatic).  

 Aromatic Bond 
The marked bond can only be aromatic. 

 Single or Double Bond 
The marked bond can only be single or double bonds (but not aromatic 
or triple). 

 Ring Bond 
The marked bond must be part of a ring (cancels chain). 

 Chain Bond 
The marked bond must be part of a chain (cancels ring). 

To specify query bonds for a substructure search, click the required button from a set of tools, 
and then click the bond in the structure which you want to be replaced with the query one. 

Note When you mark query bonds in a structure you can only use the structure as a 
search query.  You cannot store such a structure in a database except for 
ACD/SpecDB database, version 6.0 or later. 

For more information on how to perform substructure search, refer to online Help of the 
corresponding program. 
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3.7.3 Atom Buttons 

These buttons can be used to quickly insert atoms of required elements into the workspace 
without opening the Periodic Table of Elements dialog box (for more information, refer to 
Section 3.13.5).  Click the required atom button on the Atoms toolbar to choose it. 

You can do one of the following with the chosen atom: 
• Click in the empty space to insert the chosen atom. 

• With the Draw Normal  tool active, click any atom in the drawing area to replace it with 
the chosen atom. 

• With the Draw Continuous  tool active, click an atom twice to sprout a new single 
bond with the chosen atom. 

• With the Draw Chains  tool active, draw atom chains with the chosen atom as the 
binding point. 

For more information on these tools, refer to Sections 3.6.5–3.6.7 correspondingly. 

If the required element is not listed on the Atoms toolbar, click  to display the Periodic Table 
of Elements dialog box where you can choose the required element (note that the selected 
element will be placed on the Atoms toolbar as a new button). 

To remove user-selected atoms from the Atoms toolbar, double-click the toolbar. 

For non-metals, the inserted atom appears in its lowest valence as a hydride derivative, whereas 
for metals, the inserted atom appears in its lowest oxidation state as an ion.  You can change the 

atomic charge and/or oxidation state of an atom by using the Increment(+) Charge  or 

Decrement (–) Charge  buttons (for more information, refer to Section 3.7.6) or by drawing 
new chemical bonds from this atom.  You can also change the atomic charge, valence, oxidation 

state, coordination number, and isotope number by clicking Atom Chemical Properties  (for 
more information, refer to Section 3.7.7). 
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3.7.4 Edit Atom Label Button 

This button  enables the Edit Atom Label tool allowing you to insert a label in an empty 
space or to replace any atom in a structure with a group abbreviation or a label which then can 
be expanded.  To insert a label, click the Edit Atom Label tool and then click the needed atom or 
empty space.  In the Edit Label dialog box that appears, specify the label to be inserted, and 

then click Insert.  To switch this tool off, right-click in the workspace; the Draw Normal tool  
will be enabled. 

Note You can then change the connection point of the label by using the Change 
Position tool (for more information, refer to Section 3.6.20). 

 
This dialog box contains the following options: 

Option Description 

Format area The tools in this area allow you to format an input label. 
Label box In this box, type the label you want to insert or choose the corresponding one from the list 

below.  Note that the three last used labels are saved in the list and are displayed with 
red at the top (they cannot be deleted).  To save your label or delete the existing ones, 
use the buttons to the right.  To show only standard or user labels, use the options in the 
List area. 

List In this area, select the required option to specify the type of labels to be displayed: all of 
the available labels (All), just the standard built-in labels provided by the program 
(Standard), or custom labels you have previously created (User). 

 
Saves the label specified in the Label box.  This label will be added to the list of User 
labels.  The User labels are displayed in dark blue.  Three labels that have been recently 
entered are saved to the list automatically.  They are displayed in red and cannot be 
deleted. 

 
Removes the selected label from the list.  Note that if you try to remove standard built-in 
labels, the warning message appears.  Three labels that have been recently entered are 
saved to the list automatically.  They are displayed in red and cannot be deleted. 
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Option Description 

 
Replaces the selected atom with the specified label or inserts the label in the empty 
workspace of the ChemSketch page. 

 
Expands the specified label (represents it as a structure).  The atom label can be 
expanded only if it was entered in capitals.  Also, only group abbreviations which replace 
the terminal atoms in a structure can be expanded. 
The following symbols are accepted by this tool: 
'~' (tilde)—negative charge 
'+' (plus)—positive charge 
'–' (minus)—single bond (can be omitted) 
'=' (equal sign)—double-bond 
'%' (percent)—triple bond 
'( )' (brackets)—enclose a group of atoms 
You can find the conventions for label expanding in the EXPAND.TXT file located in the 
ACD/Labs installation folder (ACD10 for version 10.0).  The left column in this file 
contains notations supported by the Expand tool.  It is not recommended to modify this 
file. 
If ACD/ChemSketch cannot expand the current abbreviation, the corresponding message 
appears.  You can also expand the inserted labels using the Expand Shorthand 
Formulae command (for more information, refer to Section 3.12.9). 

3.7.5 Pseudo Atom and Radical Label Buttons 

These buttons  /  enable the set of tools allowing you to replace atoms with radical labels 
or pseudo atoms.  If you click the bottom right triangle of the button, it will be expanded into more 
buttons: 

 
Click the required button to make active the corresponding tool, and then click the atom to 
replace it with the label or pseudo atom. 

Tip To insert pseudo atoms, you can also double-click a highlighted atom to display the 
corresponding Properties panel; in the Value box of the Atom tab, select 'Empty', 
and then click Apply. 

Use the Pseudo Atom  tool to create open-ended polymers and bent bonds.  Bent bonds are 
ignored in calculations (treated as standard bonds). 

3.7.6 Charge/Radical Particles Buttons 

These buttons enable the set of tools allowing you to change atom's charge or to make radicals 
from the existing atoms.  Click the bottom right triangle of the button to expand it into more 
buttons: 

 
To apply any of these tools, click the required button and then the atom you want to modify. 
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3.7.6.1 Increment (+) Charge and Decrement (–) Charge Buttons 

These buttons  /  enable tools allowing you to change the charge of a chosen non-metal 
atom or both the charge and oxidation state of a chosen metal.  To apply the required charge, 
click the button and then click the desired atom in the workspace.  The atomic charge and/or 
oxidation state increases in increments or decreases in decrements according to the valid 
oxidation states for metals or the valid valences for non-metals. 

Note These two options only allow you to change the charge and/or oxidation state of an 
atom within certain limits.  For non-metals, the charge can be changed from –4 to 
+4 in general, whereas for metals the charge can only be changed according to the 
allowed oxidation states given in the Periodic Table of Elements.  To set any other 
charges and/or oxidation states, use the Properties panel or Atom Chemical 
Properties   button. 

You can switch between the Increment (+) Charge  and Decrement (–) Charge  tools 
by right-clicking in the workspace. 

3.7.6.2 Radical Particles Buttons 

The Radical button  enables the tool allowing you to create radicals.  The subsequent 
clicking the atom with this tool active changes the atom to: 

• Monoradical, for example  

• Singlet biradical, for example  

• Triplet biradical, for example CH2  

The Positive Radical Ion button  enables the tool allowing you to create positive radical ions, 

for example CH4
+

.  To do this, click any atom with this tool active. 

The Negative Radical Ion button  enables the tool allowing you to create negative radical 
ions, for example .  To do this, click any atom with this tool active. 

Note Right-clicking in the workspace with any of the aforementioned tools active 
switches between them. 
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3.7.7 Atom Chemical Properties Button 

This button  enables the Atom Chemical Properties tool allowing you to set new properties 
for a drawn atom.  To edit the properties of the required atom, click the atom with this tool active.  
In the Atomic Properties dialog box that appears, specify the required settings. 

 
This dialog box contains the following options: 

Option Description 
Valence In this box, specify the valence value.  It should be a number from 0 to 8. 

Charge In this box, specify the charge value.  Note that you can also define radical particles. 

Isotope In this box, specify the isotopic mass value. 

Numbering In this box, specify a numerical or textual string to be used as a numbering for the 
selected atom. 

Keep non-typical 
visibilities 

This check box is available in case you have manually set some of the visible 
characteristics (e.g., presence of valence or isotope) through the Properties panel 
(refer to Section 3.12.1).  To keep the previously set visible characteristics, select this 
check box. 

 
Saves the properties you have specified in this box and adds them as a new Atom 
Chemical Properties button to the Atoms toolbar.  Now as you click the desired atom 
on the workspace with the created button active, the atom’s properties will be 
changed accordingly. 
Note that you can add as many ‘’properties’’ buttons as you want.  To remove all of 
the custom buttons from the Atom toolbar, double-click the toolbar.  In the message 
that appears, click Yes. 

Note To change the style (font size, color, etc.) of atom properties labels, use the 
Properties panel (refer to Section 3.12.1). 
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3.7.8 Manual Numbering Button 

Clicking this button  displays the Manual Numbering dialog box where you can number 
atoms in the workspace manually. 

 
This dialog box contains the following options: 

Option Description 
Text Before In this box, type the text to be inserted before each inserted number. 

Number From the list of available number styles, choose the required one. 

Text After In this box, type the text to be inserted after each inserted number. 

Start At In this box, specify the value from which the numbering should be started. 

OK Closes the dialog box and enables the Manual Numbering tool. 

Cancel Closes the dialog box and disables the Manual Numbering tool. 

Tip You can also display this dialog box by right-clicking in the workspace with the 
Manual Numbering tool active. 

To set atom numbering, follow the steps: 

1. On the Atoms toolbar, click Manual Numbering .  This will display the Manual 
Numbering dialog box. 

2. Specify the type of numbering, if required, enter the text before and after a number and 
specify the starting number. 

3. Click OK.  Note that cursor becomes .  Then click the desired atom on the workspace.  It 
will be assigned the specified starting number.  Subsequent clicking of other atoms in the 
workspace will continue numbering. 

4. To stop numbering and disable the Manual Numbering tool, click any other button. 

To edit atom numbering, click the required atom with this tool active and specify new settings in 
the dialog box. 

Note You can specify the color of atom numbers in the Auto/Manual Numbering box of 
the Preferences dialog box (Structure tab).  For more information on this dialog 
box, refer to Section 3.14.1.2. 
You can change the style (font size, color, etc.) of the atom number labels on the 
Properties panel.  For more information on this panel, refer to Section 3.12.1. 
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3.8 References Toolbar 

The References toolbar is displayed vertically to the right of the workspace.  This toolbar contains 
buttons for quick and accurate creating of structures with the help of templates. 

This toolbar contains the following buttons: 

Button Function 

—Commercial 
version only! 

Displays ACD/Dictionary.  For more information, refer to Section 3.13.6. 

  
Displays the Table of Radicals containing the most frequently needed 
radicals for a quick structure drawing.  For more information, refer to Section 
3.13.4. 

Shortcut buttons for 
radicals 

These shortcut buttons appear when you select a radical from the Table of 
Radicals at least once and can be removed from the toolbar by double-
clicking it. 

Note To customize the toolbar contents, right-click it to display the shortcut menu.  For 
more information, refer to Section 2.2.1. 

3.9 File Menu 

This menu contains commands allowing you to load and save files, import and export files to 
other formats, print your work, and set printer and page formats.  On the File menu, you can see 
the history of last loaded files. Click the file you want to load again. 

3.9.1 New 

This command creates a new empty document which immediately becomes active. 

You do not need to execute the New command after starting ACD/ChemSketch.  The program 
starts with a blank document, named NONAME00.SK2, active in the workspace.  Subsequent 
new documents are named NONAME01.SK2, NONAME02.SK2, etc., until you save them with a 
new filename. 

If you have several open documents, you can have only one document visible at a time—you 
cannot tile or cascade multiple document windows.  All the other open files remain open but are 
no longer active.  To make any document active, select it from the list on the Documents menu. 

Note ACD/ChemSketch allows you to have up to ten documents open at once.  If you 
have ten documents open, the New command will become inactive until one is 
closed. 

Shortcut: 

General toolbar:  
Keyboard:  CTRL+N 
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3.9.2 Open 

This command allows you to display the Open Document dialog box where you can specify the 
name and location of file that you want to load.   

The following formats are supported: 
• ChemSketch 2.0 Document (.SK2) 
• All supported Chemical Files (.MOL, .SKC, .RXN, .CHM, .CDX, .MST, .RPT) 
• MDL molfiles (.MOL) 
• ISIS/Sketch (.SKC)1 
• MDL RXNfiles (.RXN) 
• ChemSketch 1.0 (.MST, .RPT) 
• CS ChemDraw (.CHM, .CDX)2 
• Windows Metafiles (.WMF)3 

As soon as you open the document, its name is displayed in the left corner of the status bar. 

Note ACD/ChemSketch allows you to have up to ten documents open at once.  If you 
have ten documents open, the Open command becomes inactive until at least one 
document is closed. 

Shortcuts: 

Keyboard:  CTRL+O 

General toolbar:  

3.9.3 Close 

This command closes the active document.  If you made changes since the last time you opened 
or saved this document, you are prompted to confirm whether to save changes or not.  If this is 
the last open document, ChemSketch automatically creates a “noname” one.  As you close a 
document, ChemSketch prompts you to save your work if you've not already done so. 

Tip To close all of the open documents, from the Documents menu, choose Close All. 

Shortcut: 

Keyboard:  CTRL+W 

General toolbar  

3.9.4 Save 

This command allows you to save the active document as an .SK2 file.  If you are saving your 
work for the first time, the Save Document As dialog box appears prompting you to specify the 

                                                      
1 You can import objects from the ISIS/Sketch BIN files of any version, but for the files of the 
versions later than 2.0 some new features may be missing. 
2 You can import objects from the CS ChemDraw files of any versions later than 3.0. 
3 While importing Windows Metafiles, note that the bitmaps from the imported file will not be 
placed into ACD/ChemSketch. 
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file name and location.  If your work has been saved before, the existing file parameters are used 
(the name and location of the file are displayed on the title bar). 

Tip If you want to change the name or location of an existing file, from the File menu, 
choose Save As.  To save all of the open documents at once, from the File menu, 
choose Save All. 

Shortcuts: 

Keyboard:  CTRL+S 
General toolbar  

3.9.5 Save As 

This command allows you to display the Save Document As dialog box where you can specify a 
new name, location, and format for the currently open ChemSketch document.   

The following formats are supported: 

 ChemSketch 2.0 Document (SK2) 

 MDL Molfiles (.MOL) 

 ISIS/Sketch (.SKC) 

 MDL RXNfiles (.RXN) 

 CS ChemDraw (.CHM, .CDX) 

 MDL Extended Molfiles (.MOL) 

 CML files (.CML) 

 Adobe Acrobat (.PDF) - you can also use the Export to PDF  button on the General 
toolbar. 

 Windows Metafiles (.WMF) 

 Windows Bitmaps (.BMP, .DIB) 

 Paintbrush (.PCX) 

 TIFF Bitmaps (TIF) 

 GIF Bitmaps (.GIF) 

 Portable Network Graphics (.PNG) 
If you are saving data to TIFF Bitmap or Portable Network Graphics format, you can define some 
options in the TIFF Export Options and Potable Network Graphics Export Options dialog 

boxes (refer to Section 3.9.5.1), which can be displayed by clicking Options . 

Tip If you want to save a file with the same name and to where it currently resides, from 
the File menu, choose Save.  To save all of the open documents at once, from the 
File menu, choose Save All. 

Shortcut: 

Keyboard: CTRL+SHIFT+ S 
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3.9.5.1 TIFF Export Options / Portable Network Graphics Export Options 
Dialog Box 

This dialog box allows you to set the required image resolution for the active file you are working 
with. 

This dialog box appears when you choose TIFF Bitmap (.TIF) / Portable Network Graphics 
(*PNG) in the Set as type drop-down list and click Options  in the Save Document 
As/Export dialog box. 

3.9.6 Save All 

This command saves all of the open documents (up to ten may be open at once) as .SK2 files.  
When you are saving your work for the first time, the Save Document As dialog box prompts you 
to specify the name and location for each open file.  If any of the documents have been saved 
before, the existing names and locations are used. 

Tip If you want to change the name or location of an existing file, from the File menu, 
choose Save As.  To save only the current document, from the File menu, choose 
Save. 

Shortcut: 

Keyboard: SHIFT+ F12 

3.9.7 Export 

This command allows you to export the contents of the active document into one of the supported 
external formats.  This command displays the Export dialog box where you can specify the 
format, name, and location of a file to be exported. 

The following formats are supported: 

 MDL Molfiles (.MOL) 

 ISIS/Sketch (.SKC) 

 MDL RXNfiles (.RXN) 

 CS ChemDraw (.CHM, .CDX) 

 MDL Extended Molfiles (.MOL) 

 CML files (.CML) 

 Adobe Acrobat (.PDF) - you can also use the Export to PDF  button on the General 
toolbar. 

 Windows Metafiles (.WMF) 

 Windows Bitmaps (.BMP, .DIB) 

 Paintbrush (*.PCX) 

 TIFF Bitmaps (*TIF) 

 GIF Bitmaps (*GIF) 

 Portable Network Graphics (*PNG) 



2BStructure Mode 

ACD/ChemSketch  Reference Manual 49 

If you are exporting data to TIFF Bitmap or Portable Network Graphics format, you can define 
some options in the TIFF Export Options and Potable Network Graphics Export Options 
dialog boxes (refer to Section 3.9.5.1), which can be displayed by clicking Options . 

3.9.8 Import 

This command allows you to import objects from one of the supported external formats.  It 
displays the Import dialog box where you can specify the name and location of a file you want to 
import. 

The following formats are supported: 
• All supported Chemical Files (.MOL, .SKC, .RXN, .CHM, .CDX, .MST, .RPT) 
• MDL molfiles (.MOL) 
• ISIS/Sketch (.SKC)4 
• MDL RXNfiles (.RXN) 
• ChemSketch 1.0 (.MST, .RPT) 
• CS ChemDraw (.CHM, .CDX)5 
• Windows Metafiles (.WMF)6 

The imported structures retain their original design and chemical significance.  You can change 
and manipulate the imported structures, save them to a new file, print, insert them into other 
Windows applications, and calculate their chemical properties. 

Some of the imported structures may have the size that the system can consider non-feasible.  If 
this is the case, the Import Warning dialog box appears.  To rescale the structure, click Yes. 

3.9.9 Run ChemBasic 

This command allows you to display the Run Program dialog box where you can specify the 
name and location of a program (.BAS) written in ACD/ChemBasic language.  As you click OK, 
the program will be run.  You can create such programs yourself or use the ones available for 
free as goodies (for more information, refer to Appendix C) from our Web site. 

ACD/ChemBasic programs may have shortcut buttons which can be placed on a toolbar with the 
help of the ChemBasic Organizer command (Options menu).  For more information, refer to 
Section 3.14.8. 

3.9.10 Forms Manager 

This command displays the Forms Manager dialog box where you can design input forms for 
ACD/ChemBasic programs. 

For more details on ACD/ChemBasic and ACD/Forms Manager, refer to the corresponding 
documentation. 

                                                      
4 You can import objects from the ISIS/Sketch BIN files of any version, but for the files of the 
versions later than 2.0 some new features may be missing. 
5 You can import objects from the CS ChemDraw files of any versions later than 3.0. 
6 While importing Windows Metafiles, note that the bitmaps from the imported file will not be 
placed into ACD/ChemSketch. 
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3.9.11 Page Setup 

This command allows you to display the Page Setup dialog box where you can specify page 
settings either for the whole document or for the current page. 

It contains the following options: 

Option Description 

Size&Orient On this tab, you can specify the paper format and orientation of the drawing: either 
landscape or portrait (for more information, refer to Section 3.9.11.1). 

Margins On this tab, you can set margins for the page to be printed (for more information, 
refer to Section 3.9.11.2). 

Poster  On this tab, you can set the number of pages your poster will consist of (if you are 
going to print a poster).  For more information, refer to Section 3.9.11.3. 

Apply To In this box, you can choose whether to apply the settings specified in the dialog box 
to the whole document (Whole Document) or to the current page of the current 
document only (Current Page).  If there is the only page in the document, this 
option is not available. 

Preview Field Shows the results of the specified settings. 

 
Saves the currently specified paper size, orientation, and margins as default. 

 
Changes the current settings to the last accepted default settings.  If no defaults 
have been recently set, this button has no effect. 

3.9.11.1 Page Setup Dialog Box: Size & Orientation Tab 

On this tab, you can specify the paper format and orientation of the page(s), either landscape or 
portrait. 
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This tab contains the following options: 

Option Description 

Format In this box, specify the paper size available for your printer.  As you choose the 
paper format, the Width and Height boxes display the corresponding values.  
If you choose Custom Size, you can specify your own format. 

Width This box displays the width* of the currently set paper format.  As you start 
typing your own value, the Format box displays Custom Size. 

Height This box displays the height* of the currently set paper format.  As you start 
typing your own value, the Format box displays Custom Size.  

Portrait Choosing this option will allow you to print the document so that the short edge 
of the paper is horizontal.  Refer to the Preview area to see what the page will 
look like. 

Landscape Choosing this option will allow you to print the document so that the long edge 
of the paper is horizontal.  Refer to the Preview area to see what the page will 
look like. 

 
Changes the current page configuration (paper size and orientation only) to the 
printer settings. 

3.9.11.2 Page Setup Dialog Box: Margins Tab 

On this tab, you can set margins for the page to be printed.  This function does not constrain your 
drawing it only draws a line showing the margins. 

 
This tab contains the following options: 

Option Description 

Left 
Top 
Right 
Bottom 

In these boxes, specify the amount of space* between the left/top/right/bottom edge of 
the paper and the corresponding margin of the page. 

To display the margins on the ChemSketch page(s), select the Page Margins check box in the 
Preferences dialog box (General tab).  For more information on this dialog box, refer to 
Section 3.14.1.1. 

                                                      
* Units of measurement in these boxes correspond to those set in the Preferences dialog box (Options menu).  To enter 
the value in points/inches/millimeters/centimeters type the values and add the unit you want (pt/in/mm/cm), e.g., 5 pt.  The 
values will be recalculated into the corresponding units of measurement. 
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3.9.11.3 Page Setup Dialog Box: Poster Tab 

If you are going to print the poster, on this tab, you can set the number of pages your poster will 
consist of. 

 
This tab contains the following options: 

Option Description 

Width Calculation In this box, you can specify the number of standard pages (the size page 
dimensions is specified on the Size & Orientation tab) for the width of the 
poster.  Note that the maximal number of pages for the width is 5.  The 
calculated poster size will be displayed in the Virtual Page Size area.* 

Height Calculation In this box, specify the number of standard pages (the standard page size is 
specified on the Size & Orientation tab) for the height of the poster.  Note that 
the maximal number of pages for the height is 4.  The calculated poster size 
will be displayed in the Virtual Page Size area.*  

Virtual Page Size This area displays the calculated virtual size of a poster. 

3.9.12 Print 

This command allows you to print the active document using the current printer defaults.  For 
proper printing of your work, make sure that your Microsoft Windows environment and your 
printer are properly configured and connected.  See your Microsoft Windows User's Guide for 
details. 

As you choose this command, the Print dialog box is displayed allowing you to specify which 
pages of the document you want to print, the number of printed copies, and the printer to use. 

Note When you start printing the colored page, a message box appears asking if you 
want to print the page with the set background color.  If you choose No, the set 
background color will be ignored and the page will remain white.  Be careful when 
canceling background color printing: if you have, for example, a black background 
and the structures drawn in white, the structures will not be visible on the printout if 
you cancel background color. 

Shortcuts: 

Keyboard:  CTRL+P 

General toolbar:  
                                                      
* Units of measurement in these boxes correspond to those set in the Preferences dialog box (Options menu).  To enter 
the value in points/inches/millimeters/centimeters type the values and add the unit you want (pt/in/mm/cm), e.g., 5 pt.  The 
values will be recalculated into the corresponding units of measurement. 
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3.9.13 Print Preview 

This command allows you to display each page as it will look on the printout.  You can view 
multiple pages at a time, and magnify or reduce the size of the page on the screen.  

The view that appears incorporates the following buttons: 

Button Function 

 Prints the active document. 

 
Zooms in to get a close-up view of the document.  You can zoom in using the button in the Print 
Preview mode or by pressing the PLUS SIGN (+) on the numeric keypad. 

 
Zooms out to see more of the page (multiple pages) at a reduced size.  You can zoom out using 
the button in the Print Preview mode or by pressing the MINUS (–) on the numeric keypad. 

 
Displays only one page.  You can also display one page by pressing the ASTERISK (*) on the 
numeric keypad. 

 
Displays the first page in the current document. 

 
Displays the previous page in the current document (if any). 

 
Displays the next page in the current document (if any). 

 
Displays the last page in the current document (if any). 

 
Quits print preview and returns to the previous view of the document. 
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3.9.14 Properties 

This command displays the Document Properties dialog box, which allows you to set the 
properties (descriptive title, subject, author name, organization, and other user information in the 
file) for the active ACD/ChemSketch document which will help you to track the data. 

 
This dialog box contains the following options: 

Option Description 

Title Type the title you want to use when searching for the file. 

Subject Type the subject of the file.  Use this property to group similar files together, so 
you can search for all files that have the same subject. 

Author By default, this box contains your system login.  To change the author, delete 
the existing name, and then type a new one. 

Organization Type your company name. 

Comments Enter the comments for your file. 

Set As Default 
Properties 

If you select this check box, the information specified in this dialog box will be 
automatically inserted into the properties for newly created documents. 

Statistics Displays the dates when the document was created and modified, and the file size. 
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3.9.15 Send > As Is / As PDF 

Use these commands to send the current document by e-mail either as an .SK2 or .PDF file. 

When you choose the appropriate command, your default mail client starts, and a new message 
is created with the current document attached (either as an.SK2 or .PDF file).  Note that this 
command does not work properly if no mail client is set as the default. 

If you have opened a saved document and have edited it without saving the changes, the 
attached document will have the same name as the source file but will contain all of the changes 
you have made up to the moment of sending. 

If you have opened a new document and have not saved it yet, ACD/ChemSketch will give it a 
default name (noname 01, 02...). 

Note This command is not available if a new document is currently open and has not 
been edited yet. 

3.9.16 File Associations 

This command displays the File Associations dialog box where you can assign certain file 
formats to ACD/ChemSketch. 

 
The following options are available in this dialog box: 

Option Description 

Available Formats This box contains the formats that can be associated with the program.  
Select the check boxes of the formats that are to be associated with 
ACD/ChemSketch.  The Associated with area shows the application 
to which the currently highlighted format is linked. 

Always perform check when 
starting the program 

If this check box is selected, each time ACD/ChemSketch is started it 
will verify whether there are formats supported by your version that are 
not associated with it yet.  If there are any, this dialog box will appear at 
the startup. 
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Option Description 

 
Click this button to select all of the file formats in the Available 
Formats box. 

 
Click this button to cancel the selection of all the file formats in the 
Available Formats box. 

 
Click this button to close the dialog box applying the specified settings. 

 
Click this button to close the dialog box without applying association. 

If the file formats have been already associated with the program, the corresponding message 
will be displayed. 

If you open the File Associations dialog box under Windows NT but have no rights to change 
file associations, a warning message appears.  Contact your system administrator to resolve this 
matter. 

Note You can change file association through Windows Explorer: hold down SHIFT and 
right-click the required file, then, from the shortcut menu that appears, choose 
Open With, and specify the application that should be used to open the file. 

3.9.17 Exit 

Use this command to close ACD/ChemSketch.  Note that if you have other programs from the 
ACD/Labs package running, you won't quit them with this command.  To close all of the 
programs, from the ACD/Labs menu, choose Close All. 

Note ChemSketch will prompt you to save your work unless you have just done so. 

Shortcuts: 

Keyboard: ALT+X 
Mouse: double-click the application control menu button (in the upper left corner of the 

window). 

3.9.18 Recent Files 

Use these submenu commands to display the recently opened files. 
You can display the file opened this day, the day before, within the last 7, 14, 30 days, or 12 
months. To clear the History, on the History submenu commands, choose Clear History. 

Note If you save a document in a format that is not supported by the Import 
command of ACD/ChemSketch, this file will not be displayed in the list of 
recently opened files. 
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3.10 Edit Menu 

The commands located on this menu allow you to edit the sketch contents, i.e., to cut, copy, 
paste, and undo actions. 

3.10.1 Undo 

This command allows you to cancel the last actions performed.  This command can be used up 
to 50 times in sequence so that you can restore almost any previous stage of your work.  To 
reverse the effect of the Undo command, from the Edit menu, choose Redo. 

Shortcuts: 

Keyboard:   ALT+BACKSPACE 

General toolbar:  

3.10.2 Redo 

This command allows you to cancel the action performed by the last Undo command.  This 
feature can be used sequentially up to 50 times so that you can restore almost any edits made to 
your work.  To reverse the effect of the Redo command, from the Edit menu, choose Undo. 

Note The Redo command can be used only once for each corresponding Undo 
command. 

Shortcuts: 

Keyboard:   SHIFT+ALT+BACKSPACE 

General toolbar:  

3.10.3 Cut 

This command removes the selected objects from the workspace and places them to the 
Clipboard.  Once the objects are on the Clipboard, you can paste them into other Microsoft 
Windows applications as well as other documents within ACD/ChemSketch, or other parts of the 
same document. 

Note When pasting structures copied from ACD/ChemSketch to other applications (e.g., 
Microsoft Excel), the structure may be represented as a set of numbers and figures 
(as a MDL molfile).  To place a picture of the structure, use the Paste Special 
feature in the application you are pasting to.  Among the paste options, choose 
either the ACD ChemSketch Object or Picture option.  The former inserts the 
structure as an OLE object thus allowing you to edit the inserted structure via 
ChemSketch by double-clicking on the picture. 

Shortcuts: 

Keyboard:   CTRL+X 

General toolbar:  
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3.10.4 Copy 

This command copies the selected objects to the Clipboard.  Once the objects are on the 
Clipboard, you can paste the selection into other Microsoft Windows applications as well as other 
documents within ACD/ChemSketch, or other parts of the same document. 

Note When pasting structures copied from ACD/ChemSketch to other applications (e.g., 
Microsoft Excel), the structure may be represented as a set of numbers and figures 
(as a MDL molfile).  To place a picture of the structure, use the Paste Special 
feature in the application you are pasting to.  Among the paste options, choose 
either the ACD ChemSketch Object or Picture option.  The former inserts the 
structure as an OLE object thus allowing you to edit the inserted structure via 
ChemSketch by double-clicking on the picture. 

Shortcuts: 

Keyboard:   CTRL+C 

General toolbar:  

3.10.5 Paste > Default 

This command pastes the last object added to the Clipboard into the document.  Once this 
command is selected, the cursor with the attached shadow of the object from the clipboard 
appears.  Click the desired location to place the object. 

Note If the object has been placed onto the Clipboard from an external application (not 
ACD/ChemSketch), it will be pasted as an embedded object and can be edited in 
the application it has been taken from.  To paste the object in different clipboard 
formats, on the Edit menu, point to Paste, and then choose Special. 

Shortcuts: 

Keyboard:   CTRL+V 

General toolbar:  

3.10.6 Paste > In Place 

This command pastes a copy of the Clipboard contents to the place the copy was taken from.  If 
the object is copied or cut from any external application (not ACD/ChemSketch), it will be pasted 
in the left upper corner of the page. 

Note To paste the object at arbitrary place in the workspace, on the Edit menu, point to 
Paste, and then choose Default. 

Shortcut: 

Keyboard:  CTRL+SHIFT+V 
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3.10.7 Paste > Special 

This command allows you to paste objects from the Clipboard in a specific format.  As you 
choose this command, the Paste Special dialog box with clipboard formats available for the 
current contents of the Clipboard appears.  Select the needed format and click OK.  The 
Clipboard contents appear attached to the cursor.  Click in the desired location to paste the 
object. 

To edit the object pasted in this way, double-click it.  If the object has not been created in 
ACD/ChemSketch, but in an external application (e.g., MS Excel), the corresponding application 
will be started (if available on your computer) where you can edit the object.  As you close the 
application, the edited objects will be updated in the ChemSketch window correspondingly. 

Note To insert an object created with another application or to link to another application 
and create an object without leaving ACD/ChemSketch, from the Edit menu, 
choose Insert Object. 

3.10.8 Paste > Structure 

This command pastes chemical structure(s) from the Clipboard.  It is useful for inserting chemical 
structures that were not created with ACD/ChemSketch (for example, from ISIS/Draw).  Unlike 
the Paste Special command, this command places structure(s) created with other applications 
not as a picture but as chemical structure(s) so that you can edit them in the Structure mode.  If 
the Clipboard does not contain a structure, this command is disabled. 

Note The possibilities of the Paste Structure function are limited so some structures can 
be pasted incorrectly. 

3.10.9 Paste > Table 

This command pastes the Clipboard contents into the workspace as a table.  It allows you to 
paste tables that were not created in ACD/ChemSketch (e.g., MS Excel tables or MS Word 
tables) and then edit them as usual ChemSketch objects.  Unlike the Paste > Special command, 
this command places table(s) created with other applications not as a picture or embedded object 
but as a ChemSketch table so that you can edit it in the Draw mode. 

As you choose this command, the Clipboard contents appear attached to the cursor.  Click the 
desired location to paste the copied objects. 

Note To insert an object created with another application in your ChemSketch document 
or to link to another application and create an object without leaving 
ACD/ChemSketch, from the Edit menu, choose Insert Object. 
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3.10.10 Delete 

This command erases all of the selected objects from the current page without placing them on 

the Clipboard.  If you want to delete specific objects only, use the Delete  tool on the General 
toolbar (for more information, refer to Section 3.5.1.) 

Note You cannot use the Paste commands to retrieve the objects erased with Delete; 
however, you can retrieve them by using the Undo command. 

Shortcut: 

Keyboard:  DELETE 

3.10.11 Select All 

This command selects all of the objects on the current ChemSketch page.  For more details on 
how to select/unselect individual objects in the Structure mode, refer to Sections 3.6.1–3.6.2. 

Note If the Select Graphics check box is cleared in the Preferences dialog box 
(Structure tab), the objects created in the Draw mode are not selected in the 
Structure mode. 

Shortcut: 

Keyboard:  CTRL+A 

3.10.12 Insert Object 

This command embeds an object created with another application.  This command allows you 
either to create the object (e.g., create a spreadsheet, picture, database, etc.) or to insert a 
previously created object into your drawing. 

To insert an object, follow the steps: 
1. Choose this command.  The dialog box with the list of the supported applications appears. 
2. Select an application and click OK.  The application, if available and properly installed, will be 

opened. 
3. In this application, create, open, or modify a file. 
4. Quit the application to return to ACD/ChemSketch.  The object is embedded in the left upper 

corner of the ChemSketch page. 

Note To edit the embedded object, from the Edit menu, choose Edit Object or double-
click the object. 
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3.10.13 Edit Object 

This command allows you to edit the selected object that was previously embedded with the 
Insert Object command. 

As you select the object and choose this command, the application associated with the object is 
started.  After making the necessary changes, quit the application to return back to 
ACD/ChemSketch where the object is automatically updated. 

Note You will have to operate in the Draw mode to select and edit the majority of the 
inserted objects, including spreadsheets and pictures. 

Shortcut: 

Mouse: Double-click the object to be edited. 

3.11 Pages Menu 

The commands located on this menu allow you to create, rename, or delete pages, browse 
through multipage document, and manage header/footer for the pages in your document. 

3.11.1 New 

This command creates a new blank page at the end of the document and makes it active.  One 
document can contain up to 100 pages. 

Shortcut: 

General toolbar:  

3.11.2 Insert 

This command creates a new blank page before the current page and makes it active. 

Shortcut: 

Keyboard:  SHIFT+F3 

3.11.3 Change Order 

This command allows you to rearrange pages in your document.  It displays the Change Order 
of Pages dialog box where you can see the current page number and specify a new number for 
the page by typing or using the arrows.  The other pages are reordered accordingly.  Note that 
this command is disabled if you have opened one-page document. 
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3.11.4 Delete 

This command removes the current page and its contents from the current document.  After a 
page has been deleted, the remaining pages in the document are renumbered. 

ACD/ChemSketch will not ask you to confirm the deletion.  Though, once deleted, the page can 
be recovered with the Undo command until you quit ChemSketch. 

Shortcut: 

Keyboard:  SHIFT+F4 

3.11.5 Rename 

This command allows you to rename the current page of a document.  Clicking this command 
displays the Rename Page dialog box.  In the Page Name box, type a new name for the current 
page.  Click OK. 

Assigned page names can be viewed on the status bar when you click Page List: 

 
Note You can use the Number/Annotate Page goody for page annotation.  For more 

information, refer to Appendix C. 

3.11.6 Color 

This command displays the Page Color dialog box where you can specify the background color 
of the current page.  Choose the color from the palette and click OK.  This command both sets 
the color of your display and affects the color of the page on the printout. 

Note When you start printing the colored page, a message box appears asking if you 
want to print the page with the set background color.  If you choose No, the set 
background color will be ignored and the page will remain white.  Be careful when 
canceling background color printing: if you have, for example, a black background 
and the structures drawn with white, structures will not be visible on the printout if 
you cancel background color. 

3.11.7 Header and Footer > Edit 

This command displays the Header and Footer toolbar that allows you to create headers/footers 
for the pages in your document.  Headers and footers can consist of text or graphics.  As in other 
applications, a header appears at the top of a page and a footer appears at the bottom. 
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The toolbar incorporates the following buttons: 

Button Function 

 
Inserts common header or footer items in your document.  From the drop-down list, 
choose the item you want to insert into header/footer.  The information is placed in tags 
(unrepresented text of document markup) containing braces and macro elements.  The 
macro elements denote the following: 
$N—page numbers 
$S—total page numbers 
$A—author's name 
$O—organization name 
$L—document title 
$J—document subject 
$F—file name 
$P—path with file name 
$T—time 
$D—date 
As the header/footer is formatted and you close the Header and Footer toolbar, the 
program runs the macro replacement process.  The author's name, organization name, 
document title, and document subject are inserted from the settings in the Document 
Properties dialog box (refer to Section 3.9.14). 
To avoid mistakes, do not try to insert one macro set into another.  Do not modify the 
information within braces; the program inserts it by default. 

 
Inserts page numbers that are automatically updated when you add or delete pages. 

 
Inserts a time field that is automatically updated so that the current time is displayed 
when you open or print the file. 

 
Inserts a date field that is automatically updated so that the current date is displayed 
when you open or print the file. 

 
Moves the insertion point from left to right within the header and footer fields thus 
aligning it right, center, and left.  Click this button as many times as required to occupy 
the desired position. 

 
Moves the insertion point from right to left within the header and footer fields thus 
aligning it left, center, and right.  Click this button as many times as required to occupy 
the desired position. 

 
Moves the insertion point to the header. 

 
Moves the insertion point to the footer. 

 
Displays the Open Document dialog box where you can specify the name and location 
of any previously saved .HFP file to be loaded into the current document. 

 
Displays the Save Document As dialog box where you can specify the name and 
location of an .HFP file to which the current footer and header are to be saved. 

 
Closes the Header and Footer toolbar and applies your settings. 

Tip You can use this feature to insert a background picture for your document.  When in 
the Edit Header/Footer mode, draw or insert the picture and place it in the required 
position on the page.  When you leave the editing mode, the picture will become a 
background for your drawings. 

3.11.8 Header and Footer > Load 

This command allows you to load the header and footer previously saved to an .HFP file. 
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3.11.9 Header and Footer > Save 

This command allows you to save the header and footer of the current document to an .HFP file, 
so that you can load it for other documents afterwards. 

If you save the header and footer for the first time, the Save Document As dialog box appears. 

3.11.10 Header and Footer > Save As 

This command allows you to display the Save Document As dialog box where you can specify 
the name and location of an .HFP file to which the header and footer of the current document are 
to be saved. 

3.11.11 Header and Footer > Set As Default 

This command allows you to display the Set Header/Footer Page as Default dialog box where 
you can specify an .HFP file whose header and footer are to be used by default, that is, they will 
automatically be inserted in newly created documents. 

To define the default header and footer, click Set Current as Default.  If you have not saved your 
header and footer into a file yet, the program will prompt you to do so.  As soon as the file is 
saved, it is defined as the default. 

To cancel the default header and footer, click Clear Default. 

3.11.12 Header and Footer > Clear 

This command removes both the header and footer from the current document. 

3.11.13 Header and Footer > Show 

This command toggles the display of headers and footers in the document.  Note that this 
command is selected by default. 

3.11.14 Previous 

This command displays the previous page of the document.  Note that this command is disabled 
if you have opened one-page document. 

You can also click Page List  (displays the current page’s number and the overall 
number of pages in the current document) on the status bar to quickly switch to the required 
page. 

Shortcuts: 

Keyboard:  PAGE UP 
Status bar:  
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3.11.15 Next 

This command displays the next page of the document.  Note that this command is disabled if 
you have opened one-page document. 

You can also click Page List  (displays the current page’s number and the overall 
number of pages in the current document) on the status bar to quickly switch to the required 
page. 

Shortcuts: 

Keyboard:  PAGE DOWN 
Status bar:  

3.11.16 First 

This command displays the first page of the document.  Note that this command is disabled if you 
have opened one-page document. 

You can also click Page List  (displays the current page’s number and the overall 
number of pages in the current document) on the status bar to quickly switch to the required 
page. 

Shortcut: 

Keyboard:  CTRL+HOME 

3.11.17 Last 

This command displays the last page of the document.  Note that this command is disabled if you 
have opened one-page document. 

You can also click Page List  (displays the current page’s number and the overall 
number of pages in the current document) on the status bar to quickly switch to the required 
page. 

Shortcut: 

Keyboard:  CTRL+END 
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3.12 Tools Menu 

The commands located on this menu allow you to refine a created structure and to determine its 
properties. 

3.12.1 Structure Properties 

This command displays the Properties panel containing properties of the currently selected 
structure(s).  You can also open this panel by double-clicking the structure with the Select/Move 

tool  active.  On this panel, you can specify the graphic representation of chemical drawings. 

 
The table below gives the general description of the panel parts: 

Option Description 

 
This set of options allows you to load the style attributes from any of the 
existing styles, save a user-defined style, and delete any of the user-
defined styles. 
To load the style, click the arrow and choose the style from the list.  
To apply it to the selection, click Apply at the bottom of this panel. 
To name your own style, set the required options in the panel, click in 
this box, type the name of the style, and click Save. 
To delete the style, find it in the list and click Del. 

Common tab On this tab, you can specify settings common for both atoms and 
bonds of the selected structure(s).  For more information, refer to 
Section 3.12.1.1. 

Atom tab On this tab, you can set the view options of atoms.  For more 
information, refer to Section 3.12.1.2. 

Bond tab This tab contains options for changing the display of bonds.  For more 
information, refer to Section 3.12.1.3. 
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Option Description 

Special tab On this tab, you can specify the style settings for the Markush bond 
shadow.  For more information, refer to Section 3.12.1.4. 

 
Applies the specified style settings to the selected structural fragments 
or structures. 

 
Saves the specified style settings as default, i.e., the default style will 
be applied to all the newly drawn structures automatically. 

 
Enables the update feature allowing you to copy style attributes from 
the drawn structure to the panel.  As you click this button, the cursor 

becomes an arrow labeled From .  Click with it a structure to 

update its style settings to this panel. 

 
Restores the settings of the current default style on the panel. 

Shortcuts: 

Keyboard:  CTRL+SHIFT+S 
Mouse: double-click a fragment or atom 

3.12.1.1 Properties Panel: Common Tab 

This tab allows you to specify the style settings for the selected structural fragments or structures. 

 
This tab contains the following options: 

Option Description 

Show Carbons The check boxes located in this area control whether all of the carbons or 
terminal carbons only should be displayed.  Select/clear the All or Terminal 
check boxes.*  If none of the check boxes is selected, no carbons will be 
displayed in the selected structure. 

Hide Zero Charge This check box controls whether the zero charges should be displayed.* 

                                                      
* If several objects are selected on the ChemSketch page, the check box of an attribute can be: cleared, i.e., this attribute 
will not be applied to the selected objects; selected, i.e., this attribute will be applied to the selected objects; dimmed (if the 
state of the current attribute differs for the selected objects), i.e., this attribute will not be changed for the selected objects. 
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Option Description 

Cross Out Invalid Atom This check box controls whether the invalid atoms should be crossed out.  If 
you select this check box, the invalid atoms will be automatically crossed out 
with X.* 

Size Calculation In this area, you can specify the atom symbol size and bond length **.  Note 
that if the Auto check box is selected, the bond length will be automatically 
calculated to fit the entered atom symbol size and vice versa. 

Atom Style In this area, you can specify the style for atom labels.  If the selected atoms 
are of mixed style, the Own button  is enabled. 

Bond Style In this area, you can set the bond thickness** and color. 

3.12.1.2 Properties Panel: Atom Tab 

On the Atom tab, you can specify the style settings for the selected atom labels. 

Preview area

 
Each label is represented with a set of attributes: 

 atom symbol 

 hydrogen 

 index 

 charge 

 valence 

 isotope 

 numbering 

To change the settings for any of them, click the corresponding button below the preview area.  
To apply the same style settings to several kinds of atom attributes at a time, hold down SHIFT 
and click the required buttons in the row of attributes. 

Tip If some of the changes made to the current attribute(s) are not displayed in the 
preview area at once, press ENTER. 

                                                      
* If several objects are selected on the ChemSketch page, the check box of an attribute can be: cleared, i.e., this attribute 
will not be applied to the selected objects; selected, i.e., this attribute will be applied to the selected objects; dimmed (if the 
state of the current attribute differs for the selected objects), i.e., this attribute will not be changed for the selected objects. 
** Units of measurement in these boxes correspond to those set in the Preferences dialog box (Options menu).  To enter 
the value in points/inches/millimeters/centimeters, type the values and add the unit you want (pt/in/mm/cm), e.g., 5 pt.  
The values will be recalculated into the corresponding units of measurement. 
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The following options are available: 

Option Description 

 In this box, you can specify the font style to be applied to the symbol(s) currently 
selected below the preview area. 

 
In this box, you can specify the font size to be applied to the symbol(s) currently 
selected below the preview area. 

 Allow you to make the corresponding symbols in the atom labels bold / italic / bold 
italic.  If the Own button  is enabled, it means the current attribute has mixed 
formatting in the selection. 

 In this box, you can specify the color for the symbol(s) currently selected below the 
preview area. 

Show This check box controls whether the selected attribute should be shown in the 
structure or not.* 

Value This box is present for atom symbol , hydrogen , charge , valence , isotope 
 and numbering  and allows you to set the corresponding value for any of these 

attributes. 
For the atom symbol, if you choose Empty, no atom symbol will be inserted. 
For the hydrogen symbol , in this box, you can specify the position of the hydrogen: 
auto position, left, right, bottom, or top relative to the basic atom symbol. 
Note that to make this box appear on the panel you should previously select one atom 
only. 

Y This box is present for hydrogen index , charge , valence , isotope  and 
numbering  and allows you to set the Y-coordinate** of the corresponding attribute 
relative the basic atom symbol. 

After H This check box controls the position of the valence symbol  in the atom label.  If 
you select this check box, the valence symbol will be placed after hydrogen.*  

Soft Select this check box to make the charge ‘soft’.  The ‘soft’ charge disappears after the 
charged atom is connected to a bond.  If this check box is cleared, the specified 
charge will remain when any connections are made to the charged atom.  Note that if 
you increase or decrease the atom charge using one of the Increment (+) Charge 

 or Decrement (–) Charge  tools on the Atoms toolbar, the charges are set 
as ‘soft’.* 

X In this box, specify the X value that controls the position of the numbering symbol  
relative to the atom label along the X-axis.  Note that the coordinates can have a 
negative value.* 

                                                      
* If several objects are selected on the ChemSketch page, the check box of an attribute can be: cleared, i.e., this attribute 
will not be applied to the selected objects; selected, i.e., this attribute will be applied to the selected objects; dimmed (if the 
state of the current attribute differs for the selected objects), i.e., this attribute will not be changed for the selected objects. 
** Units of measurement in these boxes correspond to those set in the Preferences dialog box (Options menu).  To enter 
the value in points/inches/millimeters/centimeters, type the values and add the unit you want (pt/in/mm/cm), e.g., 5 pt.  
The values will be recalculated into the corresponding units of measurement. 
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3.12.1.3 Properties Panel: Bond Tab 

On the Bond tab, you can specify the style settings for the selected bonds. 

Preview area

 
The following types of bonds are available: 

 single bond 

 double bond 

 triple bond 

 up stereo 

 down stereo 

 coordinating bond  

 undefined bonds 

To change the settings for any of them, click the corresponding button below the preview area.  
To apply the same style settings to several kinds of bonds at a time, hold down SHIFT and click 
the required buttons in the row of bond types. 

As you make changes on the tab, you can preview the bond appearance in the preview area. 

The following options are available for bond attributes: 

Option Description 

 
In this box, you can specify the line thickness* to be used for the corresponding type 
of bond. 

 
In this box, you can specify the color for the bond lines of the type currently selected 
below the preview area. 

Between In this box, you can specify the distance between the lines for double bond  and 
triple bond . 

Shift This box is present for double bond  and triple bond . 
For double bonds, in this box, you can specify the shift (i.e., difference in length) 
between the lines when the bond is defined as a symmetric. 
For triple bonds, in this box, you can specify the difference* between the central line 
length and the length of other two lines in a bond.  

Pos. In this box, you can specify the position of two lines in a double bond  relative to 
each other.  You can see the specified position in the preview area. 

Width In this box, you can specify the thickness* of the wider end for up stereo  and down 
stereo  bonds, and the width* of sections for undefined bonds  

                                                      
* If several objects are selected, these check boxes may have three statuses: cleared—does not apply the current option 
to all the selected objects, selected—applies the current option to all the selected objects, and grayed—does not change 
the current option of the selected objects). 
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Option Description 

Step In this box, you can specify the step between the sections representing down stereo 
 and undefined bonds . 

H. Length 
H. Width 

In these boxes, you can specify the length and width of the arrowhead for 
coordinating bond . 

3.12.1.4 Properties Panel: Special Tab 

On the Special tab, you can specify the style settings for the Markush bond shadow. 

 
The following options are available: 

Option Description 

Show Controls whether the Markush bond shadow should be shown in the structure or not. 

 Solid Click this button to shadow the Markush bond in a solid color.  You can specify the fill color 
in the adjacent Color box that appears. 

 Pattern Click this button to shadow the Markush bond using a diagonal strip pattern.  You can 
specify the prototype and color for hatching in the Color and Pattern boxes to the right. 

 Mixed The active Mixed button indicates that the state of the Markush bond shadow in the 
selected objects differs and will not be changed. 

Color In this box, you can specify the color to be applied to the selected Markush bond. 

Pattern In this box, select the needed pattern for hatching. 

3.12.2 Clean Structure 

This command redraws and resizes the selected chemical structure(s) to standardize all of the 
bond lengths and angles.  If there is more than one structure in the current page and none of 
them is selected, all of the structures will be ''cleaned''. 
The Clean Structure function standardizes all of the bond lengths and angles, while minimally 
changing the relative dislocations of all the inter-bonded atoms and fragments in the drawn 
structure.  To define the way of structure representation, in the Preferences dialog box (Clean 
tab), select the required checkboxes (for more information, refer to Section 3.14.1.4). 

If the results are not satisfactory, use Undo  to cancel the changes made, change the mutual 

dislocations of the selected atoms or fragments with the Select/Move  or 

Select/Rotate/Resize  tools, and apply the Clean Structure command again. 

Shortcuts: 

Structure toolbar:   
Keyboard:  F9 
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3.12.3 Check Tautomeric Forms 

This command checks and generates the most reasonable tautomeric forms of drawn organic 
structures.   

As soon as the forms are generated, the Check Tautomeric Forms dialog box appears with the 
suggested predominant tautomeric forms displayed. 

Note If the drawn structure is the major tautomeric form itself, selecting this command 
displays the corresponding message. 

 
This dialog box contains the following options: 

Option Description 

Information Displays the number of tautomeric forms suggested. 

Structure Displays the drawn chemical structure as the dialog box is open.  As you click 
the Next  and Previous  buttons below, this area displays 
the suggested tautomeric forms. 

   Use these buttons to browse through the tautomeric forms. 

 
Replaces the drawn structure with the structure currently displayed in the 
Structure area. 

Shortcuts: 

Structure toolbar:  
Keyboard:  CTRL+SHIFT+T 
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3.12.3.1 ACD/Tautomers Algorithm 

The following information will help you to gain a better understanding of the features of the 
current algorithm. 

The ACD/Tautomers algorithm recognizes and takes into account most of the known types of 
tautomeric equilibrium such as: 

• Aldehydes, ketones, thioaldehydes, thioketones—enoles, thioenoles; 
• Imines—enamines; 
• Oximes—nitrozocompounds; 
• Nitrocompounds—aci-form of nitrocompounds; 
• Tautomeric equilibria of oxy-, amino- and thio- substituted and nonsubstituted 5- and 6-

member heteroaromatics 

In most cases, the influence of the electron withdrawing groups on the tautomeric equilibrium is 
taken into account as well. 

The following major types of known tautomeric equilibria are not taken into account in the current 
ACD/Tautomers algorithm: 

• Ring—chain equilibria; 
• Equilibria involving any changes in the atomic valence; 
• Equilibria that are too slow without a catalyst. 

The ACD/Tautomer algorithm does not proceed with the following classes of chemical structures: 
• Structures containing metal atoms; 
• Structures containing charged atoms, other than the derivatives of nitrogen (+) bonded to 

oxygen (–); 
• Structures containing elements in their non-typical valence; 
• Structures with coordinating bonds; 
• Structures containing more than 255 atoms. 

The current ACD/Tautomers algorithm provides only the suggested tautomeric forms, but not 
necessarily the correct forms.  The possibility of the alternative tautomeric forms should always 
be carefully considered, if the drawn organic structure contains two or more double or triple 
bonds conjugated with or attached to oxygen, nitrogen, sulphur, or other heteroatoms.  Consult 
other sources of information to make a final decision. 

3.12.4 3D Structure Optimization 

This command creates a realistic 3-dimensiomal model of a planar (2D) chemical structure.  This 
option can be applied to only one selected structure at a time.  While optimization is being carried 
out, the status bar displays the progress and allows you to cancel at any time.  After the 3D 
optimization is complete, the 3D model is automatically available for 3D rotation if the Switch to 
3D-Rotation Mode check box in the Preferences dialog box (Structure tab) is selected (for 
more information on the dialog box, refer to Section 3.14.1.2).  If this check box is cleared, you 

should manually switch to the 3D Rotation mode by clicking 3D Rotation  on the Structure 
toolbar. 

The 3D optimization is based on modified molecular mechanics which take into account bond 
stretching, angle bending, internal rotation, and Van der Waals non-bonded interactions.  
Modifications include minor simplification of potential functions and enforcement of the 
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minimization scheme by additional heuristic algorithms for dealing with "bad" starting 
conformations.  The 3D optimization algorithm is a proprietary version of molecular mechanics 
with the force field initially based on CHARMM parametrization (refer to B.R. Brooks, R.E. 
Bruccoleri, B.D.Olafson, D.J. States, S. Swaminathan, and M. Karplus. CHARMM: A program for 
macromolecular energy, minimization, and dynamics calculations.  J. Comput. Chem. 4, 187–217 
(1983)).  The modifications involve some simplification and were intended to increase the stability 
and speed of computation.  Note that 3D-optimizer is NOT a full-scale molecular mechanics 
engine.  Its design aims to reliably reproduce reasonable conformations from (possibly very 
unreasonable) 2D drawings, rather than to precisely optimize 3D structures. 

Occasionally, the 3D optimization produces a molecular conformation different from what you 
have expected.  It is the very essence of the conformational analysis that structures typically have 
many possible conformations.  The optimizer finds only one, and it is not necessarily the one you 
have expected.  For example, you probably expect a cyclohexane fragment to be a chair, but the 
optimizer may generate twist-boat, which is also one of its suitable conformations (indeed, in 
many structures this fragment exists in a twisted form).  To obtain another conformation, move 
some atoms in the resultant 3D structure to make the initial structure closer to the final 
conformation, and then optimize the structure once again. 

If you try to obtain a specific enantiomer for a structure with chiral centers, in the process of 
optimization, the configuration input may occasionally change to an opposite one.  To solve the 
problem, it is usually enough to draw all four substituents of the chiral atom and use both Up and 
Down Stereo Bonds tools to define the required direction of bonds in the initial 2D structure.  If it 
doesn't work, you can move the atoms manually in the resulted 3D structure and optimize the 
structure once again.  In any case, we recommend answering "No" when you are asked whether 
to remove hydrogens before starting optimization in the unfolding 3D Structure Optimization 
dialog box. 

You may wish to perform actual conformational analysis of your structure using a special 
molecular mechanics or quantum chemistry geometry optimization package.  ChemSketch 3D-
optimized structure may serve as input data in this case. 

Note ACD/ChemSketch can optimize structures containing atoms from hydrogen to 
xenon with standard valence state and bonding states. 
 
If you use the up and down stereo bonds to define the stereoconfigurations, you 
should do that on the "flat", non-3D-optimized structure.  Note that the stereo bonds 
on 3D structure can be ambiguous. 

Shortcuts: 
Structure toolbar:  
Keyboard:  CTRL+SHIFT+3 

3.12.5 Calculate Boiling Point 

This command calculates boiling point (BP), vapor pressure (VP), enthalpy of vaporization, and 
flash point for the selected structure.  Choosing this command opens the ACD/Boiling Point 
dialog box with a graph illustrating the calculated BP or VP. 

Note This module must be purchased in addition to ChemSketch. 

For more details on the Boiling Point dialog box options, refer to the ACD/Boiling Point User's 
Guide. 

Shortcuts: 
Structure toolbar:  
Keyboard:  CTRL+SHIFT+B 
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3.12.6 MassSpec Scissors 

This command calculates and displays monoisotopic mass for several fragments of a structure.  
Select bond(s) connecting fragments for which you want to calculate monoisotopic mass, and 

choose this command or click MassSpec Scissors .  Monoisotopic mass values will appear 
beneath the all fragments. 

Note To calculate nominal mass and average mass values for a structure fragment, 
select it and then choose the corresponding command from the Calculate 
submenu (Tools menu). 

If you select three and more adjoining bonds simultaneously, the warning message appears 
informing you that all of the selected bonds will be broken as a result of this operation, and it 
looks that a part of a molecular structure or the whole structure has been selected accidentally.  
Click Yes to continue the process anyway or No to cancel it. 

Shortcut: 

Structure toolbar:  

3.12.7 Show Aromaticity 

This command transforms the conjugated double bonds into the delocalized double bonds in 
aromatic rings of the selected structure(s) or fragment(s) or, if no selection is made, in aromatic 
rings of all the structures on the current page. 

Note To remove aromatic circles, from the Tools menu, choose Hide Aromaticity. 

Shortcut: 

Keyboard: CTRL+SHIFT+A 

3.12.8 Hide Aromaticity 

This command transforms the delocalized double bonds in aromatic rings into the conjugated 
double bonds in all of the structures on the current page or in the selected structure(s) or 
fragment(s). 

Note To show aromatic circles, from the Tools menu, choose Show Aromaticity. 

Shortcut: 

Keyboard: CTRL+SHIFT+H 
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3.12.9 Expand Shorthand Formulae 

This command expands a label based on the shorthand formula inserted with the help of the Edit 
Atom Label tool  (for more information, refer to Section 3.7.4).  Select the label you want to 
expand and choose this command.  If no structure(s) or fragments are selected, this command 
affects all of the drawn structures on the current page. 

The following symbols are acceptable by this tool: 

'~' (tilde)—negative charge; 

'+' (plus)—positive charge; 

'–' (minus)—single bond (can be omitted); 

'=' (equal sign)—double bond; 

'%' (percent)—triple bond; 

'( )' (brackets)—embrace a group of atoms. 

Note You can find conventions for label expanding in the EXPAND.TXT file.  The left 
column in this file contains notations supported by the Expand tool.  It is not 
recommended to modify this file. 

Shortcut: 

Keyboard: CTRL+SHIFT+F 

3.12.10 Add Explicit Hydrogens 

This command adds explicit hydrogens to the selected fragment or structure.  If there is no 
selection in the working area, explicit hydrogens are added to all of the structures drawn on the 
current page. 

To remove explicit hydrogens, from the Tools menu, choose Remove Explicit Hydrogens.  

Note If you choose to optimize the structure with explicit hydrogens in 3D, you are asked 
whether to remove explicit hydrogens before 3D optimization.  Even if you choose 
Yes, the hydrogens may still appear in the 3D optimized structure if the Add 
Hydrogens option in the Preferences dialog box (Structure tab) is selected.  For 
more information, refer to Section 3.14.1.2. 

Shortcut: 

Keyboard:  CTRL+SHIFT+Y 

3.12.11 Remove Explicit Hydrogens 

This command hides explicit hydrogens from the selected fragment or structure.  If no 
structure(s) or fragments are selected, explicit hydrogens will be removed from all of the drawn 
structures on the current page. 
To add explicit hydrogens, from the Tools menu, choose Add Explicit Hydrogens (for more 
information, refer to Section 3.12.10). 

Shortcut: 

Keyboard: CTRL+SHIFT+R 



2BStructure Mode 

ACD/ChemSketch  Reference Manual 77 

3.12.12 Bring Bond(s) to Front 

This command allows you to switch the selected background bond to foreground.  Select the 
bond and choose this command. 

If the Enable Bond Intersections check box in the Preferences dialog box (Structure tab) is 
selected, ACD/ChemSketch automatically breaks the bond behind the new bond that is drawn.  
The broken bond is considered to be the background bond and the unbroken one is considered 
to be in the foreground. 

 

Tip You can also bring background bond to front using the Change Position  tool 
(refer to Section 3.6.20). 

Shortcut: 

Keyboard: CTRL+F 

3.12.13 Send Bond(s) to Back 

This command moves the selected foreground bond(s) to the background (see the explanation in 
the previous section). 

Tip You can send foreground bond to back using the Change Position  tool (for 
more information, refer to Section 3.6.20). 

Shortcut: 

Keyboard: CTRL+K 

3.12.14 Auto Renumbering 

This command automatically numbers atoms of the selected structure or fragment.  If there are 
no selected structures or fragments in the workspace, all of the atoms currently drawn in the 
workspace are numbered. 

Note To edit atom numbering, use the Manual Numbering  or Atom Chemical 

Properties  tools (for more information, refer to Sections 3.7.8 and 3.7.7 
correspondingly).  To change the style (font size, color, etc.) of atom numbers, use 
the Properties panel (refer to Section 3.12.1). 

Shortcut: 

Keyboard: CTRL+SHIFT+N 
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3.12.15 Clear Numbering 

This command allows you to remove atom numbering from the selected structure or fragment.  If 
there are no selected structures or fragments in the workspace, atom numbering will be removed 
in all of the structures drawn in the workspace.  

Note To insert or edit atom numbering, use the Auto Renumbering command (refer to 

Section 3.6.14), or the Manual Numbering  and Atom Chemical Properties 

 tools (for more information, refer to Sections 3.7.8 and 3.7.7 correspondingly).  
To change the style (font size, color, etc.) of atom numbers, use the Properties 
panel (refer to Section 3.12.1). 

Shortcut: 

Keyboard: CTRL+SHIFT+L 

3.12.16 Generate > Name for Structure 

This command allows you to generate name(s) for the drawn structure(s).  Note that this 
command is available both in the Structure and Draw modes.  To obtain a name for one 
structure, select it, and then choose this command.  The generated name will be inserted under 
the structure as a text string.  To generate name for a mixture, select the required structures and 
choose this command.  The generated name for the mixture will appear under the lower structure 
as a text string in one line. 

Note If only one structure is drawn or if you want to generate name for all the structures 
drawn in the workspace, you do not have to select structures. 

ACD/Name Freeware is distributed as a free add-on to ACD/ChemSketch.  It has the following 
restrictions as compared to the commercial version: structures to be named can contain no more 
than 50 atoms (H, C, N, P, O, S, F, Cl, Br, I, Li, Na, or K) and no more than 3 cycles in any 
polycyclic part. 

To get more information on the commercial version of ACD/Name software visit our Web site at 
http://www.acdlabs.com/products/name_lab/name/. 

Shortcuts: 

Keyboard:  CTRL+SHIFT+I 

General toolbar:  

http://www.acdlabs.com/products/name_lab/name/�
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3.12.17 Generate > Structure from Name 

This command starts the ACD/Name to Structure module that generates structures from 
systematic chemical names created according to IUPAC Recommendations on Nomenclature of 
Organic Chemistry, Chemical Abstract Service (CAS) inverted names, trivial and trade names, 
registry numbers and abbreviations.  Note that the ACD/Name to Structure module should be 
purchased in addition to ACD/ChemSketch.  For detailed description on how to work with this 
module, refer to the ACD/Name to Structure User’s Guide located in ACD/Labs documentation 
folder (\\DOCS\NAMESTR.PDF). 

As you choose this command, the ACD/Name to Structure dialog box will appear: 

 
This dialog box contains the following options: 

Option Description 

Name In this box, specify the name and click Run to start the structure generation.  
Note that the drop-down list includes the names for which the structure 
generation process has been run before. 

Warning(s) This field displays the possible errors and warning messages occurring in the 
process of structure generation.  Note that the system may generate the optimal 
structure in spite of the warning messages. 

Structure Displays the generated structure.  If the system generates several structures for 
one name (e.g., pentanedithioic acid), the structures are placed into separate 
tabs.  To view the structure, click the corresponding tab. 
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Option Description 

 
Starts the structure generation process for the name specified in the Name box. 

 
Places the generated structure into the ChemSketch window. 

 
Displays the ACD/Name to Structure Options dialog box where you can set 
preferences for the structure generation process (for more information, refer to 
Section 3.12.17.1). 

 
Displays the information about the current version of the program and the 
company-producer.  

Shortcuts: 

Keyboard:  CTRL+SHIFT+G 

General toolbar:  

3.12.17.1 ACD/Name to Structure Options Dialog Box 

The ACD/Name to Structure Options dialog box allows you to specify the structure generation 

options.  To display it, in the ACD/Name to Structure dialog box, click Options . 
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This dialog box contains the following options: 

Option Description 

Numbering If the Show Numbering in Dialog check box is selected, the atoms numbering 
will be displayed in the ACD/Name to Structure dialog box. 
If the Copy to Editor with Numbering check box is selected, the atoms 
numbering will be displayed on the structure in case it is placed to the 
ChemSketch page. 
Note that if the generated structure is taken from ACD/Dictionary, numbering 
will not be displayed regardless of the options selected. 

Warnings If the Ignore Warnings option is selected, the program will generate 
structure(s) without displaying any warnings. 
If the Report Warnings option is selected, the generated structure(s) will be 
displayed together with warnings on its (their) reliability. 
Select the Stop on Warnings option, to stop the structure generation process if 
any problems appear.  As a result, the corresponding warnings and no structure 
will be displayed. 
If the structure is found in ACD/Dictionary, it is displayed along with the 
corresponding warning. 

Mark Undefined 
Double Bond Stereo 

If this check box is selected, the program will generate structures with 
undefined double stereo bonds for names that do not contain the 
information on the double bond configuration. 

Search 
ACD/Dictionary 

If this check box is selected the system will search through ACD/Dictionary for 
the specified name in case the structure generation. 

Check for SMILES 
Notation 

If this check box is selected, the program will check if the entered name 
corresponds to the SMILES notation.  If it does, the structure will be 
generated. 

Check for InChI 
Notation 

If this check box is selected, the program will check if the entered name 
corresponds to the InChI notation.  If it does, the structure will be 
generated. 
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3.12.18 Generate > Stereo Descriptors 

This command allows you to generate stereo descriptors for double bonds, chiral, and pseudo 
chiral centers.  This command is available both in the Structure and Draw modes. 

To generate stereo descriptors, select a structure or a set of structures and choose this 
command.  Stereo descriptors appear on the selected structure(s) near the corresponding chiral 
center or double bond. 

Note If no structure(s) is(are) selected in the workspace, stereo descriptors are 
automatically generated for all structures on the current page which have stereo 
centers or double bonds for which Z/E or R/S isomerism is possible. 

S and R describe a chiral center configuration. 

E and Z describe a double-bound configuration. 

Small r and s describe configurations of pseudo chiral centers. 

When generating stereo descriptors for 3D-optimized structures, the program takes into account 
the actual X-, Y-, and Z-coordinates, while the stereo bonds are ignored. 

When generating stereo descriptors, the program ignores the direction of the bond that depends 
on the way of drawing only (whether it points upwards or downwards).  However, it differentiates 
between the Up and Down Stereo bonds. 

Note To change the color of stereo descriptors, from the Options menu, choose 
Preferences.  In the dialog box that appears, click the Structure tab, and then 
select the appropriate color in the Auto/Manual Numbering box. 

To generate special stereo descriptors for potential centers, and stereo warnings on the 
incorrectly defined stereoconfiguration, select a structure or a set of structures, specify options in 
the Stereo Descriptors Options dialog box, and choose this command. 

After generation, the potential chiral centers will be marked with the asterix sign (*), atoms with 
the incorrectly defined stereoconfiguration will be marked with the question mark (?). 
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3.12.19 Generate Stereo Descriptors Options 

This command displays the Stereo Options dialog box, which allows you to specify options for 
generating special warnings descriptors about missed or ambiguous definitions of 
stereoconfiguration.  This option allows you to control the quality of chemical structure diagrams 
and avoid mistakes in structure representation and data calculations. 

 

The dialog box contains the following options: 

Option Description 

Take into Account 
Stereo Wedges 
Direction 

If this check box is selected, the "up" and "down" wedges which specify 
stereo centers will be analyzed with regard to their directions 
(depending to which atom a narrow end is attached). 
If this check box is not selected, the sign ("up" or "down") of the stereo wedge 
doesn't depend on the direction. 

           

If this check box is selected: 
(2R)-2-chlorobutane  (2S)-2-chlorobutane  (2R)-2-chlorobutane 
If this check box is not selected: 
(2R)-2-chlorobutane      (2R)-2-chlorobutane     (2R)-2-chlorobutane -  

Mark Undefined Chiral 
Centers 

Select this check box to generate stereo descriptors for potential chiral centers.  
These centers will be marked with the asterisk sign (*). 

Mark Incorrectly 
Defined Stereo 

Select this check box to generate special warning descriptors to mark atoms 
with an incorrectly defined stereoconfiguration.  They will be marked with a 
question mark (?). 

 

3.12.20 Generate > SMILES Notation 

This command generates SMILES (Simplified Molecular Input Line Entry Specification) for the 
structure(s) displayed in the ChemSketch window.  Note that this command is available both in 
the Structure and Draw modes. 

If none of the displayed structures is selected, the SMILES’s will appear for all the structures 
displayed.  To generate SMILES for the definite structure, you should select it first. 
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3.12.21 Generate > Structure from SMILES 

This command generates structure(s) from SMILES (Simplified Molecular Input Line Entry 
Specification).  Note that this command is available both in the Structure and Draw modes. 

Choosing this command displays the Generate Structure from SMILES dialog box where you 
can enter the required SMILES. 

You can also generate structures from SMILES strings displayed in the ChemSketch window 
(either generated by using the Generate > SMILES Notation command, or placed in as a text 
manually).  Just select the required SMILES string and choose this command.  The generated 
structure will be placed below the SMILES string. 

3.12.22 Generate > InChI for Structure 

This command allows you to generate the InChI notation for a drawn structure. 

The IUPAC International Chemical Identifier (InChITM) is a non-proprietary identifier enabling 
unambiguous identification of chemical substances for electronic and digital handling of chemical 
structural information. 

An InChI label is generated by converting an input chemical structure (in the form of a ‘connection 
table’) to a unique and predictable set of ASCII characters.  The InChI notation is a way of 
representing chemical compounds in a manner that does not depend on the way of drawing. 

InChI procedures were developed under IUPAC project during the period 2000–2004.  The 
technical development was carried out primarily at the US National Institute of Standards and 
Technology (NIST). 

More information about InChI is available on the IUPAC website at www.iupac.org/inchi. 

Shortcut: 

General toolbar:   

http://www.iupac.org/inchi�
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3.12.23 Generate > InChI Options 

This command displays the InChI Options dialog box, which allows you to specify preferences 
for the InChI label generation. 

 
This dialog box contains the following options: 

Option Description 

InChI String This option allows you to define whether or not to generate InChI string. 
If neither InChI AuxInfo nor InChI Key check box is selected, the InChI String 
option is selected by default. 

InChI AuxInfo—New to 
11.0! 

This option allows you to define whether or not to generate the auxiliary 
information for creating InChI string.  It describes in a specific way the atom 
connections, numbers and coordinates. 
Note that AuxInfo can be different for the same structure, it depends on the 
structure drawing order.   

InChI Key— New to 
11.0! 

This option allows you to define whether or not to generate InChI key. 
InChI key is a character signature based on a hash code of the InChI string.  A 
hash code is a fixed length-condensed digital representation of a variable length 
character string.  The length of InChI key is always 25 characters, including 
separator.  
Note that you cannot generate structure from InChI key. 

Mobile H Perception This option allows you to define if the possible tautomerism should be taken into 
account or not.  Clear this check box to include the information on the specific 
tautomer into the InChI notation. 

Include Bonds to 
Metal 

If this check box is selected, the InChI notation will include an information about 
bonds between metal and other atoms; otherwise, it will be ignored. 

Stereo Options This option allows you to choose whether to take into account 
stereoconfigurations in the drawn structure or not and how to treat them.  You 
can choose between Ignore, Absolute, Relative and Racemic options that will 
be indicated in the corresponding section of the generated InChI notation. 
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Option Description 

Narrow End of Wedge 
Points to Stereocenter 

This option defines how to treat stereo bond connecting two stereocenters.  If 
the check box is cleared, the procedure treats such stereo bond as belonging to 
both stereocenters and having the same sense for both of them.  If the check 
box is selected, only a narrow end will be taken into account and only one 
stereocenter will be defined in the generated InChI notation. 

To generate InChI with the options specified in this dialog box, on the General toolbar, click InChI 

for Structure . 

More information about InChI is available on the IUPAC website at www.iupac.org/inchi. 

3.12.24 Generate > Structure from InChI 

This command allows you to generate the structure for an InChI (IUPAC International Chemical 
Identifier) notation.  You can use this option in both Structure and Draw modes: 
• In the Structure mode; choose this command, and then in the Generate Structure from InChI 

dialog box that appears, type the InChI notation and click OK.  An outline view of the 
generated structure is attached to your cursor, simply click to place it on the workspace.  Note 
that you can flip the structure shadow by pressing TAB. 

• In the Draw mode; type the InChI notation into the text box, and then choose this command.  
The generated structure appears on the ChemSketch page. 

More information about InChI is available on the IUPAC website at www.iupac.org/inchi. 

3.12.25 Search for Structure—Commercial version only! 

This command starts the ACD/Search for Structure module that allows you to search for drawn 
chemical structure(s) in a variety of files without opening them.  The following formats are 
supported: 

• ACD/ChemSketch Document (.SK2) 
• MDL molfile (.MOL) 
• MDL SDfile (.SDF) 
• ISIS/Sketch BIN-file (.SKC) 
• CambridgeSoft ChemDraw CHM-file (.CHM) 
• CambridgeSoft ChemDraw CDX-file (.CDX) 
• Adobe Acrobat (.PDF) (created with ACD/Labs software) 
• REACCS rxnfile (.RXN) 
• Microsoft Word Document (.DOC) 
• Microsoft Excel Document (.XLS) 
• Microsoft PowerPoint Document (.PPT) 
• ACD/Spec Database (.NDB; .ND5; .ND8) 
• ACD/ChemFolder Database (.CFD) 
• ACD/CNMR User Database (.CUD) 
• ACD/HNMR User Database (.HUD) 
• ACD/XNMR Database (.XDB) 
• ACD/PhysChem User Database (.PCD; .LUD; .LU8; .PUD; .SUD) 

http://www.iupac.org/inchi�
http://www.iupac.org/inchi�
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• ACD/ChromGenius Database (.CGB) 
• ACD/NMR Predictor Internal Database (*NMR?.INT) 
• ACD/LogP Internal Database (LOGP.INT) 
• ACD/pKa Internal Database (PKA.INT) 
• ACD/Solubility DB Internal Database (SOL?.INT) 

As the structure is found, it can be viewed and placed either into the ChemSketch window or to 
the other applications. 

Draw the fragment or structure you want to find and choose this command or click the 

corresponding button  on the General toolbar.  In the ACD/Search for Structure window that 
appears, you can specify the searching preferences and define the folders to be searched 
through.  
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This dialog box contains the following options: 

Option Description 
Search Pattern Displays the structure(s) to search for in the files specified in the Look In area. 

Look In Select the check boxes against those folders that you want to search through.  
If you select the check box against a disk, all of the folders on this disk will be 
searched. 

 
In this box, you can specify the mask for the files to be searched through.  You 
can either type it manually or click the button to the right of the box.  In the 
Look Through Files dialog box that appears, choose the formats to be 
included into the search and set the file mask.  For more details on this dialog 
box options, refer to Section 3.12.25.1. 

Preview Displays the structure found by your query in the file currently highlighted in 
the Search Results list (only the structure rather than the entire page or the 
entire document). 

Click  to display the shown structure either in ACD/ChemSketch or in the 
application specified in the Search Options dialog box (Open tab). 

Search Results This area displays the list of files where the query structure has been found.  
You can double-click any file from the list to open it either in ACD/ChemSketch 
or in any other selected application (depending on the option selected in the 
Search Options dialog box, Open tab). 

 
Starts searching.  As you initiate the search, the Search button is transformed 

into the Stop button  that allows you to interrupt the search 
process and display the search results obtained so far. 

 
Displays the Search Options dialog box where you can specify search 
conditions (for more information, refer to Sections 3.12.25.2–3.12.25.3). 

 
Displays the Load Search Results dialog box where you can specify the 
name and location of a previously saved .SSF file containing search settings. 

 
Displays the Save Search dialog box where you can specify the name and 
location of an .SSF file (Search for Structure Files format).  The saved file will 
include the structure(s) to be searched, the folder and the file mask settings, 
as well as the search results (if any). 

Status bar  Files Processed—indicates the number of files searched through so far. 
Entries Found—indicates the number of structures found so far. 
Structures Compared—reflects the number of structures compared to the 
search pattern so far. 
Reflects the current search location while searching or state on completion of 
the corresponding action: Search Complete, Search Restored, or Search 
Saved. 

 
Closes the current window.  Before the ACD/Search for Structure window is 
closed, the program prompts you to save the changes to the search settings. 

 
Displays information about your copy of ACD/Search for Structure, including 
the version number, the copyright, and your user registration information. 

If there are any results displayed in the Search Results box, and you want to start a new search, 
a message appears prompting you to confirm whether to perform a new search or not. 

Shortcuts: 

Keyboard:  CTRL+SHIFT+C 

General toolbar:  
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3.12.25.1 Look Through Files Dialog Box 

In this dialog box, you can select the formats of files to be searched through and set the file mask 
for each format. 

To display this dialog box, in the Look In box of the ACD/Search for Structure window, click 
Browse . 

 
This dialog box contains the following options: 

Option Description 
List of Formats Displays the formats (with the specified mask in broken brackets) supported 

by the ACD/Search for Structure module. 
To add the formats to the list of files to be searched through, select the 
corresponding check boxes. 
To set the mask for a specific format, highlight the format in the list and click 
Change Mask. 

 
Select the format you want to set a mask for, and then click this button to 
display the Change File Mask dialog box.  Restrict your search through the 
files of the format highlighted in the list to certain files by typing their mask(s) 
(for example, but* to search only the files whose names start with "but").  You 
can specify several masks separating them by a comma.  Note that you 
should not type extensions because you can change the mask for the 
highlighted format only. 

 
Clears the mask(s) set for searching through the files of the format highlighted 
in the list.  In this case, all files of the corresponding format will be searched. 

 
Selects all of the file formats in the list.  In this case, files of all types will be 
searched through.  The masks specified for the formats will be taken into 
account. 

 
Clears all of the check boxes. 

Note For PDF format, you can search through the files created by means of 
ACD/ChemSketch only—all other files are ignored. 
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3.12.25.2 Search Options Dialog Box: General Tab— 
Commercial version only! 

In this dialog box, you can define the preferences for searching. 

To display this dialog box, in the ACD/Search for Structure window, click Options  
(for more information, refer to Section 3.12.25). 

 
The General tab contains the following options: 

Option Description 
Exact Search If this option is selected, the specified files will be searched through for the 

presence of the search pattern as a standalone structure. 

Substructure Search If this option is selected, the program treats the currently displayed 
structure(s) as (a) substructure(s) and finds all structures containing the 
structure(s) as their structural fragment(s).  Note that you can use the Query 
Atom and Query Bond tools to define the structure to be found (for more 
information, refer to Section 3.7.1–3.7.2). 

Similarity Search If this option is selected, the specified files will be searched through for the 
structure similar to that displayed in the Search Pattern box of the 
ACD/Search for Structure window.  The options for the structures similarity 
can be specified by clicking Options; you can choose among the following 
similarity coefficients: 
Tanimoto 
Dice 
Cosine 
Based on Hamming Distance 
Based on Euclidean Distance 
For more information on these coefficients, refer to Section 3.12.25.4. 
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Option Description 
Prompt to Save Changes If this check box is selected, each time you close the ACD/Search for 

Structure window, the program prompts you to save the results of search to 
an .SSF file if you have not done so. 

Search Within File If you select the Until First Occurrence option, the program will stop 
searching within a specific file as soon as at least one matching structure is 
found in this file, and then the program will proceed with searching through 
the next file. 
If the All Occurrences option is selected, the program will find all 
occurrences of the query structure in each file and will display each found 
structure as a separate string in the Search Results box. 

Preview Cache Size To speed up the display of the found structures, the pages displayed last in 
the Preview box are stored in cache and if you later view the same page, its 
display is taken from cache.  In this box, you can specify the number of 
pages to be stored in cache. 

3.12.25.3 Search Options Dialog Box: Open Tab— 
Commercial version only! 

In this dialog box, you can define the preferences for searching. 

To display this dialog box, in the ACD/Search for Structure window, click Options  
(for more information, refer to Section 3.12.25). 

 
The Open tab contains the following options: 

Option Description 
List of Formats Displays the file formats that are currently supported by ACD/ChemSketch.  When you 

click one of the formats in the list, the Action area is changed accordingly to show 
which program will open the found files. 
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Option Description 
Action In this area, specify which program should be used to open files of the selected format: 

If the Start Associated Program option is selected, the files of the selected format will 
be opened in the program currently associated with that format in the Windows system. 
If the Start Another Program option is selected, you can specify the program (EXE 
file) that should be used to open the corresponding files (this does not affect the 
Windows file registration settings). 
If the Open in ChemSketch option is selected, the found structure will be placed into 
the workspace of the ChemSketch window. 

3.12.25.4 Similarity Search Options Dialog Box—Commercial version only! 

This dialog box allows you to specify settings for searching structures according to a structure 
similar to a target one (that is currently displayed in the ChemSketch window). 

This dialog box appears when you click Options  in the Search Options dialog box. 

 
This dialog box contains the following options: 

Option Description 
Select Similarity 
Coefficient 

Displays the list of similarity coefficients that can be applied during the 
similarity search.  To apply the desired coefficient, select its check box. 

Show with Coefficient >= In this box, specify the similarity coefficient that will serve as a filter for the 
found structures.  During the similarity search, the program generates a 
similarity coefficient for each structure; the structures having coefficients 
more than or equal to the value specified in this box will be announced as 
hits for your query. 

3.12.26 Calculate > “Property Name” / All Properties 

This set of commands allows you to calculate one or all of the properties for the currently 
selected structure or fragment.  The following properties are available: 

• Molecular formula 
• Formula weight 
• Composition 
• Molar refractivity 
• Molar volume 
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• Parachor 
• Index of refraction 
• Surface tension 
• Density 
• Dielectric constant 
• Polarizability 
• Monoisotopic, nominal and average mass 

For more details on each property, refer to Appendix B. 

As you choose one of the commands, the corresponding property is calculated for the structure 
and the Calculation Results dialog box appears displaying the data.  To copy the results to the 
ChemSketch window near the structure, click Copy to Editor. 

Note If there are several structures drawn in the workspace and none is selected, the 
properties are calculated for all of these structures (treating them as one composite 
structure), if possible.  If it is impossible to calculate a property, it is labeled as "Not 
available". 

If you choose the All Properties command, the results are represented as a set of rows.  You 
can select the properties to be placed by the structure: holding down CTRL, click the desired 
properties to select them, and then click Copy to Editor.  Clicking Cancel will close the dialog 
box without copying the results to the workspace. 

Tip You can choose one of the properties to be instantly displayed on the status bar for 
the selected structure (for more information, refer to Section 2.6). 

3.12.27 Calculate > Select Properties to Calculate 

This command allows you to define the properties to be calculated when you choose the 
Calculate > Selected Properties command from the Tools menu. 

As you choose this command, the Select Properties to Calculate dialog box appears: 
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This dialog box contains the following options: 

Option Description 

Properties Lists the available properties.  To define the properties to be calculated, select 
the check boxes adjacent to the required properties. 

 
Selects all of the properties in the list. 

 
Clears the check boxes of all the properties in the list. 

3.12.28 Calculate > Selected Properties 

This command calculates the properties selected in the Select Properties to Calculate dialog 
box (for more information, refer to the previous sections). 

3.13 Templates Menu 

The commands located on this menu allow you to insert predefined, standard structures and 
graphical objects into your drawing and/or to create your own templates of commonly used 
structures or graphical objects. 

3.13.1 Template Window 

This command allows you to place any template unit into the ChemSketch page.  Templates can 
contain structures and structural fragments as well as graphical objects. 

Choosing this command displays the Template Window dialog box that shows the contents of 
available templates, either standard (built-in) or custom (user-defined). 
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This dialog box contains the following options: 

Option Description 

 
Allows you to choose either the Draw or Structure mode.  This mode will 
be active when you place the selected template on the ChemSketch 
page. 

 
This box contains templates listed in the Template Organizer (for more 
information, refer to Section 3.13.2).  To load a template, select it from 
the list. 

 
In this box, you can choose the desired page of a multi-page template. 

 Allow you to move from page to page within the multi-page template. 

 
Displays the User Template Window Organizer dialog box where you 
can manage templates (for more information, refer to Section 3.13.2). 

Template Tabs The upper part displays the list of ''fixed'' templates, i.e., templates whose 
names are displayed in the Template Window dialog box every time you 
open it.  You can specify your own ''fixed'' templates using the User 
Template Window Organizer dialog box (for more information, refer to 
Section 3.13.2).  
The lower part displays the list of templates that have been recently 
chosen from the list of available templates at the top of the window.  If 
you use some templates frequently and want them to be present in the 
Template Window dialog box every time you open it, you can place 
them into the "fixed" list above by selecting the template names in the 
User Template Window Organizer dialog box. 

Preview  Displays the contents of the template currently selected in the list. 
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To insert a template: 

1. Click Structure  or Draw  in the Template Window dialog box to indicate 
which mode is to be active when you place the selected template on the ChemSketch page. 

2. From the left row of tabs or from the drop-down list at the top, choose a template.  The 
contents of the template appear.  If there is more than one page in a template, you can switch 
from page to page using  and . 

3. Click a template item.  The program switches to the ChemSketch window in the Structure or 
Draw mode (depending on which button you have selected) with a template attached to the 
cursor.  Note that an outline view of the template item is attached to your cursor. 

Note If you are going to use a template of a chemical structure to attach it to the already 
drawn structure, make sure that you select the template by clicking the most 
suitable atom or bond.  For example, if you are going to insert a structure fused 
with a specific bond, select the corresponding template by clicking the bond (not 
the atom). 

4. Click in the workspace to paste the copied template item.  (Note that if the item is a structure 
or fragment, it attempts to attach itself to the appropriate location as you move it over the 
workspace; simply click to place it at the insertion point.)  Every time you click, you place 
another copy of the item on the workspace. 

5. To cancel, choose any button on the toolbar or right-click in the workspace. 

Note You can flip the template shadow by pressing TAB. 
 
When inserting template of a chemical structure, if you click an atom of the drawn 
structure holding down SHIFT, the atom of the template will replace the atom you 
click (template will be attached without a bond). 

Shortcuts: 

Keyboard:  F5 

General toolbar:  
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3.13.2 Template Organizer 

This command displays the User Template Window Organizer dialog box, which allows you to 
manage the standard (built-in) and custom (user-defined) templates.  Using this dialog box you 
can create a template, change the name of the file associated with a template, and remove, 
rename, and modify the template’s contents. 

 
This dialog box contains the following options: 

Option Description 

Templates Displays the list of the available templates.  To see the list of all the 
templates (both standard and user’s), select the All option.  The templates 
with selected check boxes are included into the list of ''fixed'' templates in the 
Template Window dialog box, i.e., templates whose names are displayed in 
this dialog box every time you switch to it.  Note that only ten templates can 
be placed as ''fixed'' at a time.  To include the template into the Template 
Window dialog box, click any tick and then click the box corresponding to 
the required template. 

Standard / User / All Options of this box allow you to switch between the lists of Standard (built-
in), User (added by the user), and All templates. 

Fixed / Available Displays the number of templates placed to the Template Window dialog 
box (Fixed) and the number of templates which can be added thereto 
(Available).  Note that there can be up to 10 ''fixed'' templates placed to the 
Template Window dialog box at a time. 

 
Displays the Create User Template dialog box where you can choose a file 
to be saved as a user template and specify the template name.  As you click 
OK, the template will be added to the Template box. 
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Option Description 

 
Choose the template from the list and click this button to display the Modify 
Template dialog box.  In this dialog box, you can edit the template name and 
a file serving as a template. 

 
Removes the highlighted template from the list.  Note that this removes only 
the reference to the corresponding .SK2 file, but not the file itself. 

 
This button loads an .SK2 file associated with the highlighted template into 
the ChemSketch page for editing. 

 Displays the location of a document associated with the template highlighted 
in the list. 

Note that the only difference between the template file and a usual file is the fact that you can find 
the template file in the User Template Window Organizer dialog box.  In fact, it is the same as a 
usual document with the extension .SK2.  By saving files this way there are several advantages: 

• Your .SK2 files scattered over different locations will be gathered in the Template Window 
Organizer. 

• You can assign a name to the template that is more descriptive than what the real file 
name is.  This will better reflect the contents of the document and allow you to find the 
document quickly.  Besides, you can quickly find the document by previewing its contents 
in the preview field of the Template Window. 

3.13.3 Save User Template 

This command allows you to save the current ACD/ChemSketch document as a user template.  If 
your document has not been saved before, the Save Document As dialog box appears.  As 
soon as you save your document, the Save User Template dialog box appears where you 
should specify the name for your template to be associated with your document. 

As soon as the document is saved as a template, its contents becomes available in the Template 
Window dialog box as an additional tab and in the Template Organizer dialog box in the list of 
user templates (for more information, refer to Sections 3.13.1 and 3.13.2, respectively). 
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3.13.4 Table of Radicals 

This command displays the Table of Radicals containing the most frequently needed radicals for 
a quick structure drawing. 

Preview area

 
When you point to a radical, information about it appears in the Preview area.  Note that the "R" 
in the radical structure denotes the position of attachment to other structures in the drawing area. 

To choose a radical for drawing, click the required radical button.  The Table of Radicals will be 
closed and a shadow will be attached to the cursor.  Click in the empty space to insert a non-
bonded structure of the chosen radical or click any atom to link it up to the chosen radical.  To 
replace any atom of the drawn structure with the atom of the radical (i.e., the radical will be 
attached without a bond), click the corresponding atom holding down SHIFT when inserting the 
radical structure. 

You can flip the radical shadow by pressing TAB.  You can use the radical shadow as many 
times as you want until you click with the right mouse button to cancel this mode. 

When a radical is chosen from the Table of Radicals, its corresponding button is automatically 
added to the References toolbar (for more information, refer to Section 3.8).  To remove the 
radicals from the References toolbar, double-click an empty space on the toolbar. 

Shortcuts: 

Keyboard:  F6 

References toolbar:  
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3.13.5 Periodic Table 

This command displays the Periodic Table of Elements dialog box. This dialog box allows you 
to choose a new element for drawing and view the detailed information (symbol, name, atomic 
number, density, mass, typical valence or oxidation states and electron configuration) on it. 

Note that depending on the state of the Change Navigation Mode button the work with this 
dialog box is slightly different: 

 State of the Change Navigation Mode button 

Action pulled position ( ) pushed position ( ) 

To highlight an element and display the photo 
and detailed information about it 

point to the desired element click the desired element 

To be able to insert the selected element into 
the workspace 

click the desired element click OK 

You can do one of the following with the chosen element: 
• Click an empty space to insert the atom at the insertion point. 
• Point to any atom in the workspace and drag it to an empty place on the screen.  A new 

bond appears with the chosen atom at the end. 

• With the Draw Normal tool  (for more information, refer to Section 3.6.5), click any 
atom in the drawing area to replace it with the chosen atom. 

• With the Draw Continuous tool  (for more information, refer to Section 3.6.6), double-
click an atom to sprout a new single bond with the chosen atom. 

Periodic Table of Elements contains images of all stable chemical elements in their natural form. 
To display the photo of an element, in the Periodic Table of Elements, click Show Photos of 
an Element , and then point to or click the required element (depending on the position of the 
Change Navigation Mode button) 

Tip To keep the photo of an element upon all of the windows, the Always on Top button 
should be in pushed position . 

Periodic Table of Elements is expanded with tabs that include the following data: 
• General tab: general data about an element; 
• NMR tab: isotope, spin number, abundance, magnetic moment, magnetogyric ratio, 

quadrupole moment, frequency, and receptivity; 
• Mass tab: isotope, abundance, and exact mass; 
• Coloration tab: options allowing you to apply the coloration of four different schemes 

(Classic, Aggregative States, Metals/Non-metals, or Radioactivity) or discard the coloration 
at all. 

If the tabs are not visible, click Show/Hide Extra Data .  The tabs are displayed by default. 

When an atom is taken from the Periodic Table of Elements dialog box, its button is 
automatically added on the Atoms toolbar (for more information, refer to Section 3.7).  To remove 
the user-selected atoms from the Atoms toolbar and return to the original default set, double-click 
an empty space on the toolbar, and then click Yes in the message that appears. 
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Note For non-metals, the inserted atom appears in its lowest valence state as a hydride 
derivative, whereas for metals, the inserted atom appears in its lowest oxidation 
state as an ion. 

Shortcuts: 

Keyboard:  F7 

Atoms toolbar:   

3.13.6 Dictionary—Commercial version only! 

This command displays the ACD/Dictionary dialog box. 

 
ACD/Dictionary is a program from ACD/Labs which allows you to find chemical structures 
according to their systematic or non-systematic names (as well as according to the parts of 
name), therapeutic category or inhibited enzymes, and registry numbers.  You can copy these 
structures to other ACD/Labs programs and to Windows applications. 

If there is structure(s) drawn or selected in the workspace and the Auto Search Structure option 
is marked with a tick, choosing this command will display the dialog box asking for whether you 
want to search for the drawn structure in the dictionary. 

Note The ACD/Dictionary module is only included in the commercial version of 
ACD/ChemSketch and is not available with the freeware. 
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For more details on the functionality of the ACD/Dictionary, refer to ACD/Dictionary User’s Guide 
located in the ACD/Labs documentation folder (\\DOCS\DICT.PDF). 

Shortcuts: 

Keyboard:  F8 

References toolbar:  

3.14 Options Menu 

These menu commands allow you to set on-screen viewing options: adjust the view of the cursor, 
border, on-screen grid, and color palette.  They also allow you to change angles, bond length, 
and 3D optimization features. 

3.14.1 Preferences 

This command displays the Preferences dialog box where you can set preferences for 
functionality in ACD/ChemSketch. 

3.14.1.1 Preferences Dialog Box: General Tab 

On this tab, you can define settings common for both Structure and Draw mode: 
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This tab contains the following options: 

Option Description 

View In this area, you can specify the objects to be displayed: 
The Ruler check box switches on/off the display of the ruler.  The rulers are useful for 
determining the size and position of objects. 
The RSS check box switches on/off the display of the RSS News bar.  For more 
information on the RSS options, refer to Section 2.5.1. 
The Guides check box switches on/off the display of the guides that appears on each 
ruler indicating the position of the cursor.  Note that this option is available if the Ruler 
check box is selected. 
The Palette check box switches on/off the display of the Color palette (refer to Section 
2.4). 
In the Measurement Units box, specify the units to be used for measurements in all 
dialog boxes. 

Borders Select the Printable Area check box to display the dotted lines showing the borders of 
the printable area.  Note that the margins of the printable area vary depending on the 
printer. 
Select the Page Margins check box to display the dotted lines showing the margins of 
the page.  You can set the margins in the Page Setup dialog box (File menu). 

Highlight Color In this box, you can specify the color to be used for highlighting when you point to 
structure elements and drawing objects. 

Grid Allows you to specify the way the grid should be arranged: 
 in the form of rectangles 

 
 

vertically hexagonally 
 

 

horizontally hexagonally 
 

 

Visible This check box controls whether to show or hide the grid.  This is also controlled by the 
Show Grid command (Options menu). 

Snap on Grid If this check box is selected, objects "stick to" (become automatically aligned with) the 
grid (either visible or not) when you move or create them.  This is also controlled by the 
Snap On Grid command (Options menu).  Note that if this option is enabled, the 
Fixed Bond Length and Bond Angle features (Structure tab) are ignored. 

Horizontal Step / 
Vertical Step 

In the Horizontal Step box, you can specify the horizontal distance* between the grid 
points of the rectangular or horizontally hexagonal grid.  In the Vertical Step box, you 
can specify the vertical distance between points for rectangular or vertically hexagonal 
grid.* 

Keep Draw Tool 
Active 

If this check box is selected, any of the drawing tools from the Drawing toolbar (except 

the Text tool ) remains enabled until you click or right-click in the workspace.  If this 

check box is cleared, the Select/Move/Resize tool  becomes active every time 
after you have used a tool. 

Informative 
Cursor 

Controls whether to show or hide the informative cursor.  This is a cursor showing the 
percentage of resizing, the new object’s coordinates when moving and rotating, the 
number of atoms in the chain when drawing the atom chains, etc. 

Use 
Antialiasing—
New to 11.0! 

Select this check box to automatically remove the aliasing of drawn lines and curves. 

Directories In this area, you can specify the name of folders where some configuration information 
will be stored. 
In the Private box, you can specify the folder for recording the configuration of 
ChemSketch program (TEMPLATE.CFG and QRSTYLES.STL files). 
In the Default box, you can specify the folder which you want to become current for the 
first time when you open the Save As, Open, Import, or Export dialog boxes in the 
current work session. 
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3.14.1.2 Preferences Dialog Box: Structure Tab 

On the Structure tab, you can define the preferences for the structures’ display and drawing. 

 
This tab contains the following options: 

Option Description 

Fixed In the Fixed area, you can control the structure drawing. 
If the Bond Angle check box is selected, you will be able to draw bonds at 
an angle multiple to 15°.  
If the Bond Length check box is selected, you will be able to draw bonds 
of a length multiple to the value specified in the adjacent box. 
If you find any of these check boxes unavailable, it can mean that the Snap 
on Grid check box is selected on the General tab of this dialog box.  To 
make the check boxes in the Fixed area available, clear the Snap on Grid 
check box. 

Action Center Select this check box to view the special sign showing the center of 

rotation or resizing when you use the Select/Rotate/Resize  tool.  This 
will help you see the point relative to which the objects are resized or 
rotated. 

Template Shadow If this check box is selected, the shadow of the template structure will be 
displayed near the cursor when you use the Instant Template tool or use 
templates from the Table of Radicals or Template Window. 

Hidden Atoms If this check box is selected, the hidden atoms will be displayed when you 
point to them on the structure. 

Proportional Resize If this check box is selected, the atom labels are resized in proportion to 
the bonds when the structure is resized.  If it is not, the atom labels remain 
unchanged when the structure is resized. 
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Option Description 

Wireframe 3D Rotation If this check box is selected, all of the bonds, single as well as the others, 
will be viewed as single bonds while 3D-rotating.  If you want to view the 
structure as it was drawn (with all bond types remaining unchanged) while 
3D-rotating, clear this check box. 

Select Graphics If this check box is selected, in the Structure mode, it is possible to select, 
move, and resize objects created in the Draw mode (text, shapes, arrows, 
etc.), as well as reaction pluses and arrows.  If this check box is cleared, 
you can only manipulate structures in the Structure mode. 

Auto-Select Bonds If this check box is selected, as you hold down SHIFT and click two atoms 

or bonds with the Select/Move  or Select/Rotate/Resize  tool 
active, the bond between them is also selected. 
If this check box is cleared, you can select atoms or bonds by holding 
down SHIFT and clicking them separately (so that it is possible to leave a 
bond unselected if its neighbors are selected).  Besides, if you hold down 
SHIFT and click a selected bond, the neighbors remain selected. 

Auto-Stick Atoms Select this check box if you want atoms or bonds to be automatically stuck 
either in the Move or Template modes (refer to Sections 3.6.1and 3.6.26), 
or when you paste a structure from the Clipboard.  Note that one atom 
sticks to the cursor in any mode.  The mode is inverted by pressing CTRL 
and vice versa. 

Bond Intersections In the Bond Intersection area, you can control the intersection point of 
bonds.  If you select the Enable check box, ACD/ChemSketch 
automatically makes a kind of gap in the background bond (drawn first of 
the two intersecting bonds).  You can specify the size of a gap in the 
background bond in the White Space box. 

3D-Optimization In this area, select the Switch to 3D-Rotation Mode check box if you want 

the 3D Rotation tool  (refer to Section 3.6.3) to be automatically 
enabled after the 3D optimization is complete. 
Select the Add Hydrogens check box if you want the hydrogens to be 
added to the structure after the 3D optimization is complete. 
For more details on the 3D Optimization tool, refer to Section 3.12.4. 

Markush Shadow In this area, you can adjust the options for Markush bonds.  These options 
are especially useful if some of the atoms in a structure participate in two 
or three Markush bindings.  You can select the color and shading for atoms 
participating in a primary (created first), secondary (created second), and 
tertiary (created third) Markush binding. 
To make the Markush shadow available in other ACD/Labs software, e.g., 
in all databases, select the Show in Other ACD Software check box. 
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Option Description 

Keep Stereo Configuration 
on 

In this area, select the Clean check box to keep the configuration of stereo 
centers unchanged when applying the Clean Structure command. 
For example: 

 
Select the Flips check box to keep the configuration of stereo centers 
unchanged when using the Flip on Bond, Flip Top to Bottom, or Flip 
Left to Right tools.  For example, when you apply the Flip Left to Right 
tool, the following result will be obtained: 

 
Auto/Manual Numbering 
Color 

In this box, you can specify the color of atom numbers inserted either 
manually or automatically.  For the details on atom numbering, refer to 
Sections 3.12.14 and 3.7.8. 
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3.14.1.3 Preferences Dialog Box: Reaction Tab 

On the Reaction tab, you can customize the appearance of reaction elements. 

 
This tab contains the following options: 

Option Description 

Character In this area, you can specify the text style for reaction pluses (for more 
information, refer to Section 3.6.14). 

Pen In this area, you can set the view for lines in the reaction arrows (refer to Section 
3.6.15).  Choose the required style, width, and color from the corresponding 
boxes. 

Arrowhead Size In this area, you can set the view of arrowheads in the reaction arrows (refer to 
Section 3.6.15).  You can specify the arrowhead width and height either by 
clicking/dragging in the preview area or by specifying the values in the W (width) 
and H (height) boxes. 

Double In this area, you can specify the space between the lines of a double reaction 
arrow.  Choose the required sample in the Interval box. 

Standard In this area, you can set the default length of a reaction arrow.  Type the 
required value in the Length box. 

Manual Mapping Color In this box, you can select the appropriate color for manual mapping atom 
numbers (inserted using the Atom-Atom Map tool (refer to Section 3.6.18), 
Manual mode). 
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3.14.1.4 Preferences Dialog Box: Clean Tab 

On the Clean tab, you can specify what method to use when applying the Clean Structure 
command. 

 
You can choose the required method of structure representation by selecting the corresponding 
check boxes.  If you select several check boxes, all of them will be applied one after another 

every time you click Clean Structure  on the Structure toolbar, or choose the Clean 
Structure command from the Tools menu.  For more information on this command, refer to 
Section 3.12.2. 

If the Use Template Library check box is selected, the standard representation of atoms in 
polycyclic structures is applied. 

As an example of clean methods, the structure of adamantane is given: 

Clean Method Structure Representation 

Default Method without Template Library 

 
Default Method with Template Library 

 
Method 2 

 
Method 3 
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3.14.2 Show Grid 

This command allows you to display or hide grid lines in the workspace. 

Note To change the grid density and type, use the Preferences dialog box options (for 
more information, refer to Section 3.14.1.1). 

Shortcut: 

Keyboard: CTRL+W 

3.14.3 Snap on Grid 

This command allows you to toggle the possibility to align objects according to the grid when 
moving objects or creating new ones.  Note that the grid can be enabled even if the grid lines are 
hidden. 

Note To change the grid density and type, use the Preferences dialog box options. 

Shortcut: 

Keyboard: CTRL+Q 

3.14.4 Show Palette 

This command allows you to switch on/off the display of the Color palette below the workspace.  
For more information on the Color palette options, refer to Section 2.4. 

3.14.5 Show RSS 

This command allows you to switch on/off the display of the RSS News bar.  For more 
information on the RSS options, refer to Section 2.5.1. 

Alternatively, you can switch on/off the display of the RSS News bar by selecting/clearing the 
RSS check box in the Preferences dialog box (General tab). 

Note You can hide RSS News bar in Commercial version only! 

3.14.6 Set Structure Drawing Style Submenu 

The commands on this submenu allow you to apply one of the available styles as default for 
drawing structures.  The list of styles contains both the built-in journal styles and the user-defined 
styles.  When choosing the required style, the message appears asking you whether or not you 
want to apply this style to drawn structures.  If you click Yes, the selected style will be applied to 
all drawn structures on the active page, and to all structures that will be drawn afterwards on 
other pages and documents.  If you click No, the already drawn structures will preserve their 
current view, and the selected style will be applied to the structures that will be drawn afterwards. 

Note You can define your own styles using the Properties panel (for more information, 
refer to Section 3.12.1). 

3.14.7 Add-On Organizer 

This command allows you to display the Add-On Organizer dialog box where you can specify 
the supplementary applications (add-ons) that are to be used to enhance the program's 
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possibilities.  The add-ons can be created by third-party developers and then added to the 
ACD/Labs software to enlarge its possibilities. 

 
The dialog box contains the following options: 

Option Description 

List of add-ons This box lists supplementary applications that can be used to enhance the 
program's possibilities.  To edit the list, use the buttons to the right. 
Select the check boxes of those add-ons that are to be added to the Add-Ons 
menu and/or Top toolbar (if this is specified in the add-on's properties).  To 
select/deselect all add-ons, right-click within the box, and then from the 
shortcut menu that appears, choose the corresponding command.  Note that 
by default all of the commands are selected. 
The application of any add-on can be specified while its creation. 

 
Displays the Open dialog box where you can specify the name and location of 
an ADDON file (.ADDON) that is to be added to the list. 

 
Displays the dialog box where you can edit the properties of the add-on 
selected in the list. 

 
Removes the add-on selected in the list. 

Add-on location This box displays the location of the add-on currently selected in the list. 

Add-on description In this box, view the description of the add-on selected in the list above. 
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3.14.8 ChemBasic Organizer 

This command allows you to manage programs written in ACD/ChemBasic (a special 
programming language that enables the user to customize ACD/Labs software).  Choosing this 
command displays the ChemBasic Organizer dialog box where you can add ChemBasic 
programs to be run from the ChemSketch window, create a shortcut button for each program, 
and attach a hint to each button. 

 
This dialog box contains the following options: 

Option Description 

Installed Programs Displays a list of installed ChemBasic programs.  To install/uninstall programs, 
use the button to the right of this list.  To add shortcut buttons of the 
corresponding programs to the ChemSketch toolbar, select their check boxes. 

 
This button allows you to install a ChemBasic program and add its name to the 
list.  Clicking this button displays the ChemBasic Program dialog box where 
you can specify the program, its shortcut button, and hint.  For more information, 
refer to Section 3.14.8.1. 

 
This button allows you to modify the name, shortcut, or location of the program 
currently highlighted in the list.  Clicking this button displays the ChemBasic 
Program dialog box.  For more information, refer to Section 3.14.8.1. 

 
Deletes the currently highlighted program from the list and uninstalls the 
corresponding .BAS file. 
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3.14.8.1 ChemBasic Program Dialog Box 

In this dialog box, you can define some options for running the selected ChemBasic program. 

This dialog box appears when, in the ChemBasic Organizer dialog box, you click either the 
Modify or New button.   

 
This dialog box contains the following options: 

Option Description 

Name In the Name area, specify the text that will appear as a yellow hint when you point to the 
button specified for the ChemBasic program. 

File  In the File area, specify the name and location of a ChemBasic program to be installed. 

Toolbar In the Toolbar area, specify the toolbar to which the shortcut button should be placed: 

• General toolbar (refer to Section 3.5); 

• Additional ChemBasic toolbar (that will appear between the General and 
Structure toolbars); or 

• Structure toolbar (refer to Section 3.6). 

Bitmap File In the Bitmap File area, specify the name and location of a bitmap file (.BMP) to be 
used as a shortcut button for the ChemBasic program specified above.  If you do not 
have a button image for the program, you can use the Run ChemBasic command 
(refer to Section 3.9.9) for running programs having no shortcut buttons. 
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3.15 Documents Menu 

The commands located on this menu allow you to switch between the open documents or to 
close all of the open documents at once. 

This menu also contains a list of currently open documents.  Click a document’s name to make it 
the active document.  Note that you may only have one document visible at a time—you cannot 
tile or cascade multiple document windows. 

Note You can have up to ten documents open at once. 

3.15.1 Next 

This command displays the next document from the Open Document list as the active document.  
Note that you may have only one document visible at a time—you cannot tile or cascade multiple 
document windows. 

Note If only one document is open, the Next function is inactive. 

Shortcut: 

Keyboard: CTRL+TAB 

3.15.2 Previous 

This command displays the previous document from the Open Document list as the active 
document.  Note that you may only have one document visible at a time—you cannot tile or 
cascade multiple document windows. 

Note If only one document is open, the Previous function is inactive. 

Shortcut: 

Keyboard: CTRL+SHIFT+TAB 

3.15.3 Close All 

This command closes all of the open documents.  After closing the documents, 
ACD/ChemSketch automatically displays a ''noname'' document. 

Note While closing unsaved documents, ACD/ChemSketch prompts you to save your 
work if you've not already done so. 

3.16 Add-Ons Menu 

This menu contains commands of the installed add-on applications that can be used to enhance 
the program possibilities (the add-ons can be created by the third-party developers). 

You can install the supplementary applications through the Add-on Organizer dialog box (for 
more information on this dialog box, refer to Section 3.14.7). 
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3.17 ACD/Labs Online (I-Lab) 

ACD/Labs Online (I-Lab or Interactive Laboratory) is an Internet-based service that allows you to: 
• Use ACD/ChemSketch chemical drawing and import capabilities to enable structural input for 

the I-Lab; 
• View predicted or stored CNMR and HNMR spectra (using HNMR or CNMR Viewers included 

with the Add-on); 
• Browse databases: CNMR, HNMR, FNMR, PNMR, and NNMR; 
• Attach the generated chemical names to your structures (IUPAC Name, CAS Index Name, 

and Name to Structure are available); 
• Review and save physicochemical properties (Boiling Point, LogP, LogD, pKa, H(vap), Vapor 

Pressure, Aqueous Solubility, BCF, and Adsorption Coefficient); and 
• Browse physicochemical databases from the ChemSketch interface. 

Depending on the server URL set in the ACD/I-Lab Options, you can login to Public I-Lab or I-
Lab: Intranet Edition.  

Public I-Lab: ACD/I-Lab includes free and fee-based services.  ACD/I-Lab registration and 
membership are free.  You do not have to pay anything if you only use the free services. 

I-Lab: Intranet Edition: You pay for the package rather than for each calculation.  The I-Lab: 
Intranet Edition package can include any set of the available services. 

In order to get access to ACD/I-Lab resources, you should have: 
• A direct Internet connection: 

• Public I-Lab: Access to http://www2.acdlabs.com address; 
• I-Lab: Intranet Edition: Access to the server where I-Lab: Intranet Edition is 

installed. 
• An e-mail address (for Public I-Lab only); 
• ChemSketch and I-Lab Add-on for ChemSketch: 

• Public I-Lab: Version 4.0 or later (there are both commercial and free versions 
available.  The free version can be downloaded from 
http://www.acdlabs.com/download); 

• I-Lab: Intranet Edition: Version 6.0 or later. 

As soon as you install ACD/ChemSketch and I-Lab Add-on and start up the program, you will see 
the standard ChemSketch interface with the additional I-Lab menu and the status bar whose left 
part is modified (the number of menu commands and status bar items is different depending on 
the server). 

For more detailed information on the functionality of the ACD/I-Lab add-on, refer to the separate 
ACD/I-Lab documentation. 

http://www2.acdlabs.com/�
http://www.acdlabs.com/download�
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3.18 ACD/Labs Menu 

This menu displays the list of ACD/Labs programs from one package currently installed on your 
computer. After you have installed the first ACD/Labs package, the program's name appears in 
this menu. 

Note If the ACD/Labs package is installed on the remote host, you should run any 
program just once to place its name into the list on your local computer. 

To load any program from the list, just click its name. ACD/ChemSketch is common for all 
ACD/Labs programs (except for the Batch versions) and is always loaded automatically.  

The list can contain programs from one package only.  If you have several packages of 
ACD/Labs software installed on your computer, then you will not be able to run programs from 
one package within another. 

3.18.1 Next Loaded 

If you have several ACD/Labs programs installed and currently open, this command switches you 
to another loaded program.  You may also use the SHIFT and ESC keys to switch between the 
loaded programs.  Press SHIFT and, without releasing it, press ESC.  Then, on the panel 
displaying currently loaded ACD/Labs programs, choose the required one by pressing ESC 
repeatedly and, when the desired program is selected, release SHIFT to switch to the chosen 
program. 

3.18.2 Close All 

This command closes all of the programs from the ACD/Labs package that are currently running.  
To close only one program, from the File menu, choose Exit, or, on the title bar, click Close . 

3.19 Help Menu 

The commands located on this menu allow you to obtain help on a required topic and to get more 
information about the company, software product, etc. 

3.19.1 Help Topics 

This command allows you to display the contents of the ACD/ChemSketch online Help. 

3.19.2 Using Help 

This command allows you to display instructions on how to use online Help. 

3.19.3 Tip of the Day 

This command displays the "Tip of the Day" help topics describing techniques and procedures 
more effectively. 
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3.19.4 Instructions for Authors 

This command displays the contents of the ''Instructions for Authors'' help topics. 

3.19.5 ChemBasic Help 

This command displays the ACD/ChemBasic online Help. 

ACD/ChemBasic is a special programming language that enables you to customize ACD/Labs 
software.  It can be downloaded for free from our Web site at http://www.acdlabs.com.  For 
more information about ACD/ChemBasic features, refer to the separate ACD/ChemBasic User’s 
Guide. 

3.19.6 Message Box Preferences 

This command allows you to display the Message Box Preferences dialog box where you can 
specify preferences concerning the Don't show/ask me again check boxes in program 
messages. 

Performing some operations within ACD/Labs software displays message boxes prompting you 
to do something or informing you of a particular condition. At the beginning, it is helpful to 
consider all the information that the program proposes you.  However, when a number of the 
same type of cases is treated, you might prefer "silent" mode.  For this purpose, in such message 
boxes, the Don't show me again or Don't ask me again check boxes are available; selecting 
them will not display the corresponding message boxes each time you perform a specific action. 

 
This dialog box contains the following options: 

Option Description 
Consider “Don’t show me again” Status 

Yes Select this option to obey the Don't show me again status in all the message boxes.  
In other words, the messages with the selected check boxes will be skipped and 
those with the cleared check boxes will be displayed. 

http://www.acdlabs.com/�
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Option Description 

Yes, Except for 
Today’s Choice 

Select this option to obey the Don't show me again status unless it was changed 
within the today’s calendar date. 
That is, the messages with the selected check boxes will be skipped and those with 
the cleared check boxes will be displayed; but the messages where the status of such 
check boxes was changed within the today’s calendar date will be displayed 
regardless of whether the Don't show me again check box is selected or not. 
Note that enabling this option does not change the status of check boxes but only 
ignores them. 

No (Show All 
Message Boxes) 

Select this option to ignore the settings for the Don't show me again status and 
display all the message boxes that occur. 
Note that enabling this option does not change the status of check boxes but only 
ignores them. 

Clear “Don’t show me again” Check Boxes 

 
Clears the Don't show me again check boxes only in the message boxes for which 
the status of such check boxes was changed within the today’s calendar date. 

 
Clears the Don't show me again check boxes everywhere thus allowing you to 
display all the message boxes that can occur. 

Important Changes in this dialog box will affect ALL of the ACD/Labs products within all 
the installed ACD/Labs packages (both network and local) for the current 
user. 

EXAMPLE 1. 

When you try to export a document containing some OLE object from the ChemSketch window to 
Adobe PDF file, the following message appears: "Current document contains OLE objects that 
cannot be exported to PDF document, so they will be skipped." 

If you do not want this reminder to be displayed when you do export, in the message, select the 
Don't show me again check box, and next time you export the document containing 
nonexportable OLE objects, this message will be skipped. 

But if you then decide that you should be aware of the OLE objects that cannot be exported, you 
can clear the Don't show me again option using the Message Box Preference dialog box. 

EXAMPLE 2. 

When you import an MDL molfile containing a structure of the size that the system may consider 
non-feasible, the Import Warning message box with the Yes and No choices appears asking 
you whether the imported structure should be resized or not. 

If you want the structure to be resized now and in all the later instances, in this message, select 
the Don’t ask me again check box and click Yes.  In this case, next time a structure of non-
feasible size is imported, it will be resized in a silent mode, without the message appearing, as if 
you have clicked Yes in that message box. 

If you want to keep the structure size now and in all the later instances, in this message, select 
the Don’t ask me again check box and click No.  In this case, next time the structure of non-
feasible size is imported, no message will appear and the structure won’t be resized, as if you 
have clicked No in that message box. 

And again, if you later decide that you want to choose manually whether the structures should be 
resized or not, you can use the required option or button in the Message Box Preferences 
dialog box to make the Import Warning message appear again by each import. 
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3.19.7 Documents 

This command allows you to display documentation (Reference Manual, Tutorial, User’s Guide) 
related to the current program. 

3.19.8 Visit ACD/Labs Web Site 

This command allows you to run your default Internet browser and goes to the ACD/Labs Web 
page at http://www.acdlabs.com/. 

3.19.9 Bug Report / Feature Request 

Depending on the option selected in the Bug Report Settings dialog box (refer to the 
subsequent section), this command allows you to submit a bug report and feature request either 
through the ACD/Labs Web site or by e-mail. 

3.19.10 Bug Report Settings 

This command displays the dialog box where you can choose the way you wish to submit bug 
reports and feature requests.  Note that in both cases you are supposed to fill in a form where 
you can report the problems you have encountered while working with ACD/Labs software or 
submit a request for a new feature to be included in any of the ACD/Labs products. 

The following two options are available: 

Option Description 
Go to the ACD/Labs Bug 
Report Page  

If you select this option, each time you choose the Bug Report / Feature 
Request command, your default Internet browser will be run and the 
ACD/Labs Web page (http://www.acdlabs.com/feedback/bugs.html) will be 
opened. 

Send E-mail to ACD/Labs 
Bug Processing Center  

If you select this option, each time you choose the Bug Report / Feature 
Request command, your default mail client will be activated.  The program 
will create a message according to the built-in template. 

3.19.11 About ACD/ChemSketch 

This command displays information about your copy of the ACD/Labs package, including the 
version number, the copyright, and your user registration information.  This also contains 
information on how to contact ACD/Labs. 

Moreover, by clicking the License ID button you can see your license ID number(s)—you will 
need the ID number(s) in case our technical support is required. 
 

http://www.acdlabs.com/�
http://www.acdlabs.com/feedback/bugs.html�
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4. Draw Mode 

4.1 Objectives 

This chapter describes in detail the options, tools and features available in the Draw mode.  You 
will be acquainted with the following: 

• The general capabilities of the Draw mode; 
• Draw mode interface at a glance, and 
• Detailed description of each command, tool, and interface part available in the Draw mode. 

To switch to the Draw mode, on the General toolbar, click Draw . 

4.2 General Information 

In the Draw mode, you can perform the following actions: 
• Draw graphical objects such as lines, arrows, rectangles, ellipses, arcs, polylines, and 

polygons, and insert callouts, brackets, and text labels. 
• Manipulate the objects: ungroup complex objects or group them into more complex objects, 

align, flip, rotate, resize, and fit objects to page dimensions. 
• Open, close, and print documents; cut, copy, and paste the required objects; delete and zoom 

objects.  You can also paste your work to the other Windows applications and insert the 
objects from other Windows applications into your work. 

• Create multi-page documents, rename and delete pages, insert new pages and organize all of 
the pages in a document. 

• Control the location of objects on the page with a ruler and gridlines.  You can choose 
different units of measurement for a ruler and insert or remove gridlines by using the Options 
menu commands. 
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4.3 Screen 

Below, you can see the screen with the Draw mode enabled.  The names and positions of the 
toolbars and the other elements, to be used throughout this manual, are introduced. 

Status bar

Title bar
Menu bar

General toolbar

Editing toolbar

Drawing 
toolbar

Color Palette

Workspace

RSS News bar

 
This table gives the short description of each interface element designated in the above picture: 

Interface Element Function 
Title bar This bar shows the name of the program, the name and location of the currently 

open file, and buttons controlling the size and position of the window (for more 
information on the title bar, refer to Section 2.3). 

Menu bar This bar contains a series of words.  Each word links to a list (‘menu’) of related 
commands for working in the ChemSketch window in the Draw mode (for a detailed 
description of each menu and the commands it contains, refer to Sections 4.8–
4.18). 

General toolbar This toolbar includes tools that are present in both Structure and Draw modes and 
will help you with tasks relevant to both modes such as: saving, opening files, 
undoing/redoing operations, copying and pasting, zooming in and out, as well as 
inserting various templates (for more information, refer to Section 3.5). 

ChemBasic toolbar This toolbar includes additional tools that extend the functionality of 
ACD/ChemSketch.  Note that the ChemBasic toolbar is present in both Structure 
and Draw modes if you have the Goodies tools previously installed (for more 
information, refer to Appendix C). 
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Interface Element Function 
Editing toolbar This toolbar is only present in the Draw mode.  It contains tools for changing the 

graphical attributes of objects in your workspace.  Note that you cannot edit 
chemical structures with the tools of the Editing toolbar (except resizing and rotating 
them).  For more information, refer to Section 4.6. 

Drawing toolbar This toolbar contains buttons used for creating graphical objects such as lines, 
rectangles, text boxes, etc. (for more information, refer to Section 4.7). 

Workspace The workspace is the current ChemSketch page where you can draw and edit the 
required objects (structures, reactions, pictures). 

Color Palette Allows you to quickly change the pen and fill color of the selected objects (for more 
information, refer to Section 2.4). 

Status bar This bar contains information that may be useful for the current moment: name of 
the opened .SK2 file, page number, molecular formula of the selected structure, etc.  
It also contains a button for automatic I-Lab access.  For more information, refer to 
Section 2.6. 

4.4 Menu Bar 

Right below the title bar, you will find the menu bar that contains the program menus.  By clicking 
the menus you can access the program commands. 

 
For detailed information on the commands that are available from the menus of the ChemSketch 
window in the Draw mode, refer to Sections 4.8–4.18. 

4.5 General Toolbar 

In both Structure and Draw modes, below the menu bar, the General toolbar is displayed. 

For more information on the buttons available on this toolbar, refer to Section 3.5. 

4.6 Editing Toolbar 

In the Draw mode, this toolbar is displayed below the General toolbar.  The Editing toolbar 
contains buttons for changing the graphical attributes of objects in your workspace.  Note that 
you cannot edit chemical structures with the tools of the Editing toolbar (except resizing and 
rotating them).  Use the Structure mode for structure editing. 

The Editing toolbar contains the following buttons: 

Button Function 

 
Allows you to select, move, and resize objects (for more information, refer to Section 4.6.1). 

 
Allows you to select, move, and rotate objects (for more information, refer to Section 4.6.2). 
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Button Function 

 
Allows you to change an object’s shape by editing (moving, adding, deleting) the object’s 
nodes.  As you click this button, the right part of the Editing toolbar is replaced with the Node 
toolbar.  For more information, refer to Section 4.6.3. 

 
Allows you to edit text.  As you click this button, the right part of the Editing toolbar is replaced 
with the Text toolbar.  For more information, refer to Section 4.6.4. 

 
Brings the selected background objects to the foreground (for more information, refer to 
Section 4.12.2). 

 
Sends the selected foreground objects to the background (for more information, refer to 
Section 4.12.3). 

 
Groups/ungroups the selected objects and allows you to place data into tables (for more 
information, refer to Section 4.12.1). 

 
Turns the selected object(s) about the vertical axis (for more information, refer to Section 
4.12.4). 

 
Turns the selected object(s) about the horizontal axis (for more information, refer to Section 
4.12.5). 

 
Rotates the selected object(s) by 90° (for more information, refer to Section 4.12.6). 

 
Aligns the selected objects horizontally to the left (for more information, refer to Section 
4.12.7). 

 
Aligns the selected objects horizontally to center (for more information, refer to Section 4.12.7). 

 
Aligns the selected objects horizontally to the right (for more information, refer to Section 
4.12.7). 

 
Aligns the selected objects vertically to the bottom (for more information, refer to Section 
4.12.8). 

 
Aligns the selected objects vertically to the center (for more information, refer to Section 
4.12.8). 

 
Aligns the selected objects vertically to the top (for more information, refer to Section 4.12.8). 

Note To customize the toolbar contents, right-click it to display the context menu (for 
more information, refer to Section 2.2.1). 

4.6.1 Select/Move/Resize Button 

This button  enables the Select/Move/Resize tool allowing you to select, move, and resize 
graphical objects created both in the Draw and Structure modes.  If you double-click the selected 
object with this tool active, you can change its style using the Objects Panel that appears (for 
more information, refer to Section 4.11.7). 

The table below summarizes the actions you should do to select objects: 

To Select Do This 

One object Click the object or drag around the object. 

Multiple objects Hold down SHIFT when selecting as described in the previous 
action. 

All the objects in the workspace Press CTRL+A.  Note that pressing CTRL+A again will deselect 
all of the objects. 
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The table below summarizes the actions you should do to move objects: 

To Move Do This 

Selected object(s) Point to the object so that the contour appears around it and 
drag. 

Selected object(s) leaving its copy 
behind 

Hold down CTRL while dragging. 

Selected object constraining the 
object’s movement 

Hold down SHIFT while moving; in this case, the movement of 
the selected object is constrained to the X or Y axis. 

Note If the Informative Cursor check box in the Preferences dialog box (General tab) 
is selected, the new object’s coordinates (relative to its original location) are 
displayed near the cursor. 

The table below summarizes the actions you should do to resize objects: 

To Resize Do This 
Selected object relative to its 
side or corner 

Point to the selection handle so that the cursor changes to a two-way 
arrow (  , ,  , or  ), and drag. 

Dragging the top / bottom side selection handles resizes the object’s 
height, dragging the left / right side handles—width; and dragging the 
corner handles resizes the object proportionally in all directions. 

Selected object relative to its 
center 

Hold down CTRL when dragging the selection handles as described 
above. 

Selected object proportionally 
to 5% of its size 

Hold down SHIFT when dragging the side selection handles as 
described above. 

Selected object so that the 
height and width change 
independently 

Hold down SHIFT when dragging the corner selection handles as 
described above. 

Note If the Informative cursor check box in the Preferences dialog box (General tab) 
is selected, the percentage of resizing will be displayed by the cursor. 

You can quickly switch between this tool and the Select/Move/Rotate  tool by right-clicking in 
the workspace or by clicking any selection handle. 

4.6.2 Select/Move/Rotate Button 

This button  enables the Select/Move/Rotate tool allowing you to select, move, and rotate 
objects created both in Draw and Structure modes.  If you double-click the selected object with 
this tool active, you can change its style using the Objects Panel that appears (for more 
information, refer to Section 4.11.7). 

The table below summarizes the actions you should do to select objects: 

To Select Do This 

One object Click the object or drag around the object. 

Multiple objects Hold down SHIFT when selecting as described in the previous 
action. 

All the objects in the workspace Press CTRL+A.  Note that pressing CTRL+A again will deselect 
all of the objects. 
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The table below summarizes the actions you should do to move objects: 

To Move Do This 

Selected object(s) Point to the object so that the contour appears around it and 
drag. 

Selected object(s) leaving its copy 
behind 

Hold down CTRL while dragging. 

Selected object constraining the 
object’s movement 

Hold down SHIFT while moving; in this case, the movement of 
the selected object is constrained to the X- or Y-axis. 

Note If the Informative Cursor check box in the Preferences dialog box (General tab) 
is selected, the new object’s coordinates (relative to its original location) are 
displayed near the cursor. 

The table below summarizes the actions you should do to rotate objects: 

To Rotate Do This 

Selected object around its 
center 

Point to the selection handle so that the cursor changes to  and 
drag. 

Selected object in 15 degree 
increments 

Hold down SHIFT when rotating as described in the previous action. 

Note If the Informative Cursor check box in the Preferences dialog box (General tab) 
is selected, the angle of rotation will be displayed by the cursor. 

You can quickly switch between this tool and the Select/Move/Resize  tool by clicking any 
selection handle or right-clicking in the workspace. 

4.6.3 Edit Nodes Button 

This button  enables the Edit Nodes tool allowing you to modify the shape of the following 
objects: lines, arcs, curves, arrows, polylines, rectangles, rounded rectangles, polygons, 
brackets, and callouts. 

When you click the Edit Nodes button, the Node toolbar replaces the right part of the Editing 
toolbar.  To edit an object, select it so that the nodes appear: 

 
Note Only one object can be selected at a time when the Edit Nodes tool is active. 
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The function of the Edit Nodes  tool varies depending on the type of object selected: 

Object Type Function 
Line/Arrow/Curve/Polygon/ 
Curved shape 

Changing the shape by moving nodes and control points and using the Node 
toolbar. 

Rectangle Rounding corners by moving nodes. 

Rounded Rectangle Changing the radius of corners by moving nodes. 

Arc Changing the length by moving nodes. 

Brackets/Callout Modifying the size and shape by moving nodes. 

Note Nodes—the points at the ends of line and curve segments in a curve object. 
Control points—the points extending from nodes along a curve object that 
determine the angle at which the curve passes through the node.  Control points 
appear when you select a node.  Nodes associated with straight lines do not have 
control points. 

                                    

4.6.3.1 Node Toolbar 

The Node toolbar appears when you click Edit Nodes  on the Editing toolbar and replaces 
the right part of the latter. 

It contains the following buttons for manipulating nodes and control points (for more information, 
refer to the previous section). 

Button Function 

 
Connect Vertices 

Connects end nodes of a selected free-form curve or broken line with a straight line. 

 
Disconnect Vertices 

Erases the segment between the two selected adjacent nodes. 

 
Add Node 

Adds a node between the two selected adjacent nodes. 
Each additional click on this button will add new nodes between the existing ones. 

 
Delete Nodes 

Deletes the selected nodes. 

 
Convert to Line 

Converts the selected curve or curved segment into a line.  If the segment is defined 
as a line, it has no control points and thus cannot be reshaped. 

 
Convert to Curve 

Converts the selected line segment into a curve.  Once the segment is defined as a 
curve, you can reshape it by manipulating its nodes and control points.  To see the 
control points, click the node. 
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Button Function 

 
Smooth 

Allows you to put a node and its both adjacent control points into line and move 
together with the node as you drag.  Release the Smooth button to disable this 
function. 

 

 
Symmet 

Equalizes the distances between the selected node and their adjacent control points.  
These distances will be changed equally while you drag a control point.  Release the 
Symmet button to disable this function. 

 

 
Align Left 

Aligns the selected nodes horizontally to the left—relative to each other. 

 
Center Horizontally 

Aligns the selected nodes horizontally to the center—relative to each other. 

 
Align Right 

Aligns the selected nodes horizontally to the right—relative to each other. 

 
Align Bottom 

Aligns the selected nodes vertically to the bottom—relative to each other. 

 
Center Vertically 

Aligns the selected nodes vertically to the center—relative to each other. 

 
Align Top 

Aligns the selected nodes vertically to the top—relative to each other. 

Note To select the required nodes, click them holding down SHIFT. 
 
If you do not need all of the buttons available on the toolbar, you can customize it.  
For more information, refer to Section 2.2.1. 

4.6.4 Edit Text Button 

This button  enables the Edit Text tool allowing you to enter and edit the text. 

With this tool enabled, click within the workspace to enter or edit the text.  Modify the text as 
desired using the Text toolbar buttons.  To leave the editing mode, click outside the text box. 

Optionally, you can use the Text  and Artistic Text  tools (for more information, refer to 
Section 4.7.11). 
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4.6.4.1 Text Toolbar 

The Text toolbar appears whenever you enter or modify text using either the Edit Text , Text 

, or Artistic Text  tool.  The Text toolbar replaces the right part of the Editing toolbar.  It 
contains the following buttons for formatting text: 

Button / Box Function 

 
In this box, you can specify the font style for the selected text or for the text to be 
typed. 

 
In this box, you can specify the font size for the selected text or for the text to be typed. 

 
Applies the bold formatting (e.g., text) to the selected text or to the text to be typed. 

 
Applies the italic formatting (e.g., text) to the selected text or to the text to be typed. 

 
Applies the underlined formatting (e.g., text) to the selected text or to the text to be 
typed. 

 
Applies the strikethrough formatting (e.g., text) to the selected text or to the text to be 
typed. 

 
Applies the superscript formatting (e.g., text) to the selected text or to the text to be 
typed. 

 
Applies the subscript formatting (e.g., text) to the selected text or to the text to be typed. 

 
Transforms characters of the selected text or the text to be typed to Greek symbols. 

 
Aligns the text to the left. 

 
Centers the text in the text box. 

 
Aligns the text to the right. 

 
Stretches the text so that it fills the whole lines between the left and right borders of a 
text box. 

 
Applies the default font style specified on the Font panel (refer to Section 4.11.4) to 
the selected text and/or applies the default paragraph style specified on the Paragraph 
panel (refer to Section 4.11.5) to the paragraph where the mouse pointer is currently 
located. 

 
Saves the current font and paragraph attributes as default. 

Note If you do not need all of the buttons available on the toolbar, you can customize it.  
For more information, refer to Section 2.2.1. 
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4.7 Drawing Toolbar 

In the Draw mode, this toolbar is displayed vertically to the left of the workspace.  It contains 
buttons for creating graphical objects such as lines, rectangles, text boxes, etc. 

Note To switch to the Select/Move/Resize mode, press ESC or, on the Editing 

toolbar, click Select/Move/Resize . 

The Drawing toolbar contains the following buttons: 

Button Function 

 
Allows you to draw straight lines (for more information, refer to Section 4.7.1). 

 
Allows you to draw arcs (for more information, refer to Section 4.7.2). 

 
Allows you to draw curves of a predefined shape (for more information, refer to Section 
4.7.3). 

 
Allows you to draw free-form curves and broken lines (for more information, refer to Section 
4.7.4). 

 
Allows you to draw arrows of different shape (for more information, refer to Section 4.7.5). 

 
Allows you to draw rectangles (for more information, refer to Section 4.7.6). 

 
Allows you to draw rectangles with rounded corners (for more information, refer to Section 
4.7.7). 

 
Allows you to draw ellipses and circles (for more information, refer to Section 4.7.8). 

 
Allows you to draw free-form shapes (for more information, refer to Section 4.7.9). 

 
Allows you to insert images (for more information, refer to Section 4.7.10). 

 
Allows you to insert text into the workspace (for more information, refer to Section 4.7.11). 

 
Allows you to draw table of specified size (for more information, refer to Section 4.7.12). 

 
Allows you to draw brackets of different types (for more information, refer to Section 4.7.13). 

 
Allows you to draw callouts (for more information, refer to Section 4.7.14). 

 
Allows you to create templates for ACD/SpecManager reports (for more information, refer to 
Section 4.7.15). 

Note The toolbar can be customized according to your preferences; for more 
information, refer to Section 2.2.1. 

4.7.1 Line Button 

This button  enables the Line tool allowing you to draw straight lines.  Click this button and 
drag in the workspace to draw a line.   

Holding down SHIFT while dragging draws the line at an angle multiple to 15°.   

Holding down CTRL while dragging draws the line centered at the starting position of the cursor. 
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Objects drawn with the Line  tool are automatically assigned the default attributes defined on 
the Pen style panel (refer to Section 4.11.1). 

Note To change the thickness, style, and color of a drawn line without affecting defaults, 
double-click the line and make the required settings on the Objects Panel that 
appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool becomes active immediately after you have drawn a line. 

4.7.2 Arc Buttons 

These buttons enable the set of tools allowing you to draw arcs.  Click the right bottom triangle of 
the button to expand it into the following buttons: 

 Arc 90° 

 Arc 120° 

 Arc 180° 

 Arc 240° 

 Arc 270° 

To draw an arc of the required size, click the corresponding Arc button and, as it becomes active, 
drag in the workspace.  The direction of your mouse drag determines the arc position. 

Tip To change the arc angle to any other value, use the Edit Nodes  tool (refer to 
Section 4.6.3). 

The default attributes defined on the Pen style panel (refer to Section 4.11.1) are automatically 
assigned to the objects drawn with the Arc tool. 

Note To change the thickness, style, and color of a drawn arc without affecting defaults, 
double-click the arc and make the required settings on the Objects Panel that 
appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool becomes active immediately after you have drawn an arc. 

4.7.3 Curve Button 

This button  enables the Curve tool allowing you to draw curves of a definite shape.  Click 
this button and drag in the workspace to draw a curve.   

Holding down SHIFT while dragging draws the curve at an angle multiple to 15°.   

Holding down CTRL while dragging draws the curve centered at the starting position of the 
cursor. 
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The default attributes defined on the Pen style panel (refer to Section 4.11.1) are automatically 
assigned to the objects drawn with the Curve tool. 

Note To change the thickness, style, and color of a drawn curve without affecting 
defaults, double-click the curve and make the required settings on the Objects 
Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool becomes active immediately after you have drawn a curve. 

4.7.4 Polyline Button 

This button  enables the Polyline tool allowing you to draw free-form curves 

and broken lines . 

To draw a broken line, click in the workspace several times with this tool active and right-click to 
finish drawing.  To draw a free-formed curve, use dragging in combination with clicking. 

Note You can edit the form of the drawn curve with the help of the Edit Nodes  tool. 

The default attributes defined on the Pen style panel (refer to Section 4.11.1) are automatically 
assigned to the objects drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the polyline and make the required settings on the Objects 
Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool becomes active immediately after you have drawn a polyline. 

4.7.5 Arrow Button 

This button  enables the Draw Arrow tool allowing you to draw arrows and apply arrowheads 
to any linear object (lines, arcs, curves, and polylines).  When you click this button, the Arrow 
style panel where you can specify arrow style appears.  For more information on the options on 
this panel, refer to Section 4.11.3. 

To draw an arrow, select any of the following tools: Line , Arc , Curve , or Polyline 

, then click Arrow  and drag in the workspace.  As you finish drawing, the arrowhead 
appears at the end of the object. 

To apply an arrowhead to the already drawn objects, select the object, choose this tool, and then 
in the Arrow style panel that appears, click Apply. 
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The default attributes defined on the Pen style panel and Arrow style panel (refer to Sections 
4.11.1 and 4.11.3) are automatically assigned to the objects drawn with this tool. 

Note To change the thickness, style, and color of a drawn arrow without affecting 
defaults, double-click the arrow and make the required settings on the Objects 
Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool becomes active immediately after you have drawn an arrow. 

4.7.6 Rectangle Button 

This button  enables the Rectangle tool allowing you to draw rectangles and squares.  To 
draw a rectangle of the desired size and form, activate this tool and drag in the workspace. 

Holding down SHIFT while dragging draws a square. 

Holding down CTRL while dragging draws the rectangle or square centered at the starting 
position of the cursor. 

The default attributes defined on the Pen style panel and Fill style panel (for more information on 
these panels, refer to Sections 4.11.1 and 4.11.2 correspondingly) are automatically assigned to 
the objects drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the rectangle and make the required settings on the Objects 
Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool immediately becomes active after you have drawn a rectangle. 

4.7.7 Rounded Rectangle Button 

This button  enables the Rounded Rectangle tool allowing you to draw rounded rectangles 
and rounded squares.  To draw a rounded rectangle of desired size and form, activate this tool 
and drag in the workspace.   

Holding down SHIFT while dragging draws a rounded square.  Holding down CTRL while 
dragging draws the rectangle or square centered at the starting position of the cursor. 

The default attributes defined on the Pen style panel and Fill style panel (refer to Sections 4.11.1 
and 4.11.2 correspondingly) are automatically assigned to the objects drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the rounded rectangle and make the required settings on the 
Objects Panel that appears. 



Draw Mode 

ACD/ChemSketch  Reference Manual 132 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool immediately becomes active after you have drawn a rounded 
rectangle. 

4.7.8 Ellipse Button 

This button  enables the Ellipse tool allowing you to draw ellipses and circles.  To draw an 
ellipse of desired size and form, choose this tool and drag in the workspace. 

Holding down SHIFT while dragging draws a circle. 

Holding down CTRL while dragging draws the ellipse or circle centered at the starting position of 
the cursor. 

The default attributes defined on the Pen style panel and Fill style panel (refer to Sections 4.11.1 
and 4.11.2 correspondingly) are automatically assigned to the objects drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the ellipse and make the required settings on the Objects 
Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool immediately becomes active after you have drawn an ellipse. 

4.7.9 Polygon Button 

This button  enables the Polygon tool allowing you to draw polygons  and curved 

shapes . 

To draw a polygon, subsequently click in the workspace with this tool active and right-click to 
finish drawing.  To draw a curved shape, use dragging in combination with clicking. 

Note You can then edit the form of the drawn shape with the help of the Edit Nodes 
[button image] tool. 

The default attributes defined on the Pen style panel and Fill style panel (refer to Sections 4.11.1 
and 4.11.2 correspondingly) are automatically assigned to the objects drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the polygon and make the required settings on the Objects 
Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool immediately becomes active after you have drawn a polygon. 
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4.7.10 Insert Image Button 

The Insert Image  button allows you to insert external bitmap images (BMP, JPG, and GIF 
formats) into the body of a ChemSketch document.  To insert a bitmap, click this button, and then 
click at the insertion point or select the insertion area by dragging.  In the Select Bitmap dialog 
box that appears, specify format,  name and location of a file and click Open to insert the picture. 

Note The inserted picture retains its original size if the insertion point has been specified 
by clicking.  In case of dragging as a selection means, however, the dimensions of 
the picture change in accordance with the dimensions of the selected area.  You 

can edit the dimensions of the inserted picture using the Select/Move/Resize  
tool. 

4.7.11 Text Button 

This button  enables the Text tool allowing you to insert text at any location on the 
workspace. 

If you click the bottom right triangle of the Text  button, it will be expanded into the following 
buttons: 

 Formatted Text 

 Artistic Text 

ACD/ChemSketch uses two types of text: formatted and artistic.  Unlike the formatted text, artistic 
text can be stretched or compressed to create visual effects. 

To type the text, click the required text tool to make it active and click in the workspace to place 
the text box.  Type the text and, as soon as you finish, click somewhere outside the text box. 

To edit the text, click the required text tool and click the text you want to edit. 

The default attributes defined on the Font panel and Paragraph panel (refer to Sections 4.11.4 
and 4.11.5 correspondingly) are automatically assigned to the text written with this tool. 

Note To change the style (font, color, etc.) of existing text, double-click the text and 
make the required settings on the Objects Panel that appears.  You can also 
change the default style attributes using the tools on the Text toolbar that appears 
as you activate the Text tool (for more information on the toolbar, refer to Section 
4.7.11).   

To edit the existing text, use the Edit Text  tool (for more information, refer to Section 4.6.4). 
You can rotate the text the same way as you can manipulate any graphical object using the 

Select/Move/Rotate  tool. 
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4.7.12 Table Button 

This button  enables the Table tool allowing you to insert table of required size and format.  
Activate this tool and then drag in the workspace to outline a box that will contain your table.  As 
you release the mouse button, the Insert Table dialog box where you should define the number 
of columns and rows appears.  As you click OK in this dialog box, the table is inserted and the 
Table toolbar appears allowing you to customize your table. 

4.7.12.1 Table Toolbar 

The Table toolbar appears on the middle part of the Editing toolbar if a table or its cell(s) is 

selected in the workspace and either the Select/Move/Resize  or Select/Move/Rotate  
tool is active.  This toolbar allows you to edit table rows and columns, and manipulate boxes into 
which a table can be arranged. 

Button Function 

The following six buttons serve for the editing column(s) and row(s).  Note that these buttons are 
available only if one or more cells of the inserted table are selected. 

 
Adds a column to the right of the column with the selected cell; the dimensions of a new 
column are the same as those of the column with the selected cell(s).  Note that to view the 
added column(s), enlarge the table box dimensions. 

 
Adds a row under the row with the selected cell; the dimensions of a new row are the same 
as those of the row with the selected cell(s).  Note that to view the added row(s), enlarge the 
table box dimensions. 

 
Deletes the column containing a selected cell. 

 
Deletes the row containing a selected cell. 

 
Displays the Column Width dialog box where you can type the appropriate width for the 
selected column(s).  The columns containing the selected cells are considered to be 
selected (to select several cells, hold down SHIFT while clicking them). 

 
Displays the Row Height dialog box where you can type the appropriate height for the 
selected row(s).  The rows containing the selected cells are considered selected (to select 
several cells, hold down SHIFT while clicking them). 

These buttons are available only if the entire table or a table box is selected. (To select a box, point to its 
upper left corner so that the gray border appears around the box, and then click. To select several boxes, 
press SHIFT, and then select each of the boxes as described above). 

 
Adds a new box for the selected table. 

 
Copies an empty box for the selected table where the rest rows of the table will be arranged, 
if they do not fit into one box.. 

 
Swaps the contents of the selected boxes.  Note that you can swap the contents of boxes 
within one table only. 

 
Deletes the selected table alongside with its content and all of the boxes referring to it. 

Note You can customize the toolbar using its shortcut menu.  For more information, refer 
to Section 2.2.1. 
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4.7.13 Brackets Buttons 

These buttons enable the corresponding tools allowing you to draw bracket(s), parenthes(is/es), 

and brace(s).  Click the bottom right triangle on the button  to unfold a panel representing 
various types of brackets: 

 Brackets 

 Bracket 

 Parentheses 

 Parenthesis 

 Braces 

 Brace 

To draw the brackets, click the button, and then drag in the workspace or point to the object and 
click when the brackets appear around it.  To draw a right/left standalone bracket, drag from side 
to side horizontally to flip it left to right. 

The default attributes defined on the Pen style panel and Fill style panel (refer to Sections 4.11.1 
and 4.11.2 correspondingly) are automatically assigned to the brackets drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the drawn brackets and specify the required options on the 
Objects Panel that appears. 

If the Keep Draw Tool Active check box in the Preferences dialog box (General tab) is 
selected, this tool remains active until you click or right-click in the workspace (the 

Select/Move/Resize  tool becomes active).  If this check box is cleared, the 

Select/Move/Resize  tool immediately becomes active after you have drawn brackets. 

4.7.14 Callout Buttons 

These buttons enable the tools allowing you to draw callouts.  Click the bottom right triangle of 

the button  to expand it into the following buttons representing various types of callouts: 

 Rounded 

 Square 

 Open 

To draw a callout, activate the required tool and drag in the workspace, or point to any drawn 
object and click when the callout appears around it. 
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The default attributes defined on the Pen style panel and Fill style panel (refer to Sections 4.11.1 
and 4.11.2 correspondingly) are automatically assigned to the callouts drawn with this tool. 

Note To change the thickness, style, and color of a drawn object without affecting 
defaults, double-click the callout and specify the required settings on the Objects 
Panel that appears. 

If the Keep draw tool active check box in the Preferences dialog box (General tab) is selected, 
this tool remains active until you click or right-click in the workspace (the Select/Move/Resize 

 tool becomes active).  If this check box is cleared, the Select/Move/Resize  tool 
immediately becomes active after you have drawn a callout. 

4.7.15 Report Template Button 

ACD/ChemSketch allows you to create report templates for data supported by 1D NMR, 2D 
NMR, MASS, UVIR, CURVE, and CHROM modules of ACD/SpecManager.  Make sure that you 

are in the Draw mode, click Report Template  on the Drawing toolbar, and then drag in the 
workspace to display the ACD/ChemSketch Template dialog box. 

For more information on how to create and use report templates, refer to ACD/Report Template 
Reference Manual located in the ACD/Labs documentation folder (\\DOCS\REPTEMPL.PDF). 

4.8 File Menu 

For detailed information on the commands that are available from this menu, refer to Section 3.9. 

4.9 Edit Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.10. 

4.10 Pages Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.11. 

4.11 Tools Menu 

The commands located on this menu allow you to change the appearance of graphical objects.  
These commands set the styles for lines, filling, arrows, text, paragraphs, and objects. 

Default Style Panels 

ACD/ChemSketch applies the default style to all new objects unless you specify otherwise by 
changing the default settings.  You can change the default in the Draw mode either by setting 
another existing style as the default or by changing the default style attributes on any of the Pen, 
Fill, Arrow, Font, Paragraph, and Table panels from the Tools menu. 
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Each panel is provided with a set of buttons having common functions: 

 
The table below lists these common buttons: 

Button Function 

 
Applies the current panel settings to selected objects. 

 
Copies the style attributes from the drawn object(s) to the panel.  When you click this 

button, the cursor becomes an arrow labeled From ( ).  Click the required 
object to update its style attributes to the panel. 

 
Displays the Save User Style dialog box where you can specify the name for a new 
style and select the style attributes to be saved.  For more information, refer to 
Section 4.11.8.1. 

 
Displays a list of styles where you can select the style whose attributes are to be 
added to the panel.  Note that this affects all of the attributes (font, arrow, fill, etc.). 

4.11.1 Pen Style Panel 

This command displays the Pen panel where you can specify the default line style, thickness and 
color for drawing lines, arcs, arrows, rectangles, ellipses, brackets, and callouts. 

Note To affect the selected objects only, without setting defaults, use the Objects Panel 
dialog box.  For more information, refer to Section 4.11.7. 

Whenever you draw a new object, ACD/ChemSketch fills it using the default style which can be 
specified on this panel. 

 
This panel contains the following options: 

Option Function 

 In this box, select the line of the needed type. 

 In this box, select the line of desired thickness. 

 In the color palette, select the needed color for lines. 

Shortcut: 

Keyboard: CTRL+SHIFT+P 
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4.11.2 Fill Style Panel 

This command displays the Fill panel where you can specify the default style for filling in 
rectangles, ellipses, polygons, and callouts. 

Note To affect the selected objects only, without setting defaults, use the Objects Panel 
dialog box.  For more information, refer to Section 4.11.7. 

Whenever you draw a new object, ACD/ChemSketch fills it using the default style which can be 
specified on this panel.  Depending on the button selected at the top of this panel, it has a 
different view: 

       
This panel contains the following options: 

Option Function 

  None When this button is active, the objects will be drawn with no fill, i.e., they will be 
transparent. 

  Solid When this button is active, the objects will be drawn with the solid fill.  You can specify 
the fill color in the color palette below. 

  Pattern When this button is active, the hatched objects will be drawn.  You can specify the 
prototype and color for hatching in the Color and Pattern boxes that appear. 

  Shade  When this button is active, the object whose fill fades or becomes more intensive 
gradually from the basic color to one of its tones will be drawn.  You can specify the 
prototype, color, and intensity for shading in the Color, Pattern, and Shade boxes that 
appear. 

 

In the color palette, choose the needed color. 

 

In this box, select the needed pattern for hatching. 

 

In this box, select the required shade type. 

 
In this box, you can specify the degree of default fill shading, i.e., the percentage of 
basic color changing in the fill. 

Shortcut: 

Keyboard: CTRL+SHIFT+F 
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4.11.3 Arrow Style Panel 

This command displays the Arrow panel where you can specify the default style for arrows. 

Note To affect the selected objects only, without setting defaults, use the Objects Panel 
dialog box.  For more information, refer to Section 4.11.7. 

Whenever you draw a new arrow, the default style which can be specified on this panel is applied 
to it. 

 
This panel contains the following options: 

Option Function 

 
In this box, specify the default arrow type.  If you choose Custom, the panel expands 
allowing you to specify your own arrow type. 

 Displays/hides the right part of the panel. 

Arrowhead size The preview area displays the arrowhead that will be applied to your arrow.  You can 
set the arrowhead width and height either by clicking/dragging in this area or by 
entering the values in the Width and Height boxes. 

Arrow body style In this box, specify the arrow body type. 

Arrowheads shape In this area, you can specify the default arrowhead shape to be applied to the right 
and/or to the left arrow ends. 

 Interchanges the right and the left arrowheads. 

Shortcut: 

Keyboard: CTRL+SHIFT+A 
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4.11.4 Font Panel 

This command displays the Font panel where you can specify the default style for text. 

Note To affect the selected objects only, without setting defaults, use Objects Panel.  
For more information, refer to Section 4.11.7. 

Whenever you enter a new text, ACD/ChemSketch applies the default style which can be 
specified on this panel. 

 
This panel contains the following options: 

Option Function 
Style In this box, you can specify the default font style. 

Size In this box, you can specify the default font size. 

Color In this color palette, you can specify the default font color. 

 Applies bold formatting.  You can use the bold format button in combination with other 
options. 

 Applies italic formatting.  You can use the italic format button in combination with other 
options. 

 Applies underlined formatting.  You can use the underline button in combination with other 
options. 

 Applies .formatting.  You can use the strikeout button in combination with other 
options. 

 Sets superscript formatting.  You can use the superscript button in combination with other 
options. 

 Sets subscript formatting.  You can use the subscript button in combination with other 
options. 

 Hides/shows the preview area. 

Preview area Shows how characters will look with the options selected.  You can hide/display it. 

Shortcut: 

Keyboard: CTRL+SHIFT+T 
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4.11.5 Paragraph Panel 

This command displays the Paragraph panel where you can specify the default style for 
paragraphs. 

Note To affect the selected objects only, without setting defaults, use the Objects Panel 
dialog box.  For more information, refer to Section 4.11.7. 

Whenever you enter a new text, ACD/ChemSketch applies default paragraph attributes which 
can be specified on this panel. 

    
This panel contains the following options: 

Option Function 
Justification In this area, specify the alignment for the paragraph by clicking the corresponding 

buttons: to the left , centered , to the right , and justified . 

Indentation On this tab, you can define the space from the left (Left) and from the right (Right) 
margins as well as the first line indent (First Line). 

Spacing On this tab, you can define the space above (Before) and below (After) the paragraph, 
as well as the distance between tab stops (Tab Step), and spacing between lines in a 
paragraph (Line Spacing). 
Note that the At option is available only if you select At Least or Exactly in the Line 
Spacing box. 

Note In most of the boxes, you can enter values in various units (points, inches, 
millimeters, or centimeters) by typing the value and adding the unit you want 
(pt/in/mm/cm).  The value will be recalculated automatically corresponding to the 
unit indicated in the Preferences dialog box (General tab). 

Shortcut: 

Keyboard: CTRL+SHIFT+R 
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4.11.6 Table Panel 

This command displays the Table panel where you can specify the default style for tables. 

Note To affect the selected objects only, without setting defaults, use the Objects Panel 
dialog box.  For more information, refer to Section 4.11.7. 

Whenever you draw a new table, ACD/ChemSketch applies the default style to it which can be 
specified on this panel. 

    
This panel contains the following options: 

Option Function 
On the Box tab, you can define options for table. 

Use Header If this check box is selected, the first row in the table is inserted in every box as a header. 

Protect 
Contents 

If this check box is selected, the program does not allow you to insert or remove objects 
from the table cells. 

Move to the 
Right 

If this check box is selected, the table rows are arranged into several groups like 
columns, each one is located to the right from the previous one.  The table rows that do 
not fit in the first group are moved to the right of the first group; the table rows that do not 
fit in the second group are moved to the right of the second group, and so on. 

Move to Next 
Box 

If this check box is selected, the table rows that do not fit in the box (that is restricted as 
you first drag in the workspace when inserting a table), are moved to the next box. 

Vertical Justify If this check box is selected, numbers of rows in each group (column) are approximately 
equal. 
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Option Function 
On the Cell tab, you can define options for table cells. 

Alignment In this area, you can specify the horizontal and vertical alignment of the content in a 
table. 

Fit In this box, select the way the table and its contents fit to each other: 
Mixed—various cells in the table have different Fit parameters. 
Table to Contents—the table dimensions are adjusted to the size of the contents (the 
table cells are reduced or enlarged with respect to the largest height and width of the 
inserted objects). 
Contents to Table—the inserted objects are resized to fit properly into the table cells. 
None—the table retains its primary dimensions irrespective of the size of the contents. 

Note For more information on how to create a table in ACD/ChemSketch, refer to 
Section 4.7.12. 

Shortcut: 

Keyboard: CTRL+SHIFT+B 

4.11.7 Update Object Style Panel 

This command allows you to alter style of the selected object without affecting default settings.  

Clicking this command (or double-clicking the required object with the Select/Move/Resize  

or Select/Move/Rotate  tools enabled) displays the Objects Panel with the options that 
correspond to the type of the selected object(s). 

The panel may contain different buttons corresponding to the type(s) of the selected object(s); 
the represented screen shot is the fullest variant. 

 

Combine your choices from the tabs and the drop-down lists to create your style, and then click 
Apply to employ changes. 

If no objects are selected in the workspace, this command is disabled. 

Note To change defaults, use the Pen, Fill, Arrow, Font, Paragraph, and Table panels 
(for more information, refer to Sections 4.11.1–4.11.6.). 

Each Object Panel dialog box is provided with a set of buttons having common functions: 
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The table below lists these common buttons: 

Button Function 

 
Applies the specified style settings to the selected objects. 

 
Displays the list of the available styles.  Choose the required style name 
to load its attributes into the panel. 

 
Sets the specified settings as the default. 

 
Displays the Save User Style dialog box where you can specify a new 
style name and choose which of the selected object's attributes are to 
be included into the style.  For more information, refer to Section 
4.11.8.1. 

Shortcuts: 

Keyboard: CTRL+SHIFT+O 
Mouse: double-click the selected object 

4.11.7.1 Objects Panel: Common 

The Common button displays tabs with style attributes common for different types of objects. 

       
The following options are available: 

Option Function 
On the Pen tab, you can specify the line thickness, style, and color of the selected objects. 

Style From the list, choose the line style. 

Width In this box, specify the line thickness for the selected objects. 

Color In this box, specify the line color to be applied to selected objects. 
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Option Function 
The Fill tab presents options for specifying the fill style, color, and pattern of selected objects. 

Style In this area, click the required button to: 

  None Draw the objects with no fill, i.e., they will be transparent. 

  Solid Draw the objects with the solid fill (you can specify the fill color in the 
Color box that appears). 

  Pattern Draw the hatched objects (you can specify the prototype and color for 
hatching in the Color and Pattern boxes that appear). 

  Shade Draw the objects whose fill fades or becomes more intensive gradually 
from the basic color to one of its tones (you can specify the prototype, 
color, and intensity for shading in the Color, Pattern, and Shade boxes 
that appear). 

Color In this box, you can specify the fill color to be applied to the selected objects. 

Pattern In this box, select the needed pattern for hatching or the required shade type. 

Shade In this box, you can specify the degree of default fill shading, i.e., the percentage of basic 
color changing in the fill. 

On the Font tab, specify the font and paragraph settings for the selected text. 

Style In this box, you can specify the font style. 

Size In this box, you can specify the font size. 

Color In this box, you can specify the font color. 

Attributes Selecting check boxes applies the corresponding formatting: 
Bold 
Italic 
Underline 
Strikeout. 
Superscript (Superscript) 
Subscript (Subscript) 

Note If several objects are selected on the ChemSketch page, the check box of an 
attribute can be: 
—Cleared, i.e., this attribute will not be applied to the selected objects; 
—Selected, i.e., this attribute will be applied to the selected objects; 
—Dimmed (if the current attribute differs for the selected objects), i.e., this attribute 
will not be changed for the selected objects. 
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4.11.7.2 Objects Panel: Structure 

The Structure button displays tabs with style settings to be applied to the selected structures. 

    
The following options are available: 

Option Function 
On the Atom tab, specify the font options to be used for atom labels of the selected structure(s). 
Font In this box, specify the font style to be applied to atom labels in the selected structure. 

Symbol Size In this box, specify the font size to be applied to atom labels of the selected structure. 

Color In this box, specify the font color to be applied to atom labels of the selected structure. 

Style In this box, specify the style for atom labels: bold and/or italic. 
The pressed-in Mix button indicates that the corresponding attribute in the selected 
objects differs (e.g., the selected structure has some atoms formatted just with bold 
and some just with italic). 

On the Bond tab, specify the width and color to be used for bonds of the selected structure(s). 

Width In this box, specify the bond thickness for the selected structure.  Note that you can 
enter values in various units (points, inches, millimeters, or centimeters) by typing the 
value and adding the unit you want (pt/in/mm/cm).  The value will be recalculated 
automatically corresponding to the unit indicated in the Preferences dialog box 
(General tab). 

Color In this box, specify the color to be applied to bonds of selected structure. 
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4.11.7.3 Objects Panel: Lines & Arrows 

The Lines & Arrows button displays tabs with style settings to be applied to selected linear 
objects and arrows: 

    
The following options are available: 

Option Function 
On the Pen tab, you can specify the thickness, style, and color of the line on selected linear objects. 

Style From this box, choose the line style. 

Width In this box, specify the line thickness for the selected objects. 

Color In this box, you can specify the line color to be applied to the selected objects. 

On the Arrow tab, you can specify the style of arrowhead and body of selected arrows.  
Body Style In this box, specify the default arrow body type. 

Arrowheads shape In this area, specify the default arrowhead shape to be applied to both arrow ends. 

 Interchanges the arrowheads. 

Arrowheads size In this area, specify the arrowhead width and height. 
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4.11.7.4 Objects Panel: Shapes 

The Shapes button displays tabs with style settings to be applied to selected filling enclosures 
such as rectangles, ellipses, polygons and callouts. 

       
The following options are available: 

Option Function 
On the Pen tab, you can specify the thickness, style, and line color of the selected objects.  These tab 
settings will be applied to all the selected rectangles, ellipses, polygons, and callouts. 
Style From this box, choose the line style. 

Width In this box, specify the line thickness for selected objects. 

Color In the color palette, you can specify the line color to be applied to the selected objects. 

On the Fill tab, you can specify the fill style and color of the selected objects.  These settings will be applied to 
all the selected rectangles, ellipses, polygons, and callouts. 

Style In this area, click the required button to: 

  None Draw the objects with no fill, i.e., they will be transparent. 

  Solid Draw the objects with the solid fill (you can specify the fill color in the 
Color box that appears). 

  Pattern Draw the hatched objects (you can specify the prototype and color for 
hatching in the Color and Pattern boxes that appear). 

  Shade Draw the objects whose fill fades or becomes more intensive gradually 
from the basic color to one of its tones (you can specify the prototype, 
color, and intensity for shading in the Color, Pattern, and Shade boxes 
that appear). 

Color In this box, you can specify the fill color to be applied to the selected shapes. 

Pattern In this box, select the needed pattern for hatching or the required shade type. 

Shade In this box, you can specify the degree of default fill shading, i.e., the percentage of 
basic color changing in the fill. 
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Option Function 
On the Shadow tab, you can specify the size and color of shadow to be applied to the selected objects.  
These settings will be applied to all the selected rectangles, ellipses, polygons, and callouts. 

On / Off /Mixed Adds/removes shadow of selected shapes.  Specify the shadow size and color in the 
other boxes.  The selected Mixed option indicates that the corresponding attribute in the 
selected objects differs (e.g., one selected shape has a shadow and the other does not 
have any). 

Color In the color palette, you can specify the color of the shadow. 

dX / dY In these boxes, you can specify the position of a shadow relative to the object along the 
X and Y axes correspondingly. 
To enter the value in points/inches/millimeters/centimeters, type the value and add the 
unit you want (pt/in/mm/cm), e.g., 5 pt.  The value will be recalculated into the unit of 
measurement selected in the Preferences dialog box (General tab).  

4.11.7.5 Objects Panel: Text 

The Text button displays tabs with the style settings to be applied to selected text. 

       
The following options are available: 

Option Function 
On the Attr tab, you can transform the selected formatted text into the artistic one and rotate it. 

Artistic Text Select this check box to transform the selected Formatted text into the Artistic one.  
Unlike the formatted text, the artistic text can be modified like a usual graphical object 
(stretched, rotated, etc.). 

Angle of Rotation In this box, you can specify the angle at which you want to rotate the selected text. 
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Option Function 
On the Font tab, specify the font settings for the selected text. 
Style In this box, specify the font style. 

Size In this box, specify the font size. 

Color In this box, specify the font color. 

Attributes Selecting check boxes applies the corresponding formatting: 
Bold 
Italic 
Underline 
Strikeout. 
Superscript (Superscript) 
Subscript (Subscript) 

On the Paragraph tab, you can specify the style for paragraphs of selected text. 

Justification In this area, specify the alignment for the paragraph by clicking the corresponding 
buttons: to the left , centered , to the right , and justified .  Text will be 
aligned relative to the current indents that can be specified in the Indentation area 
below.  The active Mix button ( ) indicates that the justification of the selected 
objects differs and will not be changed. 

Indentation In this area, you can specify the left and the right indention of the paragraph in the text 
box as well as the indent of the first line in the paragraph. 

Spacing 
 

In this area, you can define the space above (Before) and below (After) the 
paragraph, as well as the distance between tab stops (Tab Step), and spacing 
between lines in a paragraph (Line Spacing). 
Note that the At option is available only if you select At Least or Exactly in the Line 
Spacing box. 
In most of the boxes, you can enter values in various units (points, inches, millimeters, 
or centimeters) by typing the value and adding the unit you want (pt/in/mm/cm).  The 
value will be recalculated automatically corresponding to the unit indicated in the 
Preferences dialog box (General tab). 

Note If several objects are selected on the ChemSketch page, the check box of an 
attribute can be: 
—Cleared, i.e., this attribute will not be applied to the selected objects; 
—Selected, i.e., this attribute will be applied to the selected objects; 
—Dimmed (if the current attribute differs for the selected objects), i.e., this attribute 
will not be changed for the selected objects. 
 
The units of measurement in most of the boxes correspond to those set in the 
Preferences dialog box (General tab).  To enter the value in 
points/inches/millimeters/centimeters, type the value and add the unit you want 
(pt/in/mm/cm), e.g., 5 pt.  The value will be recalculated into the corresponding unit 
of measurement. 
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4.11.7.6 Objects Panel: NMR Spectrum 

The NMR Spectrum button displays tabs with style settings to be applied to the selected 1D 
NMR spectra copied from the ACD/CNMR or ACD/HNMR applications. 

 

 

 
The following options are available: 

Option Function 
On the View tab, specify the objects to be displayed with the spectrum. 

Spectrum display 
options 

In this area, select the check boxes of the elements to be displayed on the spectrum: 
gridlines, integral curves, lines' labels, confidence limits. 
If several spectra are selected on the ChemSketch page, the check box of an element 
can be dimmed, i.e., the state of the current element differs for these spectra. 

Scale display 
options 

In this area, select/clear the Vertical Scale / Horizontal Scale check boxes to 
display/hide the corresponding scales of the spectrum. 
If several spectra are selected on the ChemSketch page, the check box of an element 
can be dimmed, i.e., the state of the current element differs for these spectra. 

On the Spectrum tab, specify the spectrum lines style and labels font style. 

Spectrum Lines 
Styles 

In this area, specify the style, thickness, and color to be applied to the spectrum lines 
(solute, solvent, and overlapped lines). 

Labels Font Style In this area, specify the style, size, and color for spectrum labels. 
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Option Function 
On the Scale tab, specify the scale line style and label font style. 

Scale Line Style In this area, specify the style, thickness, and color to be applied to the scale lines. 

Scale Font Style In this area, define the font style, size, and color for scale values. 
 

4.11.7.7 Objects Panel: Spectrum 

The Spectrum button displays tabs with style settings to be applied to the spectra copied from 
ACD/SpecManager. 

   

   
The following options are available: 

Option Function 
On the View tab, specify the objects to be displayed with the spectrum: labels, integral curves, gridlines, 
vertical scale, and horizontal scale. 

On the Spectrum tab, specify the style for spectrum and scales. 

Spectrum Line Style In this area, specify the ordinal number of the line for which the style, width, and 
color should be specified in the Lines boxes below. 

Scale Style  In this area, define the font style, size, and color for scale values (Values boxes), 
also specify the style, width, and color for scale lines (Lines boxes).   
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Option Function 
On the Labels tab, specify the style, position, and orientation of peak labels. 

Labels Style In this area, specify the style, size, and color for spectrum labels. 

Position In this area, specify the position of peak labels on the spectrum.  The selected 
Mixed option indicates that the position of labels in several selected spectra 
differs and will not be changed. 

Orientation In this area, specify the orientation of peak labels.  The selected Mixed option 
indicates that the orientation of labels in several selected spectra differs and will 
not be changed. 

On the Integrals tab, specify the styles for integral lines and integral values. 

Note If several objects are selected on the ChemSketch page, the check box of an 
attribute can be: 
—Cleared, i.e., this attribute will not be applied to the selected objects; 
—Selected, i.e., this attribute will be applied to the selected objects; 
—Dimmed (if the current attribute differs for the selected objects), i.e., this attribute 
will not be changed for the selected objects. 

4.11.7.8 Objects Panel: 2D Spectrum 

The 2D Spectrum button displays tabs with style settings to be applied to the selected 2D NMR 
spectra copied from ACD/SpecManager. 

  

 



Draw Mode 

ACD/ChemSketch  Reference Manual 154 

The following options are available: 

Option Function 
On the Spectrum tab, specify the style for 2D spectrum and 1D curves. 

2D Spectrum Colors In this area, specify the color settings for peaks of the current spectrum and 
background.  As you click the Coloration Scheme box, the dialog box appears 
allowing you to choose the coloration scheme (either Polychromatic or 
Dichromatic) you want to apply, set the additional color gradient for better 
visualization of a spectrum, and specify the colors to be used for displaying plot 
layers. 
You can select colors for up to ten overlaid spectra: in the No. box, choose the 
spectrum number and set the desired colors.  Using this option helps you to 
distinguish between the collected 2D NMR spectra. 

Plots and Contours In this areas, specify a form of the plot to be used for the spectrum 
representation.  If several spectra are selected and they are represented with 
different types of plots, the Mixed Plot button is pressed in. 
For Gradient Contour Plot and Contour Plot you can also set the number of 
Contours to be used for each peak display. 

Spectrum Bitmap 
Resolution 

In this area, choose Low or High resolution depending on your requirements.  
Note that the higher resolution provides the better image quality, but also the 
larger file size. 

1D spectra In this area, select the check boxes of those 1D spectra that should be inserted 
together with the 2D spectrum.  Note that these check boxes are enabled when 
you have 1D spectra attached. 
Moreover, in this area you can specify the color and width of the 1D spectrum 
lines. 

On the Labels tab, specify the labels' components, units of measurement, color and style of the labels’ text 
and lines. 

Show Labels Select this check box to display the labels on the spectrum.  In the section below 
you can specify the elements to be included into a label. 
If several spectra are selected on the ChemSketch page, this check box can be 
dimmed, i.e., the state of the elements differs in these spectra. 

Include in Label In this area, select check boxes of the elements to be included in peak labels: 
F2 / F1 shifts, intensities, volumes, assignments, annotations, and gridlines.  If 
several spectra are selected on the ChemSketch page, the check box of an 
element can be dimmed, i.e., the state of the current element differs for these 
spectra. 

F2 Units / F1 Units In these areas, specify the units of measurement for the F2 and F1 scales. 
The pressed Mix button indicates that the units of measurement in several 
selected spectra differ and will not be changed. 

Style In this area, you can specify the display preferences for up to ten overlaid 
spectra.  In the No. box, select the number of the spectrum, and then select the 
appropriate style attributes (label font style, size, and color, as well as the line 
style and color) in the boxes to the right. 
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Option Function 
On the Scales tab, specify the units of measurement, position of scales, color and style of the scales’ text and 
lines. 

Show In this area, select the check boxes of those elements that should be displayed 
together with the spectrum. 
If several spectra are selected on the ChemSketch page, the check box of an 
element can be dimmed, i.e., the state of the current element differs for these 
spectra. 

Position of Scales In this area, select the location of the axes: 
    right and bottom; 
    left and bottom; 
    right and top; 
    left and top. 
If several spectra are selected and they have different display of scales, the 
Mixed Scales button is active. 

Style In this area, define the font style, size, and color for the scale values (Text 
boxes); also specify the style and color for scale lines (Lines boxes). 

4.11.7.9 Objects Panel: Table 

The Table button displays the tabs with style settings for table: 
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The following options are available: 

Option Function 
On the Box tab, specify the general table options including arrangement of table rows in the box in the various 
ways. 

Use 
Header 

If this check box is selected, the first row in the table is inserted in every box as a header. 

Protect 
Contents 

If this check box is selected, the program does not allow you to insert or remove objects from 
the table cells until you clear this check box. 

Move to 
the Right 

If this check box is selected, the table rows are arranged into several groups like columns, 
each one is located to the right from the previous one.  The table rows that do not fit in the first 
group are moved to the right of the first group; the table rows that do not fit in the second group 
are moved to the right of the second group, and so on. 

Move to 
Next Box 

If this check box is selected, the table rows that do not fit in the box (that is restricted as you 
first drag in the workspace when inserting a table), are moved to the next box. 

Vertical 
Justify 

If this check box is selected, numbers of rows in each group (column) are approximately equal. 

On the Cell tab, you can define options for content alignment and manipulation within the table. 

Alignment In this area, you can specify the horizontal and vertical alignment of the content in a table. 

Fit In this box, select the way the table and its contents fit to each other: 
Mixed—various cells in the table have different Fit parameters. 
Table to Contents—the table dimensions are adjusted to the size of the contents (the table 
cells are reduced or enlarged with respect to the largest height and width of the inserted 
objects). 
Contents to Table—the inserted objects are resized to fit properly into the table cells. 
None—the table retains its primary dimensions irrespective of the size of the contents. 

On the Pen tab, specify the line style, width, and color of the table borders. 

On the Fill tab, specify the fill style and color of table cells. 

Style In this area, click the required button to: 

  None Draw the objects with no fill, i.e., they will be transparent. 

  Solid Draw the objects with the solid fill (you can specify the fill color in the Color 
box that appears). 

  Pattern Draw the hatched objects (you can specify the prototype and color for 
hatching in the Color and Pattern boxes that appear). 

  Shade Draw the objects whose fill fades or becomes more intensive gradually from 
the basic color to one of its tones (you can specify the prototype, color, and 
intensity for shading in the Color, Pattern, and Shade boxes that appear). 

Color In this box, you can specify the fill color to be applied to the table cells. 

Pattern In this box, select the needed pattern for hatching or the required shade type. 

Shade In this box, you can specify the degree of default fill shading, i.e., the percentage of basic color 
changing in the fill. 

Note If several objects are selected on the ChemSketch page, the check box of an 
attribute can be: 
—Cleared, i.e., this attribute will not be applied to the selected objects; 
—Selected, i.e., this attribute will be applied to the selected objects; 
—Dimmed (if the current attribute differs for the selected objects), i.e., this attribute 
will not be changed for the selected objects. 
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4.11.8 Style Organizer Panel 

This command allows you to manage styles.  It displays the Style Panel containing a list of all 
saved styles and attributes (pen, arrow, fill, font, paragraph, and table) included in each style. 

Using this panel you can apply any of the existing styles to the selected object, set any style from 
the list as the default one, rename or delete an existing style, and save the current default 
settings as a new style. 

If you choose one or several attributes from the row at the top of the panel, the list of styles which 
include the chosen attributes will appear. 

Choose all of the attributes to see the whole list of styles. 

 
This panel contains the following options: 

Option Function 
Attributes Click the required button to view the styles containing the corresponding attribute.  The 

following attributes are available: 

— Pen (for more information on this attribute, refer to Section 4.11.1) 

—Arrow (for more information on this attribute, refer to Section 4.11.3) 

—Fill (for more information on this attribute, refer to Section 4.11.2) 

—Font (for more information on this attribute, refer to Section 4.11.4) 

—Paragraph (for more information on this attribute, refer to Section 4.11.5) 

—Table (for more information on this attribute, refer to Section 4.11.6) 

List of Styles Displays a list of all saved styles and attributes (pen, arrow, fill, font, paragraph, and 
table) included in each style.  Click the style to highlight it.  You can then delete, rename, 
apply, and set as default the highlighted style.  Built-in styles are shown in gray in the list 
and cannot be modified or deleted. 

 
Applies the style highlighted in the list to the selected object(s). 

 
Sets the style highlighted in the list as the default. 

 
Displays the Save User Style dialog box where you can specify the name for your style 
and to choose the attributes to be included in it.  For more information, refer to the 
section that follows. 
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Option Function 

 
Displays the Rename Style dialog box where you can specify a new name for an 
existing style.  Note that the built-in styles that appear in gray in the list of styles cannot 
be renamed. 

 
Removes the highlighted style from the list.  Note that the built-in styles that appear in 
gray in the list cannot be deleted. 

4.11.8.1 Save User Style Dialog Box 

In this dialog box, you can specify the current default attributes to be saved as a new user-
defined style. 

You can open this dialog box from any of the default style panels (Tools menu) by clicking Save 
 or from the Style Panel dialog box by clicking New .   

 
This dialog box contains the following options: 

Option Function 
Style Name Specify a new name for the style or choose the one from the list and modify it. 

Pen Style Select this check box to include current default pen style attributes (specified in the Pen 
panel) in a user-defined style. 

Arrow Style Select this check box to include current default arrow style attributes (specified in the 
Arrow panel) in a user-defined style. 

Fill Style Select this check box to include current default fill style attributes (specified in the Fill 
panel) in a user-defined style. 

Font Style Select this check box to include current default font style attributes (specified in the Font 
panel) in a user-defined style. 

Paragraph Style Select this check box to include current default paragraph style attributes (specified in 
the Paragraph panel) in a user-defined style. 

Table Style Select this check box to include current default table style attributes (specified in the 
Table panel) in a user-defined style. 

OK Click this button to save the specified attributes into the user-defined style with specified 
name. 

Cancel Click this button to close the dialog box without saving any changes you have made. 
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4.11.9 Generate Submenu 

For detailed information on the commands that are available from this submenu, refer to Sections 
3.12.16–3.12.24. 

4.11.10 Search for Structure—Commercial version only! 

For detailed information on this command, refer to Section 3.12.25. 

4.12 Object Menu 

The commands located on this menu allow you to control the location of the graphical objects on 
the page.  These commands group, layer, rotate, and align selected objects, connect lines and 
convert selected objects to polylines.  Most of the commands on this menu are also available on 
the Editing toolbar (refer to Section 4.6). 

4.12.1 Group/Ungroup 

This command allows you to do the following: 
• Group all of the selected objects together so that they can be selected and manipulated as 

a single object. 
• Break up the selected group into its individual objects.  If you have grouped several groups 

together, Ungroup breaks up one level of grouping at a time. 
• Place/extract the selected object to the selected table's cell. 

Note The Group and Ungroup commands automatically replace each other on the 
Object menu depending on the current selection. 

This command is unavailable if there is only one selected object or no selected objects in the 
workspace. 

Shortcuts: 

Keyboard:   CTRL+G 

Editing toolbar  
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4.12.2 Bring to Front 

This command brings the selected background objects to the foreground.  Select the object(s) 
and choose this command.  To reverse Bring to Front, use the Send to Back command. 

To select objects that are completely covered by foreground objects, you can apply the Send to 
Back command to the front object(s). 

Shortcuts: 

Keyboard:   CTRL+F 

Editing toolbar:   

4.12.3 Send to Back 

This command allows you to move objects from the foreground to the background.  Select the 
object(s) and choose this command.  To reverse Send to Back, use the Bring to Front 
command. 

Shortcuts: 

Keyboard:   CTRL+K 

Editing toolbar:   

4.12.4 Flip Left to Right 

This command allows you to turn the selected object(s) about the vertical axis. 

If the Select Graphics check box in the Preferences dialog box (Structure tab) is selected, you 
can apply some of the selecting, rotating, and flipping tools available on the Structure toolbar to 
the objects created in the Draw mode. 

Shortcut: 

Editing toolbar:   

4.12.5 Flip Top to Bottom 

This command allows you to turn the selected object(s) about the horizontal axis. 

If the Select Graphics check box in the Preferences dialog box (Structure tab) is selected, you 
can apply some of the selecting, rotating, and flipping tools available on the Structure toolbar to 
the objects created in the Draw mode. 

Shortcut: 

Editing toolbar:   
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4.12.6 Rotate 90° 

This command rotates the selected objects anticlockwise by 90°. 

Tip You can also use the Select/Move/Rotate tool  for rotating objects (for more 
information, refer to Section 4.6.2). 

Shortcut: 

Editing toolbar:  

4.12.7 Align Horizontally > Left/Center/Right 

These commands allow you to align the selected objects horizontally to the left, to the center, or 
to the right correspondingly. 

• If a single object is selected, it is aligned to the center, left, or right margin of the whole 
page. 

• If a group of objects is selected, objects are aligned to the center, left, or right edge of the 
whole group relative each other. 

Shortcuts: 

Editing toolbar:    

4.12.8 Align Vertically > Top/Center/Bottom 

These commands allow you to align the selected objects vertically to the top, to the center, or to 
the bottom correspondingly. 

• If a single object is selected, it is aligned to the top, center, or bottom margin of the page. 
• If a group of objects is selected, objects are aligned to the top, center, or bottom edge of 

the whole group relative each other. 

Shortcuts: 

Editing toolbar:    

4.12.9 Fit Horizontally 

This command stretches the selected object(s) horizontally to the left and right margins of the 
page. 

Unlike the Fit All  option that only changes the display of objects, this command changes the 
actual size of objects. 
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4.12.10 Fit Vertically 

This command stretches the selected object(s) vertically to the top and bottom margins of the 
page. 

Unlike the Fit All  and Fit Selected  options that only change the display of objects, this 
command changes the actual size of objects. 

4.12.11 Convert to Polyline 

This command converts the selected objects drawn with the Rectangle , Rounded 

Rectangle , Arc , and Ellipse  tools to polyline so that you can change their shape 

using the Edit Nodes  tool. 

Shortcut: 

Keyboard:   CTRL+Y 

4.12.12 Connect Lines 

This command draws connecting lines between two or more selected graphical objects drawn 

with the Line , Curve , Arrow , or Polyline  tools.  The nearest end points of the 
selected objects are joined together. 

To be able to apply this tool to objects drawn with the Arc tool , you can convert the drawn 
arcs into polyline using the Convert to Polyline command from the Object menu. 

4.13 Templates Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.13. 

4.14 Options Menu 
For detailed information on the commands that are available from this menu, refer to Section 
3.14. 

4.15 Documents Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.15. 
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4.16 I-Lab Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.17. 

4.17 ACD/Labs Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.18. 

4.18 Help Menu 

For detailed information on the commands that are available from this menu, refer to Section 
3.19. 
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Appendix A. Running ACD/ChemSketch from the 
Command Line 

There may be circumstances (such as a call from another program) in which you need to run 
ACD/ChemSketch from the command line instead of the Windows graphical user interface. 

The following command arguments are available to be issued from the command line: 

Command This command… 
chemsk Runs ACD/ChemSketch 
chemsk PathFilename.SupportedFormat 
 
where 
PathFilename.SupportedFormat can be a file of 
any format supported by the current version of 
ACD/ChemSketch (for the list of supported formats, refer 
to Section 3.9.8). 

Opens the specified file in the ChemSketch 
window (if possible) 

/print Prints the file open in ACD/ChemSketch 
/exportpdf Exports the file open in ACD/ChemSketch into 

PDF format 
/exportpdf:Filename.pdf Exports the file into PDF format with the 

specified name 
/norestore If this switch is added to the command line, all of 

the specified actions will be executed without 
opening ACD/ChemSketch 

/quit Quits ACD/ChemSketch 

Note The command line length is limited to 260 characters. 

For example, the following line: 
chemsk e:\examples\poster.sk2 /print /exportpdf /quit 

opens POSTER.SK2 from E:\EXAMPLES in the ChemSketch window, prints it, exports it into the 
POSTER.PDF file, and quits the program; 

and the following line 
chemsk c:\temp\borneol.mol /exportpdf:example.pdf /norestore /quit 

loads the BORNEOL.MOL file located in C:\TEMP, exports it into the EXAMPLE.PDF file, and 
quits the program without opening it.  
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Appendix B. Calculated Properties 

Overview 

In addition to the drawing capabilities, ACD/ ChemSketch offers predictions of numerous 
properties for your compounds.  These include prediction of  
• Molecular formula 
• Formula weight 
• Composition 
• Molar refractivity 
• Molar volume 
• Parachor 
• Index of refraction 
• Surface tension 
• Density 
• Dielectric constant 
• Polarizability 
• Monoisotopic, nominal, and average mass 

In this chapter, the simple means to calculate these properties and the calculation algorithms are 
briefly described.  An agreement between calculated and experimental values is shown for 
several hundreds of compounds. 

Algorithms for Calculating Properties 

At the heart of the additive-constitutive calculation algorithm of all physicochemical properties in 
ACD/ChemSketch lies the presumption that these properties can be estimated using additive 
atomic or group increments.  Apart from molecular weight (MW), which is trivial to calculate, the 
algorithms may be divided into three general groups: 

• Basic macroscopic properties: molar volume (MV), molar refractivity (MR), and parachor 
(Pr) 

• Derived macroscopic properties: density (d), refractive index (n), and surface tension (γ) 

• The dielectric constant ε (Permittivity) 

Basic macroscopic properties such as molar volume (MV), molar refractivity (MR), and the 
parachor (Pr) are calculated first for the input structure.  The atomic additive increments in such 
an algorithm depend on the bonds (single, double, aromatic, etc.) of this atom and on 
neighboring atoms.  ACD/ChemSketch rapidly analyzes the input structure to determine the class 
of each atom, i.e., whether it is cyclic, aromatic, aliphatic, etc. 
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The prediction algorithms for density (d), refractive index (n) and surface tension (γ) are founded 
on well-known physicochemical formula which can be found in literature on physicochemical 
properties of compounds.  They express d, n, and γ as functions of MV, MR, or Pr.  Once the MV, 
MR, or Pr, have been predicted by additive means, it is straightforward to predict d, n, and γ using 
these formula. 

The determination of the additive-constitutive atomic increments for MV, MR, and Pr were 
obtained internally by ACD/Labs scientists using large experimental databases relating structure 
to density, refractive index, and surface tension.  The MV, MR, and Pr were recalculated from d, 
n, and γ.  These parameters are proprietary information of ACD/Labs, Inc. 

The prediction of the dielectric constant ε (permittivity) resembles very closely the prediction of 
boiling point, which is a separate ACD/Labs product available from ACD/ChemSketch.  Senior 
scientists at ACD/Labs discovered an additive function, which relates the dielectric constant to 
other macroscopic properties which can be additively treated, such as MV.  Once this relationship 
was discovered, the additive-constitutive atomic increments for this function were obtained using 
large databases consisting of molecular structures and their observed dielectric constants.  Using 
the function and estimated MV for the input structure, its dielectric constant can be quickly 
predicted. 

Molar Volume, MV 

By definition, 

MV
MW
d

=
. 

ACD/ChemSketch calculates molar volume from additive increments.  The additive atomic 
increments were obtained using a database of density and calculated MW. 

Molar Refractivity, MR 

The Lorentz-Lorenz equation relates refractive index, density, and refractive index: 

  
MR n

n
MW
d

=
−
+

⋅
2

2

1
2  

ACD/ChemSketch calculates molar refractivity from additive increments.  The additive atomic 
increments were obtained using a database of density, refractive index, and calculated MW. 

Parachor, Pr 

By definition, 

  
P MW

dr = ⎛
⎝⎜

⎞
⎠⎟
γ

1
4

 
ACD/ChemSketch calculates the parachor from additive increments.  The additive atomic 
increments were obtained using a database of density, surface tension, and calculated MW. 
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Density, d 

By definition, 

  
d

MW
MV

=
  

ACD/ChemSketch calculates the density from MW and the calculated molar volume (see above). 

Refractive Index, n 

By the Lorentz-Lorenz equation, 

 
n

MR MV
MV MR

=
⋅ +

−
2

 
ACD/ChemSketch calculates the refractive index from the molar volume and molar refractivity, 
both of which are calculated as above. 

Surface Tension, γ 

By definition, 

  
γ =

⎛
⎝⎜

⎞
⎠⎟

P
MV

r
4

 
ACD/ChemSketch calculates the surface tension from calculated MV (see above) and calculated 
Pr (see above). 

Dielectric Constant, ε (Permittivity) 

By definition, 

  ( ) ( )f f MV AdditiveFunctionε = ,  

ACD/ChemSketch calculates the dielectric constant from calculated MV (see above) and a 
proprietary empirical additive function. 

Polarizability 

This property is calculated from the Molar Refractivity (MR) as follows: 

   Polarizability . MR= ⋅0 3964308  
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Monoisotopic, Nominal and Average Mass 

Monoisotopic mass (Mmi) is the exact mass of the most abundant stable isotope that can occur 
naturally. 

Nominal Mass (Mn) is the sum of the approximated monoisotopic masses of the elements forming 
the structure. 

Average Mass (Mav) is the calculated mass of a particle based on the atomic weights of the 
elements from which it is composed. 

Correlation Statistics with Experimental Data 

Distribution of Molar Refractivity Prediction Error 

    
Vertical scale: Number of Tested Structures 
Horizontal scale: ACD Molar Refractivity Estimation Error 
Number of tested structures: 592 

MRexp = 0.99901(±0.00067) MRcalc + 0.026(±0.025) R=0.999867, StD=0.23 
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Distribution of Molar Volume Prediction Error 

    
Vertical scale: Number of Tested Structures 
Horizontal scale: ACD/Molar Volume Estimation Error 
Number of tested structures: 671 

MVexp = 0.9989(±0.0020) MVcalc + 0.18(±0.29)  R=0.998626, StD=2.74 

Distribution of the Parachor Prediction Error 

    
Vertical scale: Number of Tested Structures 
Horizontal scale: ACD/Parachor Estimation Error 
Number of tested structures: 377 

Prexp = 0.9978(±0.0015) Prcalc + 0.68(±0.46)  R=0.99958, StD=3.11 
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Distribution of the Refractive Index Prediction Error 

    
Vertical scale: Number of Tested Structures 
Horizontal scale: ACD/Refractive Index Estimation Error 
Number of tested structures: 665 

n20exp = 0.98035(±0.0073) n20calc + 0.028(±0.011) R=0.982, StD=0.012 

Distribution of the Density Prediction Error 

 
Vertical scale: Number of Tested Structures 
Horizontal scale: ACD/Density Estimation Error 
Number of tested structures: 671 

d20exp = 0.9947(±0.0036) d20calc + 0.0052(±0.0036) R=0.995683, StD=0.028 
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Distribution of the Surface Tension Prediction Error 

    
Vertical scale: Number of Tested Structures 
Horizontal scale: ACD/Surface Tension Estimation Error 
Number of tested structures: 432 

st20exp = 0.998(±0.018) st20calc + 0.08(±0.53)   R=0.934720, StD=2.84 

Distribution of the Dielectric Constant (Permittivity) Estimation Error 

 
Vertical scale: Number of Tested Structures 
Horizontal scale: Dielectric constant (Permittivity) Estimation Error 
Number of tested structures: 85   

Note: Derived only for hydrocarbons 

εexp = 1.005(0.033)εexp – 0.013(0.072)   R=0.9588, StD=0.079 
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Appendix C. Goodies 

What are “Goodies”? 

Goodies are additional tools that extend the functionality of ACD/ChemSketch.  They are, 
actually, implemented as ACD/ChemBasic programs associated with the 22 supplementary 
ChemSketch buttons.  ACD/ChemBasic is a special programming language that enables you to 
customize ACD/Labs software, and we think this is a great way to show off how useful it is—and 
at the same time make your ACD/ChemSketch even more versatile! 

Note that you do not need to know anything about ACD/ChemBasic (although, if you wish, you 
can learn it by using the Goodies' code as example). 

Where Can I Get Them? 

To check if you already have Goodies, look for all .BAS files within your ACD/Labs example 
folder (\\EXAMPLES\CHEMBAS\GOODIES).  If you don’t find any, you can download them from 
our Web site free of charge at 

http://www.acdlabs.com/products/chem_dsn_lab/goodies.html 
They are easy to install and to use.  Just follow the installation instructions provided at the 
aforementioned Web page and enjoy these new ACD/ChemSketch features. 

After installation, the Goodies tools are available as buttons on a toolbar you have specified; later 
you can customize the toolbar (refer to Section 2.2.1). 

Note ChemBasic Goodies buttons are only available when you are in the Structure 
mode. 

Goodies 

Below is the list of Goodies tools that are available at the moment at our Web site: 

Goodies Function How to use 
Insert Page 
 

 

Inserts a blank page at any 
place within your ChemSketch 
document.  Note that the usual 
way—through New (Pages 
menu)—adds a page at the end 
of document. 

Go to the page before which you want to insert 

a blank page and click Insert Page . 

http://www.acdlabs.com/products/chem_dsn_lab/goodies.html�
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Goodies Function How to use 
Clone Page 
 

 

Clones current page (together 
with its contents) a specified 
number of times—it is very 
useful for filling in the document 
with page templates, tables, 
titles, etc.  New pages are added 
at the end of a document. 

Make the page which you wish to clone active 

and click Clone Page .  In the dialog box 
that appears, specify the number of clones and 
click OK. 

Move/Copy Page 
 

 

Moves and copies pages—i.e., 
changes page order in your 
document. 

Go to the page which you wish to move or 

copy and click Move/Copy Page .  In the 
dialog box that appears, type the number of 
the page after which you wish to place the 
current page, and then define the required 
action: Copy or Move.  Click OK. 

Reorder Pages 
 

 

Allows you to cut-and-paste or 
copy-and-paste a sequence of 
pages to a new position within 
the same document. 

Click this button and, in the dialog box that 
appears, type the numbers of the pages to be 
moved or copied to a new position.  Then, type 
the page number after which you want to place 
the selected range of pages.  Specify the 
required action (Copy or Move) and click OK. 

Delete Pages 
 

 

Deletes a range of pages at a 
time. 
Note that the pages you have 
deleted cannot be recovered 
with the Undo command from 
the Edit menu. 

Click Delete Pages .  In the dialog box 
that appears, type the sequence of pages to be 
deleted and click OK. 

Rename Pages 
 

 

Changes the name of pages. 
Note that the names of the 
pages will be shown when you 
click Page 1/1 on the status bar. 

Click this button and, in the dialog box that 
appears, type the number of the page to be 
(re)named, a new name of the page, and then 
click OK.  In the message that appears, click 
Yes and repeat the previous action if you want 
to rename the next page; if it is not required to 
rename the next page, click No. 

Insert Page 
Numbers/ 
Annotations 
 

 

Inserts page numbers or 
complex annotations in your 
document.  Note that an 
annotation will be inserted at the 
bottom right corner of the page. 

Click this button and, in the dialog box that 
appears, type a page annotation template, and 
then click OK. 
Annotation template keys: 
$P—inserts page numbers 
$N—inserts pages names (that can be 

inserted by clicking Rename Pages  or by 
using Rename (Pages menu))  
You can also include any fixed text into your 
annotation template (for example, template: 
Page $P: $N will insert "Page 1: Page Name", 
etc. annotations).  If a template contains no 
keys, just a fixed text for each page will be 
inserted; for example, you can sign all of the 
pages with your name. 
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Goodies Function How to use 
Annotate 
Document 
 

 

Annotates your documents 
based on the content of the 
leftmost top text box on each 
page.  This is very convenient 
for managing large documents 
and presentations. 

Click this button to annotate all of the pages 
containing any text.  After program execution 
click the page counter on the status bar to see 
page names. 

Document 
Browser 
 

 

Looks through the folders to find 
the specified ChemSketch 
documents as well as to search 
ChemSketch documents for the 
text string without opening them. 

Click this button and follow the instructions that 
appear in the dialog box.   

Create HTML 
 

 

Exports all the selected pages of 
a current document into an 
HTML file, which you can later 
view with your favorite web-
browser.  Note that this option 
requires ChemSketch 4.01 or 
later. 

All the details may be found in FILLTMP.DOC 
file provided in the Goodies folder 
(\\EXAMPLES\CHEMBAS\GOODIES). 

Sketch-to-VRML 
Converter 
 

 

Exports all of the structures from 
the current page into a VRML 
2.0 file, which you may then view 
with Cosmo, GLView, or any 
other VRML browser. 

Draw structures which you wish to export on 
the same page, and then click this button.  In 
the dialog box that appears, type the name and 
location of .WRL file to which structures are to 
be exported.  Note that if you have typed the 
filename only, the program will place the 
resulting WRL file in the same folder with 
SK2VRML.BAS.  Specify the desired structure 
presentation by selecting the corresponding 
option and click OK. 

SDF-to-Sketch 
Converter 
 

 

Imports the data (structures, 
text, etc.) from a file of MDL's 
SDfile format into ChemSketch 
document.   

Click this button and, in the dialog box that 
appears, specify the name and location of the 
SDfile which you want to import.  (If you type 
the filename without specifying the full path, 
the program will search your SDfile in the 
folder where ACD/ChemBasic programs are 
located.  So, if you placed the needed SDfile in 
the same folder with SDF2SK.BAS, then 
simply specify the file name without a path.)  
Specify the number of structures per page and 
an SDfile field containing structures, then click 
OK. 

Sketch-To-SDF 
Converter 
 

 

Exports all of the structures from 
the current page or from the 
whole document to an SDfile 

Open the page with the structures you want to 
export (if required).  Click this button and, in 
the dialog box that appears, choose what you 
want to import—the current page or the whole 
document; specify whether the formula, FW, 
and ID are to be exported along with the 
structures.  Specify the name and the path for 
an SDfile and click OK. (Note that if you type 
the filename only, the program will place the 
resulting SDfile in the same folder where 
EXPSDF.BAS resides.) 
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Goodies Function How to use 
Table Wizard 
 

 

Creates tables or/and aligns 
objects according to the 
specified number of rows and 
columns. 

Click this button; you will be informed about the 
number of objects on the page and some 
suggestions on how to align them.  Specify the 
number of rows and columns for the table, 
choose whether to create borders (the Mark-
up table check box) in the table, and then click 
OK.  To create an empty table, run the Table 
Wizard with the blank page active. 

Replace Element 
 

 

Replaces all of the atoms of a 
given type with atoms of another 
type in a chemical structure.  
This is very useful for drawing, 
for example, perfluorinated 
structures.  Note that this can 
only be done with a single 
structure on the page.   

Draw or leave only one structure on the page 
and click this button. In the dialog box that 
appears, specify the element to be replaced 
and the element that should replace the one 
specified before, and then click OK. 
Note that the hydrogen atoms should be drawn 
explicitly (use Add Explicit Hydrogens from 
the Tools menu). 

Solution 
Calculator 
 

 

Calculates the weight of a 
compound required for preparing 
an aqueous solution of the user-
defined volume and molar 
concentration.  Note that 
program execution is possible 
only with a single structure on 
the page. 

Draw or leave one structure on the page and 
click this button.  In the dialog box that 
appears, specify the required molar 
concentration and aqueous solution volume, 
then click OK. 

Label Printer 
 

 

Quickly creates labels for 
chemicals and prints them 
according to the Avery Standard 
(45 templates included) or 
according to your own template. 

Draw structures for which you want to create 
labels and click Label Printer.  Note that you 
can create labels for structures from an SDfile 
if you run this program with an empty active 
page.  For more information, see 
LPRINTER.TXT provided in the Goodies folder 
(\\EXAMPLES\CHEMBAS\GOODIES). 

Peptide Builder 
 

 

Builds a 3D peptide structure 
from the amino acids sequence. 

Refer to the PEPBUILD.SK2 file provided in 
the Goodies folder 
(\\EXAMPLES\CHEMBAS\GOODIES) as a 
guide to using this tool. 

Carbohydrate 
Builder 

 

Builds a structure from 
carbohydrate abbreviated 
names. 

For information on how to work with this tool, 
refer to the SUGARSK.TXT file that you can 
find in the Goodies folder 
(\\EXAMPLES\CHEMBAS\GOODIES). 

Remove 
Spectator Ions 
(Desalt) 
 

 

An SDfile that contains one or 
more salt structure entries can 
be changed to a “one-molecule-
per-entry” SDfile.  This tool 
removes the smallest ion, either 
by MW or by number of atoms.  
For example, sodium acetate will 
have the sodium atom removed, 
and acetic acid will remain 
behind.  (Note that the structure 
left behind is put into neutral 
form.) 

Specify the name and the path for an SDfile.  
Note that if you type the filename only, the 
program will look for a file in the Goodies folder 
(\\EXAMPLES\CHEMBAS\GOODIES).  Then, 
define a criterion for smallest part: mass or 
atom.  The resultant SDfile will be saved in the 
same folder with the original file under 
NEWFILE.SDF name.  A special sample file, 
SALTS.SDF with 5 salts in it is placed in the 
Goodies folder 
(\\EXAMPLES\CHEMBAS\GOODIES) for 
testing. 
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Goodies Function How to use 
Nucleic Acid 
Builder 

 

Builds a 3D nucleic acid (DNA, 
RNA) structure (one or two 
chains) from your input 
sequence. 

Click this button and follow the instructions in 
the dialog box that appears. 

Column Selector 
 

 

This tool lets the 
chromatographer search a 
knowledge base of the most 
utilized columns in order to 
locate the ones that have the 
properties best suited to the 
separation at hand.  

Click this button and, in the dialog box that 
appears, specify whether to compare the 
selected column with the list or two selected 
columns between themselves, and then click 
OK.  In the next dialog box, choose the proper 
column(s) from the drop-down list and set the 
weighting coefficients to be applied to all six 
column parameters, then click OK.  (For 
information on how to work with this tool, refer 
to the COLSEL_W.PDF file that you can find in 
the (\\DOCS) folder.) 
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